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 1
What's New?

New in ProjectWise CONNECT Edition Update 3

Updated Operating System and Database Support

• Support for Windows Server 2016
• Support for Microsoft SQL Server 2016
• Support for Microsoft Azure SQL Database (for hosted solutions)

Updated Application Integration Support

ProjectWise Explorer now supports integration with:
• MicroStation CONNECT Edition Update 7
• MicroStation PowerDraft CONNECT Edition Update 7
• Revit 2018 (includes both basic and advanced integration)
• Adobe InDesign CC 2017.1
Note: This version of the ProjectWise Explorer installer now delivers the following integration modules, which
were originally released (and are still available) as separate downloads for ProjectWise Explorer CONNECT
Edition Update 2.3 users:
• ProjectWise Integration Module for Revit 2018
• ProjectWise Integration Module for Adobe InDesign CC 2017.1

Revit Integration Enhancements

• You can now publish a file from the Revit advanced integration project to ProjectWise Share in the
CONNECTION Center

• The Issues Resolution feature is now production ready (no longer a technology preview)

Project Forms Preview Tab

A new option has been added in the ProjectWise Explorer installer, Project Forms Preview Tab, for use with
ProjectWise Field Data Management. Turning this option on during installation adds the Project Forms tab to
the Preview Pane in ProjectWise Explorer whenever you select a work area that is associated to a ProjectWise
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cloud project. The Project Forms tab displays the forms that exist in the ProjectWise Field Data Management
service for this project.

Allowable Locations for Storage Areas

Before you can create a storage area, you must now first define at least one allowable storage location, which is a
local and/or network location where storage areas hosted by a ProjectWise Design Integration Server or
ProjectWise Caching Server can be created.
Allowable storage locations are defined in the DMSKRNL.CFG file. If no locations are defined, you will not be able
to create any storage areas on the server.
For convenience, the ProjectWise Design Integration Server and ProjectWise Caching Server installers have been
modified to let you define the default allowable storage location during installation. You can also manually add,
modify, or remove allowable storage locations from the DMSKRNL.CFG file.

Bentley Web Services Gateway Is Now Delivered

Bentley Web Services Gateway 02.06 and the required ProjectWise Plug-in are now delivered with the
ProjectWise Server Setups download package.
Bentley Web Services Gateway is used to provide users of Bentley mobile and cloud applications access to
ProjectWise datasources.

Creating Work Area Connections from ProjectWise Explorer

ProjectWise cloud project administrators have the ability of exposing on-premise ProjectWise work areas from
the ProjectWise Share portal within the ProjectWise cloud project, by creating something called a work area
connection from the cloud project. A work area connection uses Bentley Web Services Gateway (WSG) in order to
access the on-premise ProjectWise Design Integration Server, datasource, and work area, making the content in
that work area available to users in the ProjectWise Share portal.
This release of ProjectWise now lets you create the same work area connections right from ProjectWise
Explorer. To facilitate this, a new datasource setting has been added in ProjectWise Administrator, called WSG
Work Areas URL for Connect services. In this setting, the administrator specifies the URL of the Bentley Web
Services Gateway (which includes the path to the on-premise ProjectWise Design Integration Server and
datasource). Once this URL is configured, then associating a work area to a ProjectWise cloud project
automatically creates the work area connection in the ProjectWise Share portal (or any ProjectWise Connection
Service that utilize this feature) within the associated cloud project.
See: Adding Work Area Connections to ProjectWise Cloud Projects (on page 245)

Orchestration Framework Administrator Is Now an Option of the ProjectWise
Administrator Installer

Orchestration Framework Administrator is now an option of the ProjectWise Administrator installer.
Orchestration Framework Administrator can be used to monitor the progress of automated file processing jobs
of the ProjectWise Design Integration Server as configured through ProjectWise Administrator. (In previous
releases, you had to install Bentley i-model Composition Server Administrator or Bentley Automation Service
Administrator in order to get Orchestration Framework Administrator.)

What's New?
New in ProjectWise CONNECT Edition Update 3
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Link to Online Help from ProjectWise Explorer

Clicking the Help icon, or Help > Contents, or pressing <F1> inProjectWise Explorer now opens the
corresponding version of the online help on docs.bentley.com.
If for whatever reason you cannot access the internet or this website, the delivered local version of the
ProjectWise Explorer help will open instead.

New in ProjectWise CONNECT Edition Update 2.3
This release is an update for ProjectWise Explorer only.

Updated Application Version Support

ProjectWise Explorer now supports integration with:
• MicroStation CONNECT Edition Update 6 (includes managed configurations support)
• AutoCAD 2018
• AutoCAD Architecture 2018
• AutoCAD Civil 3D 2018 (includes Civil 3D advanced integration)
• AutoCAD Map 3D 2018
• AutoCAD MEP 2018
This version of the ProjectWise Explorer installer now delivers the ProjectWise Integration Module for AutoCAD
2018, which was a separate download for ProjectWise Explorer CONNECT Edition Update 2.2 users.

Delivery of Revit Advanced Integration

Support for Revit 2016 and 2017 are not new in this release, but this version of the ProjectWise Explorer
installer delivers an updated Revit integration module for Revit 2016 and Revit 2017 which now includes both
basic and advanced integration. The advanced integration was previously available as a separate download for
ProjectWise Explorer CONNECT Edition Update 2.2 users.
A ProjectWise Integration Module for Revit 2018, which will also include both basic and advanced integration,
will be available as a separate download some time after ProjectWise Explorer CONNECT Edition Update 2.3 is
released.

'Projects' Are Now Called 'Work Areas'

The advanced type of folder that was referred to as a 'project' is now called a 'work area'. This is a label change
only, the functionality has not been changed.
In a related change, the cloud-based project that was referred to as a 'CONNECTED project' is now called a
'ProjectWise project'.
Therefore, starting in ProjectWise CONNECT Edition Update 2.3, it is now appropriate to say that, from
ProjectWise Explorer, you can associate a work area to a ProjectWise project.

What's New?
New in ProjectWise CONNECT Edition Update 2.3
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Renamed User Settings

Many of the user settings have been renamed for clarity. Note that because this is a ProjectWise Explorer only
release, you will still see the old names when looking at the same settings in ProjectWise Administrator.

ProjectWise Explorer Launch Can Be Configured to Open the CONNECTION Client
if You Are Not Signed In

By adding a certain key to the Windows registry, you can now force the CONNECTION Client to open whenever
you open ProjectWise Explorer, if you have not already signed in through the CONNECTION Client:
Key: HKEY_CURRENT_USER\Software\Bentley\ProjectWise Explorer\ExtraFeatures
String: ConnectionClientLoginRequirement
Value: ENABLE

New in ProjectWise CONNECT Edition Update 2.2

Updated Application Integration Support

ProjectWise Explorer now supports integration with:
• MicroStation CONNECT Edition Update 5 (includes managed configurations support)

Note: This version and previous CONNECT Edition updates are no longer supported in the current version of
ProjectWise - use MicroStation CONNECT Edition Update 6 or 7 instead.

• MicroStation PowerDraft CONNECT Edition Update 5 (includes managed configurations support)
Note: This version and previous CONNECT Edition updates are no longer supported in the current version of
ProjectWise - use MicroStation PowerDraft CONNECT Edition Update 7 instead.

New in ProjectWise CONNECT Edition Update 2.1
Update 2.1 is a minor update of the server, admin, and client.
The server and admin update (as of this writing, build 10.00.02.99) is primarily for Bentley Managed Services
and contains:
• updated version of ProjectWise Orchestration Framework Service
• support for running iCS for PDF jobs using Bentley IMS credentials
• PowerShell improvement for datasource creation
• Improved notification on warning message for the update tables in ProjectWise Administrator
The client update (as of this writing, build 10.00.02.203) contains:
• support for managed configurations using OpenRoads Designer  CONNECT Edition (as of this writing, build

10.00.00.120)
• bug fixes for MicroStation CONNECT Edition integration

What's New?
New in ProjectWise CONNECT Edition Update 2.2
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New in ProjectWise CONNECT Edition Update 2

Updated Application Version Support

ProjectWise Explorer now supports integration with:
• MicroStation CONNECT Edition Update 4

Note: This version is no longer supported in the current version of ProjectWise - use MicroStation CONNECT
Edition Update 6 or 7 instead.

• MicroStation PowerDraft CONNECT Edition Update 4
Note: This version is no longer supported in the current version of ProjectWise - use MicroStation
PowerDraft CONNECT Edition Update 7 instead.

• AutoCAD 2017
• Revit 2017
• Microsoft Office 2016/365
In support of AutoCAD, Revit, and Office, the ProjectWise Explorer installer now delivers the following
integration modules, which were previously each a separate download:
• ProjectWise Integration Module for AutoCAD 2017 (with advanced Civil 3D integration)
• ProjectWise Integration Module for Revit 2017
• ProjectWise Integration Module for Microsoft Office 2016 and 365

Managed Configuration Support with MicroStation CONNECT Edition

Integration with MicroStation CONNECT Edition Update 4 now includes support for managed configurations.
Note: This version is no longer supported in the current version of ProjectWise  - use MicroStation CONNECT
Edition Update 6 or 7 instead.

Reference Scanning Support for Reality Mesh Files

The reference scanner in ProjectWise Explorer supports scanning of DGN files that have reality mesh models
(.3MX) attached as references.
Reality mesh models are high resolution 3D models created in ContextCapture.

Deleted Items Folder

The Deleted Items folder can be enabled by administrators who want to save deleted documents and folders for
a period of time, giving them the chance to restore (undelete) items as needed before permanently deleting them
from the datasource. The Deleted Items folder is visible in ProjectWise Explorer when the new datasource
setting Miscellaneous > Enable 'Deleted Items' folder is turned on in ProjectWise Administrator, and you are
logged in to the datasource as the administrator.

What's New?
New in ProjectWise CONNECT Edition Update 2
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When the Deleted Items folder is enabled, the documents and folders that users delete are moved to the Deleted
Items folder. Items remain in the Deleted Items folder for the period of time specified in the datasource settings
(Miscellaneous > Enable 'Deleted Items' folder > days | months | years). Once a deleted item has been kept
for the specified period of time, it is automatically and permanently deleted from the datasource.
The administrator can restore or manually permanently delete any item in the Deleted Items folder, as long as
the parent folder it was deleted from still exists. Restoring a master document will also automatically restore its
reference documents. Likewise, restoring the main file of a multi-file document such as a SHP file will also
automatically restore its related documents. Restored documents will retain their original general properties,
including their original GUID, but they will lose any custom attribute information. Likewise, restored projects
will retain their original general folder properties (including their GUID), but they will lose any custom project
property information.
This feature is currently being offered as a technology preview.

Logging in Using Bentley IMS Authentication (Federated Identity)

You can now log in to a ProjectWise datasource using Bentley IMS authentication, which uses the credentials of
your Bentley Cloud Services profile.
In order for this to work, the following must be true:
• The administrator must enable Bentley IMS authentication in the datasource (by adding STS=1 in the

DMSKRNL.CFG file on the server).
• The user logging in must already be signed in to the CONNECTION Client on their computer using their

Bentley Cloud Services credentials.
• The user logging in must have a ProjectWise account associated to their Bentley Cloud Services profile.
Associating a ProjectWise account to a Bentley Cloud Services profile is done by adding a person's Bentley
identity (the primary email address of their Bentley Cloud Services profile) to their ProjectWise user account
properties. Each Bentley identity can only be associated to one ProjectWise account in a datasource. The
administrator can do this association manually in ProjectWise Administrator (Users node > User Properties
dialog > Federated Identity tab > Identity field), or the administrator can configure settings that allow the
association to be done automatically the first time the user logs in using Bentley IMS authentication, if there is no
account in the datasource currently associated to their Bentley Cloud Services profile. For example, depending
on the configuration, logging in with Bentley IMS authentication can cause a ProjectWise user account to be
automatically created and associated to the person's Bentley Cloud Services profile, or it can cause the user to be
prompted to either select an existing user account to associate with their Bentley Cloud Services profile, or to
allow a new ProjectWise user account to be created and associated to their Bentley Cloud Services profile.

ProjectWise Explorer Installer Enhancements

The steps for installing ProjectWise Explorer and its features have been streamlined. Instead of launching a main
installation wizard followed by a secondary setup wizard as in previous CONNECT Edition releases, all
installation options (ProjectWise Explorer, tools, integrations, other apps) are now installed through a single
installation wizard.

ProjectWise Connection Services Apps Now Included

For convenience, the following on-premise applications required for ProjectWise Connection Services are now
included with the ProjectWise Client Setups and ProjectWise Server Setups downloads:

What's New?
New in ProjectWise CONNECT Edition Update 2
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• ProjectWise Deliverables Management connector for ProjectWise Explorer - included in the ProjectWise
Explorer installer (ProjectWise Client Setups download)
ProjectWise Deliverables Management connector for ProjectWise Explorer is the on-premise component for
ProjectWise Deliverables Management.

• ProjectWise Analytics Data Upload Service - included in the ProjectWise Explorer installer (ProjectWise
Client Setups download)
ProjectWise Analytics Data Upload Service is the on-premise component for ProjectWise Project
Performance Dashboards.

• ProjectWise Sync Service - included in the ProjectWise Server Setups master installer (ProjectWise Server
Setups download)
ProjectWise Sync Service is the on-premise component for ProjectWise Project Synchronization.

Note: These same applications can also still be downloaded separately from the Bentley Software Fulfillment
Center.

Support for ProjectWise Orchestration Framework Service CONNECT Edition

This release now delivers and requires ProjectWise Orchestration Framework Service CONNECT Edition.
With the updated ProjectWise Orchestration Framework Service, you can now use either an ODBC data source
or a direct database connection to connect to the Orchestration Framework database. In previous versions of
ProjectWise Orchestration Framework Service you could only use a direct database connection.
Also, the following process management settings are new or updated:
• Maximum Memory Usage (after processing message) - This setting used to be named “Maximum Memory

Usage” and works the same as it did in previous releases.
• Maximum Memory Usage (while processing message) - Sets whether or not the process will be restarted

while processing a message, if the process happens to reach the memory usage limit while processing a
message. The process' memory is returned to its normal state on startup. If set to Infinite (the default,
recommended), there is no limit to the amount of memory the process can use while processing a message,
meaning that it will never be restarted while processing a message. If needed, you can set a limit on the
amount of memory (in MB) the process can use while processing a message. If a limit is set and the process
reaches that limit before it finishes processing a message, the process restarts and begins processing the
message again from the beginning.

• Maximum Single Message Idle Time - Sets the maximum amount of time (in minutes) the process can be
idle when processing any one message. If the process remains idle on a single message longer than the idle
time limit allows, the message is skipped. If set to Infinite, there is no limit to the amount of time the process
can be idle while processing a message.

Audit Trail Enhancements

All global audit trail logging options are now on by default in a new datasource (in previous releases they were
all off by default). So when creating a new datasource, there is no initial audit trail setup required unless you
(the administrator) want to turn off some actions that you do not think are necessary to be recorded in the audit
trail.
Also, more audit trail record types have been added, so that audit trail can now record actions related to:
• departments
• applications

What's New?
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• workflows
• states
• environments
• environment attributes
• interfaces
• views
• project types
Also, new folder audit trail logging options have been added, so that audit trail can now record when a
ProjectWise Explorer project is associated to a CONNECTED project, or when the association is changed or
removed.

Default Background Map and Coordinate System

New datasources now come with a default (reference) background map and coordinate system. “WorldMap” is
the default background map, and “LL84” is the default coordinate system (WorldMap is associated to LL84,
which is a generic Longitude/Latitude coordinate system from the delivered coordinate system dictionary). The
default background map and coordinate system are also added to upgraded datasources, if the datasource did
not previously have a default background map or coordinate system.

Default “WorldMap” background map in ProjectWise Explorer

Default “WorldMap” background map in ProjectWise Administrator
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ProjectWise Admin Setups Changes

Bentley Automation Service Administrator is no longer delivered. Use Bentley i-model Composition Server
Administrator instead.
Details:
Automated file processing jobs of the ProjectWise Design Integration Server are configured and run from
ProjectWise Administrator, while job progress is monitored from Orchestration Framework Administrator. To
install Orchestration Framework Administrator, you need to install Bentley i-model Composition Server
Administrator, which is an option of the Bentley i-model Composition Server for PDF installer.

New in ProjectWise CONNECT Edition Update 1.2
• When configuring new or exiting views in ProjectWise Explorer or ProjectWise Administrator, you can now

add custom project properties to the view.
To add a project property to a view, a new Project Properties Columns category has been added to the
Create View and View Properties dialogs in ProjectWise Explorer, and to the View Properties dialog in
ProjectWise Administrator. This category contains all of the custom project properties from all of the project
types in the datasource.

Create View dialog in ProjectWise Explorer, showing new Project Properties Columns category
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New in ProjectWise CONNECT Edition Update 1.1

Licensing Changes

You must now run the Product Activation Wizard before starting the service for ProjectWise Design Integration
Server. Please follow these steps:
1. Install ProjectWise Design Integration Server.
2. Run the Product Activation Wizard.
3. Manually start the service for ProjectWise Design Integration Server in the Services window.
Once the product is activated and the service is started, the ProjectWise server will check SELECTserver for a
CONNECT Edition license. If a CONNECT Edition license is found, it is used and the full features of the product
work as they should. If a CONNECT Edition license is not found, it checks for a V8i license. If a V8i license is
found, it is used, however the CONNECT Edition features of the product will be disabled. If neither a CONNECT
Edition nor a V8i license is found, the ProjectWise server will enter into CONNECT Edition evaluation mode.
Important: You must always start or restart the service after running the Product Activation Wizard. If for some
reason you start the service before you run the Product Activation Wizard, or if you later need to make changes
in the Product Activation Wizard, then you must restart the service.

Server Installer Changes

Because of these licensing changes, the option to start the service at the end of the server installation has been
disabled to ensure that you do not accidentally start the service before running the Product Activation Wizard.
This affects the installers for ProjectWise Design Integration Server, ProjectWise Caching Server, ProjectWise
Gateway Service, and ProjectWise Indexing Service. After running the Product Activation Wizard, then you must
manually start the services for these servers in the Services window.

AutoCAD and AutoCAD Civil 3D Integration Enhancements

ProjectWise Explorer-side features:
• Data Shortcut Project Editor

This new feature is an option on the ProjectWise Explorer installer and lets you manage AutoCAD Civil 3D
data shortcuts. You do not need to install AutoCAD Civil 3D in order to install the Data Shortcut Project
Editor.

• Support for AutoCAD Civil 3D Data Shortcuts in the Dependency Viewer
You can now enable or disable the display of AutoCAD Civil 3D data shortcut projects in the Dependency
Viewer in ProjectWise Explorer (Preview Pane > Dependency Viewer > Block Filter tab > Dependencies
section > Civil 3D Projects option)

• The reference scanner and expconv utilities have been updated to use RealDWG 2016 and support Point
Cloud References (.RCS) in DWG documents

AutoCAD basic integration features:
• Shared sheet set mode for DST documents that allows to lock sheet set only while modification needed
• Integration for Point Cloud References (.RCS) in DWG documents

What's New?
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• Support of recent ProjectWise location per integrated command
• SSMAUTOOPEN and SSLOCATE variables support
AutoCAD Civil 3D integration features:
• Create Sheets command integration for View Frame Groups ('P&P' Sheet Generator)
• Map Image Insert (MAPIINSERT) command integration
• Decreased default depth while creating AutoCAD Civil 3D relations to improve performance of Civil 3D set

processing

Updated CONNECTION Client Version

The ProjectWise Client Setups download package includes an updated version of the CONNECTION Client.

New in ProjectWise CONNECT Edition Update 1

Updated Operating System and Database Support

• Support for Windows 10
• Support for Windows Server 2012 R2 (R2 support is new)
• Support for SQL Server 2014
• Support for Oracle Database 12c

Updated Application Integration Support

• MicroStation PowerDraft CONNECT Edition
Note: This version is no longer supported in the current version of ProjectWise - use MicroStation
PowerDraft CONNECT Edition Update 7 instead.

• Bentley View CONNECT Edition
Note: Bentley View is no longer supported in the current version of ProjectWise.

• AutoCAD 2016, 2015, 2014
Note: Some AutoCAD 2014 applications are no longer supported in the current version of ProjectWise.

• Revit 2016, 2015, 2014
Note: Revit 2014 is no longer supported in the current version of ProjectWise.

• Adobe InDesign CC 2015, CS6
Note: InDesign CS6 is no longer supported in the current version of ProjectWise.

• Microsoft Office 365/2013

Delivered Integration Modules

The master ProjectWise Explorer installation wizard now delivers the following integration modules to provide
support for the related application:
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• ProjectWise Integration Module for AutoCAD 2016 (with advanced Civil 3D integration)
• ProjectWise Integration Module for AutoCAD 2015 (with advanced Civil 3D integration)
• ProjectWise Integration Module for AutoCAD 2014 (with advanced Civil 3D integration)
• ProjectWise Integration Module for Revit 2016
• ProjectWise Integration Module for Revit 2015
• ProjectWise Integration Module for Revit 2014
• ProjectWise Integration Module for Microsoft Office 365 and Office 2013
• ProjectWise Integration Module for Adobe InDesign CC 2015
• ProjectWise Integration Module for Adobe InDesign CS6
These integration options will be available if the related application is installed. These are the same integration
modules that are also available as separate downloads on Bentley's Software Fulfillment Center, for previous
versions of ProjectWise Explorer.

New in ProjectWise CONNECT Edition

Support for CONNECTED Projects and ProjectWise Connection Services

Attention: 'CONNECTED projects' are now called ProjectWise projects, and so to avoid confusion ProjectWise
Design Integration 'projects' have been renamed work areas (starting in ProjectWise CONNECT Edition Update
2.3).
ProjectWise Design Integration CONNECT Edition improves collaboration within distributed organizations
through the use of CONNECTED projects and various new cloud services. By taking your existing ProjectWise
projects and associating them with CONNECTED projects in the cloud, users can go to the project's Project Portal
in ProjectWise Explorer and access new ProjectWise Connection Services including ProjectWise Project
Performance Dashboards, ProjectWise Project Synchronization, and ProjectWise Deliverables Management.
Users can also go to their Personal Portal in ProjectWise Explorer and take advantage of custom LEARNing paths
and software recommendations based on their role and skill level.

ProjectWise Project Performance Dashboards
ProjectWise Project Performance Dashboards helps managers track project status and progress by collecting
statistical information about documents, and also deliverable packages created using either ProjectWise
Deliverables Management or Bentley Transmittal Services.
This feature requires an additional download and some on-premise configuration by your administrator before
it can be used. See On-Premise Configuration for ProjectWise Connection Services (on page 203).

ProjectWise Project Synchronization
ProjectWise Project Synchronization facilitates the sharing and receiving of project content among multiple
organizations for the purpose of design coordination. Administrators install ProjectWise Sync Service locally,
and use it to associate ProjectWise work areas or local Windows folders with ProjectWise cloud projects. Once
the association is made, people from your organization can go to the ProjectWise Project Synchronization portal
within the ProjectWise cloud project and share the associated ProjectWise or Windows content with people
from other organizations, who will themselves go to the ProjectWise Project Synchronization portal to receive
the content.

What's New?
New in ProjectWise CONNECT Edition

ProjectWise Design Integration 19 Implementation Guide



This feature requires an additional download and some on-premise configuration by your administrator before
it can be used. See On-Premise Configuration for ProjectWise Connection Services (on page 203).
Attention: The use of ProjectWise Project Synchronization in your organization requires approval by your
CONNECT administrator before it can be used. Please have your CONNECT administrator contact Bentley
Support for assistance in approving this service for your organization.

ProjectWise Deliverables Management
ProjectWise Deliverables Management provides secure deliverables exchange between business entities. It
ensures that deliverables package information can be trusted, speeds up preparation process, and makes it easy
to identify and resolve urgent issues.
Key benefits:
• Provides status visibility of all incoming and outgoing deliverables, and RFIs.
• Ensures that only authorized contractors and subcontractors have access to deliverables and RFIs.
• Enables recipients to easily acknowledge, download, review, and respond to the documents through the web

portal.
• Makes the deliverables review process easy to track through email notifications and the built-in audit trail.
This feature requires some configuration. See On-Premise Configuration for ProjectWise Connection Services
(on page 203).

ProjectWise Issues Resolution
This feature is for Bentley Navigator users who need to create punch lists that document issues associated with
items and share these issues with other project participants.
For more information, see: http://communities.bentley.com/products/projectwise/project_review/w/wiki/
23543.punch-lists

Scenario Services
Scenario Services allows engineers to run multiple design alternatives or scenarios in the cloud and compare
their performances using sophisticated charts and graphs, arriving at the most optimal design solution. Scenario
Services also helps automate the QA process by comparing detailed results from two versions of an application.
No additional configuration is needed for this feature. Users can download the results to their desktop to
perform detailed post-processing in their STAAD or SACS application.

Changes to the Delivery Set

Changes in ProjectWise Server Setups
• There is no ProjectWise Web Server in this release. If you need this feature, use ProjectWise Web Server V8i

(SELECTseries 4). Also, if you need to use the ProjectWise Publishing Gateway Service with your ProjectWise
Web Server, then use ProjectWise Publishing Gateway Service V8i (SELECTseries 4) and not the ProjectWise
Publishing Gateway Service from this release.

• ProjectWise Web View Server is no longer delivered and has been discontinued.
• ProjectWise Automation Service is no longer delivered. If you need this functionality, use the rebranded

Bentley Automation Service, which is a separate download.
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• The version of ProjectWise Orchestration Framework Service delivered in this release is ProjectWise
Orchestration Framework Service V8i (SELECTseries 6).

• ProjectWise Distribution Service is no longer delivered and has been discontinued. Use Bentley i-model
Composition Server for PDF instead.

• ProjectWise web services (not the same thing as ProjectWise Web Server) is no longer delivered and has
been discontinued.

Changes in ProjectWise Client Setups
• The entire client installation (ProjectWise Explorer and its supporting software) is now carried out through a

single installer. This new installer first installs the prerequisites (ProjectWise Prerequisite Runtimes and the
new CONNECTION Client) and then installs ProjectWise Explorer and optionally the Bentley DGN Navigator
Control. The CONNECTION Client is required to be able to access the Personal and Project Portals and work
on CONNECTED projects from ProjectWise Explorer.

• With the new ProjectWise Explorer installer, there is no longer an option to change the installation options
from the Control Panel (Programs and Features). Instead, to change your installation options you now
uninstall ProjectWise Explorer and reinstall it with the necessary changes.

• The ProjectWise Export/Import tool is now an option on the ProjectWise Explorer installer: Tools > Export-
Import Tools > Export-Import to Excel (previously it was a separate installation).

• ProjectWise i-model Packager is no longer delivered and has been discontinued.

Changes in ProjectWise Admin Setups
• The CONNECTION Client is also delivered with ProjectWise Admin Setups, and is a prerequisite for installing

ProjectWise Administrator.
• Bentley Automation Service Administrator is now delivered, for the purpose of monitoring the progress of

automated file processing jobs of the ProjectWise Design Integration Server that are configured and run from
ProjectWise Administrator. Installing Bentley Automation Service Administrator installs Orchestration
Framework Administrator.
Attention: Bentley Automation Service Administrator is no longer delivered beginning with ProjectWise
CONNECT Edition Update 2. Use Bentley i-model Composition Server Administrator instead (installing
Bentley i-model Composition Server Administrator also installs Orchestration Framework Administrator).

• ProjectWise Distribution Service Administrator is no longer delivered. See “Changes in ProjectWise Server
Setups” above.

MicroStation CONNECT Edition Integration

The ProjectWise Explorer CONNECT Edition installer delivers integration support for MicroStation CONNECT
Edition.
Note: This version is no longer supported in the current version of ProjectWise - use MicroStation CONNECT
Edition Update 6 or 7 instead.

Updated ProjectWise Applications

The delivered ProjectWise application definitions have been updated, primarily for AECOsim Building Designer
(updated icons and program associations).
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Note: For administrators: When upgrading a datasource, you will have to run DMSCONV if you want to update
the application list of your datasource.

PowerShell Extensions for ProjectWise Administrator

There is a new option on the ProjectWise Administrator installer that lets you install PowerShell Extensions.
PowerShell lets you automate certain ProjectWise operations including:
• adding/removing users/groups/lists
• configuring user settings
• creating storage areas
• configuring datasource settings

ProjectWise Specifications Management CONNECT Edition Integration

• Authoring and modeling of codes, standards, and engineering specifications
• Attribute exchange for SPECX documents
Note: ProjectWise Specifications Management is a separate download.

Changes in Bentley i-model Composition Server for PDF

Support for new Operating Systems
• Bentley i-model Composition Server for PDF is now supported on Windows Server 2012 Standard/

Datacenter Editions (64-bit).
• Bentley i-model Composition Server Administrator is now supported on Windows 8.1 (32/64-bit).

Additional Pattern Variables in the Add Symbol Dialog
• Document.Creator — ProjectWise document “Created by” value.
• Document.CreatedTime — ProjectWise document creation date/time.
• Document.DescriptionExtension — Extension component of the ProjectWise document description.
• Document.FileNameExtension — Extension component of the ProjectWise document file name.
• Document.FileUpdater — ProjectWise document “File Updated by” value.
• Document.FileUpdatedTime — ProjectWise document file updated date/time.
• Document.ModifiedTime — Most recent of the document CreatedTime, UpdatedTime, and

FileUpdatedTime.
• Document.NameExtension — Extension component of the ProjectWise document name.
• Document.Updater — ProjectWise document “Updated by” value.
• Document.UpdatedTime — ProjectWise document updated date/time.
• Folder.Url — URL of ProjectWise folder containing the given document.
• Folder.ProjectUrl — URL of nearest ProjectWise project containing the given document.
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Source Distribution Support in ProjectWise Explorer
Previously, source distribution was restricted to Bentley i-model Composition Server for PDF jobs defined in
Orchestration Framework Administrator. Now, both source and renditions can be distributed in on-demand jobs
submitted from ProjectWise Explorer. Source-only distribution remains limited to Bentley i-model Composition
Server for PDF jobs defined in Orchestration Framework Administrator.
Source distribution is controlled through a new Source Distribution dialog available from the Output Destination
Folder component in ProjectWise Administrator. Using this dialog, you can specify where in ProjectWise the
distributed source files will be stored, and whether or not to distribute references and/or rename the
distributed source files.

New Controls in the Output Destination Folder Component
• Copy version name from source document — When creating or updating a distributed document, the

system allows you to configure whether or not you want to copy the version name from the source document
or to follow the destination datasource rules regarding versioning.

• Copy workflow state from source document — When creating or updating a distributed document, the
system allows you to copy the workflow state from the source document.

Rendition Profile Component Deletion Enhancements
Previously, an attempt to delete a referenced rendition profile component resulted in an error message. This
error message has been replaced with the Rendition Profile Component Delete Failed dialog, similar to the
one used to report ProjectWise folders and projects that depend on rendition profiles being deleted. The
dependent rendition profile names are now displayed in this dialog.

What's New?
New in ProjectWise CONNECT Edition

ProjectWise Design Integration 23 Implementation Guide



 2
Database Setup

ProjectWise uses two databases - one for the ProjectWise Design Integration Server, and one for the ProjectWise
Orchestration Framework Service. ProjectWise Design Integration Server can use either SQL Server or Oracle,
whereas ProjectWise Orchestration Framework Service can only use SQL Server.

Setting Up the Main ProjectWise Database
When you are setting up the main ProjectWise server, before you install any ProjectWise software, you should
set up the database for your ProjectWise datasource. While this section does not attempt to instruct you how to
create your database, or the ODBC datasource, it does cover certain ProjectWise requirements for each
supported database. See your respective database's documentation for relevant database instructions.
1. Install a supported version of Oracle Database or SQL Server. See the Requirements section of the

ProjectWise readme (C:\Program Files\Bentley\ProjectWise\readme_ProjectWise.chm) for the
list of supported databases and drivers.

2. In Oracle Database or SQL Server, create one database for each ProjectWise datasource you plan to create.
This database will contain the ProjectWise database tables, which get created when you create the
ProjectWise datasource.

3. ProjectWise supports languages that use multi-byte characters, and therefore requires that the database
engine used by ProjectWise support Unicode data storage.
SQL Server automatically supports Unicode, and requires no special action. For Oracle databases, you must
manually set the database Character Set and National Character Set encodings. These values are typically
defined when installing the Oracle database software and creating a new Oracle database, although they may
be changed on a running database with some effort (see your Oracle documentation). The two encodings
most typically used in Oracle are UTF8 and AL32UTF8; see your Oracle documentation for information
regarding which character set you should use when creating the database.
If you will be running ProjectWise against an existing Oracle database, you need to verify that the database
NLS character set parameters are set for Unicode. This information is found in the
NLS_DATABASE_PARAMETERS table.

4. All connections to the database are supported by an ODBC connection from ProjectWise Design Integration
Server to the database. Therefore, after creating a database in Oracle or SQL Server, you must create an ODBC
datasource which points to that database. The ODBC datasource/driver must exist on the same computer on
which you install ProjectWise Design Integration Server. Make a note of the name you give the ODBC
datasource, as you will need to select it from a list of available ODBC datasources when you are creating your
ProjectWise datasource.

5. ProjectWise Design Integration Server is a native 64-bit application, therefore you must use the 64-bit ODBC
Data Source Administrator when creating an ODBC datasource, rather than the 32-bit ODBC Data Source
Administrator as in previous releases.
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6. When using SQL Server, make sure that when configuring your ODBC datasource you turn OFF the setting,
Use regional settings when outputting currency, numbers, dates, and times.

7. When using Oracle Database, you cannot use the Microsoft ODBC driver for Oracle, you must use the ODBC
driver delivered with the Oracle client install.

8. When using Oracle Database, the Oracle database user must have (at a minimum) the following privileges
and permissions in order to run ProjectWise Design Integration Server:
• CONNECT role
• CREATE PROCEDURE privilege
• CREATE SEQUENCE privilege
• CREATE TABLE privilege
• CREATE VIEW privilege
• UNLIMITED TABLESPACE privilege
• EXECUTE permission on the DBMS_LOB package

9. When using SQL Server, for optimal performance it is recommended that you disable the max degree of
parallelism server configuration option. You can do this in SQL Server Management Studio by setting the
value of this option to 1.
See the following Microsoft article for details: https://msdn.microsoft.com/en-us/library/ms189094.aspx

ProjectWise Orchestration Framework Service Configuration
ProjectWise Orchestration Framework Service is required by the following servers in order to manage various
document processing jobs:
• ProjectWise Design Integration Server (in support of its automated document processors: full text indexing,

thumbnail image extraction, file properties extraction)
• Bentley i-model Composition Server for PDF
• Bentley Automation Service (a separate download)
Tip: Bentley Automation Service (formerly ProjectWise Automation Service) is no longer delivered with
ProjectWise, and is now a separate download.
ProjectWise Orchestration Framework Service requires SQL Server to store the Orchestration Framework
database, which is where information about each document processing job is kept. A copy of SQL Server Express
Edition is delivered for those organizations who may not be using SQL Server. After installing ProjectWise
Orchestration Framework Service you will be prompted to connect to SQL Server and either create a new
Orchestration Framework database (for new installations), or select an existing Orchestration Framework
database (for upgrades).
Warning: Never select an existing ProjectWise database to use for your Orchestration Framework database!
ProjectWise Design Integration Server, Bentley i-model Composition Server for PDF, and Bentley Automation
Service should each be installed on their own computer, therefore if you are using all of these servers, you will
need to install ProjectWise Orchestration Framework Service on each of those computers. When you have
multiple installations of ProjectWise Orchestration Framework Service, it is recommended that you use the same
Orchestration Framework database for all of them. In this situation you would create a new Orchestration
Framework database for the first installation, and then select the same Orchestration Framework database for
each additional installation.
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Before You Install or Upgrade ProjectWise Orchestration Framework Service

Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.

1. Make sure the computer you are installing on is on the domain.
2. Make sure the latest Windows updates have been installed.
3. Make sure all of these Windows features are installed:

• .NET Framework 4.6
• .NET Framework 3.5
• Message Queuing
See Installing Required Windows Server Features (on page 267).
After installation, make sure the Message Queuing service is running in the Services window.

4. On this or another computer, install Microsoft SQL Server, or use the SQL Server Express that is delivered
with ProjectWise Server Setups.

5. Decide whether you want to use an ODBC connection or a direct database connection to the Orchestration
Framework database.
If you want to use an ODBC connection, then you must first create an empty database in SQL Server to be
used for the Orchestration Framework database, and then create a 64-bit ODBC data source on this computer
that connects to the empty database in SQL Server.
If you want to use a direct database connection, you can either manually create the empty database in SQL
Server, or you can skip this step and allow the Orchestration Framework Database Setup dialog to create the
Orchestration Framework database in SQL Server for you.

6. Set up the user account under which ProjectWise Orchestration Framework Service will run. You will enter
the credentials of this account during ProjectWise Orchestration Framework Service installation when you
encounter the Please provide credentials page of the installer.
This account:
• can either be a local account or a Windows account
• is recommended to have a password that is set to never expire
• must be a member of the Administrators group on this computer (Control Panel > Administrative

Tools > Computer Management > System Tools > Local Users and Groups > Groups)
• must have the Log on as a service right on this computer (Control Panel > Administrative Tools >

Local Security Policy > Security Settings > Local Policies > User Rights Assignments)
• must also already exist in SQL Server (under Security > Logins)
Tip: ProjectWise Orchestration Framework Service will stop running if and when this user account's
password expires. Because Windows accounts typically have passwords that periodically expire, one solution
is to use a local account with a non-expiring password. Another solution is to use a Windows domain account
and set its password to never expire, or simply manually reset the password for ProjectWise Orchestration
Framework Service in the Services window, ideally before the password expires.

7. Make sure the user account you use to launch the ProjectWise Orchestration Framework Service installer is a
Windows account that is a member of the local Administrators group.
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8. It is recommended that you use the same user account to install ProjectWise Orchestration Framework
Service, ProjectWise Design Integration Server, and/or Bentley i-model Composition Server for PDF software.

9. If a previous version of ProjectWise Orchestration Framework Service is installed, uninstall it now, then
restart your computer.

10. If you are upgrading from an earlier version of ProjectWise Orchestration Framework Service and you plan to
reuse (update) your existing Orchestration Framework database, you need to launch the ProjectWise
Orchestration Framework Service installer using the Run as administrator option to ensure the database
schema gets updated. (If the schema is not updated, the products sharing this database will not work.)
Tip: Right-clicking the ProjectWise Orchestration Framework Service MSI installer does not offer the Run as
administrator option; instead you must launch the ProjectWise Server Setups master installer (SETUP.EXE)
using the Run as administrator option and then launch the ProjectWise Orchestration Framework Service
installer from there.

To Install ProjectWise Orchestration Framework Service

1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to ProjectWise Orchestration Framework Service.

3. When the Setup Wizard opens, click Next.
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4. When the License Agreement page opens, read and accept the agreement, then click Next.
The Custom Setup page opens, letting you select the location to install ProjectWise Orchestration
Framework Service.
The default installation location is C:\Program Files (x86)\Bentley\OrchestrationFramework.
64-bit components are installed by default to C:\Program Files\Bentley\OrchestrationFramework.
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5. Accept or change the default installation location, then click Next.
6. On the Please provide credentials page, enter the credentials of the user account that ProjectWise

Orchestration Framework Service will run under, then click Next.
This should be the same user account you set up in the procedure, Before You Install or Upgrade ProjectWise
Orchestration Framework Service (on page 26). If the user is a Windows account, enter the name of the
domain to which the user belongs in the Domain Name field. If the user is a local account, enter the user’s
computer name in the Domain Name field.
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7. When the Ready to Install page opens, click Install.
8. When installation is complete, click Finish.
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The Orchestration Framework Database Setup dialog opens for you to create a new Orchestration
Framework database, or to select an existing one.

Database Setup
ProjectWise Orchestration Framework Service Configuration

ProjectWise Design Integration 31 Implementation Guide



Follow the steps in the next procedure to create or select your Orchestration Framework database.

To Create or Configure the Orchestration Framework Database

1. The Database Setup dialog opens after you click Finish at the end of the ProjectWise Orchestration
Framework Service installation.
This dialog is used to specify which SQL Server database the ProjectWise Orchestration Framework Service
will use as the Orchestration Framework database, and to install the latest Orchestration Framework
database schema into that database if necessary.
Tip: If you happen to close the Database Setup dialog before creating or configuring the database, you can
reopen it by going to C:\Program Files (x86)\Bentley\OrchestrationFramework and double-
clicking the DBSETUP.EXE file.

2. Select which type of database connection you want to use:
ODBC Selecting this option means that you will use a 64-bit ODBC data source on this computer to

connect to the Orchestration Framework database in SQL Server.
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If you plan to use an ODBC connection, you must have already created an empty database in
SQL Server, and you must have already created a 64-bit ODBC data source on this computer
that connects to the empty database in SQL Server.

Direct
Database
Connection

Selecting this option means that you will not use an ODBC data source to connect to SQL
Server, and instead you will connect directly to the Orchestration Framework database in
SQL Server.
With a direct database connection, either you can create the empty database in SQL Server
before using this dialog, or you can use this dialog to create the database in SQL Server.
When you select this option, the dialog behaves the way it used to behave, before the ODBC
option was added.

Left: connecting to SQL Server using an ODBC data source; Right: connecting to SQL Server using a direct
database connection

3. If you selected ODBC as the database connection type, then you need to select an ODBC data source and enter
the appropriate SQL Server credentials for it:
a. Select your ODBC data source from the list.
b. In the Database Security section, select an authentication method. You must select the same

authentication method that you used to configure the ODBC data source.
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Option Description

Use Windows
authentication

The Windows account you are logged in with must have access to the
database that the ODBC data source points to.

Use SQL Server
authentication

Enter the User name and Password of the same SQL Server account that
was used to configure the ODBC data source. This account will have access to
the database that the ODBC data source points to.

c. Click Test Data Source to make sure the specified account can connect to the database.
If the specified account is able to connect, a dialog opens with the message, TEST COMPLETED
SUCCESSFULLY!!
Once connected, the Database Status field informs you that the database pointed to by the ODBC data
source needs the latest Orchestration Framework database schema.

d. Click OK to install the latest Orchestration Framework database schema into the database.
4. If you selected Direct Database Connection as the database connection type, then you need to establish a

connection to SQL Server and either create a new Orchestration Framework database or select an existing
empty database to use as the Orchestration Framework database:
a. In the Server field, enter name of the computer where SQL Server is installed.

This field defaults to the local computer name. If your SQL Server installation has named instances, enter
the name of the computer, followed by a backslash, followed by the SQL Server instance name you want to
connect to. For example, computername\SQLServerinstancename.

b. In the Database Security section, select an authentication method and specify which account to use to
connect to SQL Server:
Option Description

Use Windows
authentication

The Windows account you are logged in with will be used to connect to the
SQL Server instance specified in the Server field.

Use SQL Server
authentication

Enter the User name and Password of a SQL Server account that will be
used to connect to the SQL Server instance specified in the Server field.

The account you specify here must be the same as the account specified on the Please provide
credentials page of the Setup Wizard during ProjectWise Orchestration Framework Service installation.
Tip: To quickly verify that the specified account is valid and can connect to SQL Server, try to select the
Database list. If connection is successful, the list will be populated with databases. If connection is not
successful, you will get an error and the list will be empty. If that is the case, one of the following may be
true:
• The service for the specified SQL Server instance may not be running. Make sure that it is running,

then try again.
• The SQL Server computer name specified, or instance name, or both, may be incorrect. Make sure you

typed the name(s) correctly, then try again.
• The account you are trying to use does not exist in SQL Server. Make sure this account (whether local

or Windows) exists in SQL Server with appropriate database permissions, then try again.

c. Once you have established a connection to SQL Server, the next step is to either create a new database in
it, or select an existing empty database:
Click the New button next to the Database list, then in the Create Database dialog, enter a name for the
database and click OK. The database is added to SQL Server and selected in the Database list.
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or
If you already have an empty database in SQL Server, select that database from the Database list.
The Database Status field informs you that the selected database needs the latest Orchestration
Framework database schema.

d. Click OK to install the Orchestration Framework database schema into the selected database.

Note: If you have installed the same version of ProjectWise Orchestration Framework Service and created or
configured a database on another computer, and you want to use the same database with this new installation of
ProjectWise Orchestration Framework Service, then select the existing database from the Database list. In this
case, the Database Status field will inform you that the selected database already has the latest Orchestration
Framework schema installed.
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ProjectWise Design Integration Server Configuration

Setting Up the ProjectWise Design Integration Server Computer
ProjectWise Design Integration Server is the primary server of ProjectWise, and is the server on which your
datasources are created. Every other ProjectWise module, whether it is a user client, an administrative client, or
another server, is said to be a client of the ProjectWise Design Integration Server.
ProjectWise Design Integration Server delivers some optional automated file processing features which require
some additional configuration beyond a basic ProjectWise Design Integration Server installation. Please review
the configuration checklist for each automated file processing feature before proceeding with ProjectWise
Design Integration Server installation. If you plan to install all of the automated file processing features, some of
the configurations listed in each checklist may be duplicated and you will only need to perform those steps once.
Note: You can host storage areas on the ProjectWise Design Integration Server computer, or you can also install
ProjectWise Caching Server on another computer and host storage areas on that computer.

Full Text Indexing Configuration Checklist

Full text indexing is the feature of ProjectWise Design Integration Server that extracts text from documents in the
datasource and then stores that text in a full text index catalog. Users can then search the datasource for any
documents containing the indexed text. To manage the catalog, ProjectWise uses Windows Search. You can store
the catalog on the ProjectWise Design Integration Server computer itself, or on a separate computer where
ProjectWise Indexing Service is installed. When using a standalone ProjectWise Indexing Service, the
ProjectWise Design Integration Server forwards full text searches, and any text extraction updates, to the
ProjectWise Indexing Service, which in turn uses its own local Windows Search service.
The following is a checklist of things you need to do to set up the full text indexing feature in general, for all
datasources run by this server. Once the feature is set up, you then use ProjectWise Administrator to enable the
feature and run full text indexing jobs on a per datasource basis.
Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.
1. On this or another computer, install Microsoft SQL Server, or use the SQL Server Express that is delivered

with ProjectWise Server Setups.
2. On this computer, install or configure the prerequisites needed for ProjectWise Orchestration Framework

Service.
See Before You Install or Upgrade ProjectWise Orchestration Framework Service (on page 26) for details.

3. On this computer, also install Windows Search.
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See Installing Required Windows Server Features (on page 267).
After installation, make sure the Message Queuing and Windows Search services are running in the
Services window.

4. Install the software required (if any) for the file types you plan to process.
Depending on the file types you want to index text from, you may need to install additional software on the
computer performing the text extraction (which is typically the ProjectWise Design Integration Server
computer). The additional software required is an iFilter for the required file type, but in some cases you may
have to install the full application to get the required iFilter. The following table lists some of the common file
types that you will need to install additional software for.
To index text from Install

DGN and DWG documents MicroStation
• CONNECT Edition Update 6 or 7
• V8i (SELECTseries 4)

PDF documents PDF iFilter 9.0 (64-bit)
MSG (Microsoft Outlook message)
documents

MSG iFilter (64-bit)

Documents attached to MSG
documents

MSG iFilter (64-bit) plus an iFilter (64-bit) for the attached document

Note: Currently, ProjectWise cannot index text from a DGN document that is attached to an MSG document.
5. If you plan to host and maintain the catalog on this computer, you can either preset the index storage location

before installing ProjectWise Design Integration Server, or you can let ProjectWise Design Integration Server
set its own default location for the catalog. There is no setup required if you want to use the default location,
however, if you choose to preset your own index storage location, follow the steps in the procedure, To
Preset the Full Text Index Storage Location (on page 78).

6. On this computer, install the following software from ProjectWise Server Setups:
• ProjectWise Prerequisite Runtimes
• ProjectWise Orchestration Framework Service (on page 27)
• ProjectWise Design Integration Server (on page 40) with the Automated File Processing > Full Text

Indexing option enabled
7. (Optional) If you want to host the text index catalog on another computer, install ProjectWise Indexing

Service (on page 98) on that computer.
You can skip this step if you plan to host the text index catalog on the ProjectWise Design Integration Server
computer. Also, regardless of which computer hosts the catalog, the ProjectWise Design Integration Server
will always perform the text extractions.

8. After you install an iFilter, make sure you restart the services for both Windows Search and ProjectWise
Integration Server in the Services window.

9. On this or another computer, install ProjectWise Administrator (on page 45) with the Automated File
Processing and Orchestration Framework Administrator options enabled.

10. In ProjectWise Administrator:
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a. Set up a user account in the datasource to use for running full text indexing jobs. The user’s user setting
General > Use access control should be OFF, to ensure the user has access to all documents in the
datasource.

b. Configure the Full Text Indexing document processor. See “Processing Documents Using Orchestration
Framework” in the ProjectWise Administrator help for details.

Thumbnail Image Extractor Configuration Checklist

Thumbnail image extraction is the feature of ProjectWise Design Integration Server that extracts thumbnail
images from documents in the datasource. ProjectWise Explorer users will then be able to see the thumbnail
images of their documents when they browse the document list.
The following is a checklist of things you need to do to set up the thumbnail image extraction feature in general,
for all datasources run by this server. Once the feature is set up, you then use ProjectWise Administrator to
enable the feature and run thumbnail image extraction jobs on a per datasource basis.
Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.
1. On this or another computer, install Microsoft SQL Server, or use the SQL Server Express that is delivered

with ProjectWise Server Setups.
2. On this computer, install or configure the prerequisites needed for ProjectWise Orchestration Framework

Service.
See Before You Install or Upgrade ProjectWise Orchestration Framework Service (on page 26) for details.

3. On this computer, install the software required (if any) for the file types you plan to process:
• Adobe Reader X is required to extract thumbnail images from PDFs.
• No additional software is required to extract thumbnail images from V8 DGN, AutoCAD DWG (AutoCAD

2010 and later formats), and Revit documents.
Tip: Thumbnails cannot be generated from pre-V8 DGN documents.

4. On this computer, install the following software from ProjectWise Server Setups:
• ProjectWise Prerequisite Runtimes
• ProjectWise Orchestration Framework Service (on page 27)
• ProjectWise Design Integration Server (on page 40) with the Automated File Processing > File

Property and Thumbnail Image Extractors option enabled
5. On this or another computer, install ProjectWise Administrator (on page 45) with the Automated File

Processing and Orchestration Framework Administrator options enabled.
6. In ProjectWise Administrator:

a. Set up a user account in the datasource to use for running thumbnail image extraction jobs. The user’s
user setting General > Use access control should be OFF, to ensure the user has access to all documents
in the datasource. Also, the user’s user setting Document > Can modify must be ON.

b. Configure the Thumbnail Extraction document processor. See “Processing Documents Using
Orchestration Framework” in the ProjectWise Administrator help for details.
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File Property Extractor Configuration Checklist

File property extraction is the feature of ProjectWise Design Integration Server that extracts file properties from
documents in the datasource. ProjectWise Explorer users will then be able to see the file properties of their
documents on the File Properties tab of the Document Properties dialog.
The following is a checklist of things you need to do to set up the file property extraction feature in general, for
all datasources run by this server. Once the feature is set up, you then use ProjectWise Administrator to enable
the feature and run file property extraction jobs on a per datasource basis.
Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.
1. On this or another computer, install Microsoft SQL Server, or use the SQL Server Express that is delivered

with ProjectWise Server Setups.
2. On this computer, install or configure the prerequisites needed for ProjectWise Orchestration Framework

Service.
See Before You Install or Upgrade ProjectWise Orchestration Framework Service (on page 26) for details.

3. On this computer, install the software required (if any) for the file types you plan to process:
• Install Adobe Reader X if you want to extract file properties from PDFs.
Note: The MSG iFilter is no longer required to extract file properties from MSG documents.

Note: Due to an AutoCAD limitation, you cannot extract file properties from DWG documents.
4. On this computer, install the following software from ProjectWise Server Setups:

• ProjectWise Prerequisite Runtimes
• ProjectWise Orchestration Framework Service (on page 27).
• ProjectWise Design Integration Server (on page 40) (with the Automated File Processing > File

Property and Thumbnail Image Extractors option enabled)
5. On this or another computer, install ProjectWise Administrator (on page 45) with the Automated File

Processing and Orchestration Framework Administrator options enabled.
6. In ProjectWise Administrator:

a. Set up a user account in the datasource to use for running file property extraction jobs. The user’s user
setting General > Use access control should be OFF, to ensure the user has access to all documents in the
datasource. Also, the user’s user setting Document > Can modify must be ON.

b. Configure the File Property Extractions document processor. See “Processing Documents Using
Orchestration Framework” in the ProjectWise Administrator help for details.

Installing ProjectWise Design Integration Server

Before You Install or Upgrade ProjectWise Design Integration Server
See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and other
system requirements.
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1. Create a database in SQL Server or Oracle, then create an ODBC datasource that points to that database (on
page 24).

2. Ideally, the computer you are about to install ProjectWise Design Integration Server on should be on a
domain.

3. Make sure the latest Windows updates have been installed.
Note: In particular, make sure you have the update for Universal C Runtime (CRT) in Windows installed:
https://support.microsoft.com/en-us/help/3118401/update-for-universal-c-runtime-in-windows

4. Make sure that the computers on which you install ProjectWise Design Integration Server and all ProjectWise
Caching Servers have their clocks synchronized with the time of an authoritative computer. If the clocks are
not properly synchronized, then any tokens issued by ProjectWise Design Integration Server may expire
prematurely when a user attempts to check out a document, causing the operation to fail. See the following
Microsoft article for details:
http://technet.microsoft.com/en-us/library/cc773013(WS.10).aspx

5. Install ProjectWise Prerequisite Runtimes (available from ProjectWise Server Setups).
6. If you plan to implement full text indexing, see the full text indexing configuration checklist (on page 36).
7. If you plan to implement thumbnail image extractions, see the thumbnail image extractor configuration

checklist (on page 38).
8. If you plan to implement file property extractions, see the file property extractor configuration checklist (on

page 39).
9. ProjectWise Design Integration Server cannot be installed on a computer on which ProjectWise Caching

Server, ProjectWise Gateway Service, or ProjectWise Indexing Service is already installed.
10. The ProjectWise Design Integration Server installer automatically adds the ProjectWise broadcasting and

listening ports of 5799 and 5800 to the Windows Firewall exception list on this computer.
11. If you plan to use the Product Activation Wizard as launched from the final page of the Setup Wizard, then

you must launch the master ProjectWise Server Setups installer using the Run as Administrator option. This
ensures that the Product Activation Wizard is also run as an administrator, which in turn ensures that the
licensing information you enter through the Product Activation Wizard gets registered to the correct location
in the Windows Registry.

To Install ProjectWise Design Integration Server

1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to ProjectWise Integration Server.
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3. When the Setup Wizard opens, click Next.

 

 
4. When the License Agreement page opens, read and accept the agreement, then click Next.

The Custom Setup page opens, showing you the features that can be installed, and the location to which the
product will be installed.
The following additional items can be installed through the ProjectWise Design Integration Server installer:
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Component Services EC plugin — Server-side files required for using Bentley OpenPlant with this server.
Installing this feature creates a website in IIS called “Component Services”.
Automated File Processing > Full Text Indexing — Server-side files for performing full text extractions,
indexing of the extracted text to a catalog, and searching and retrieving text from the catalog when users
run full text searches.
Automated File Processing > File Property and Thumbnail Image Extractors — Server-side files for
performing file property and thumbnail image extractions.
ProjectWise Indexing Connector for SharePoint — Used with ProjectWise Web Server.
Spatial extension — Provides basic spatial features to ProjectWise. This extension is automatically
installed when you install ProjectWise Design Integration Server, there is no option for it on the installer.

Note: The Automated File Processing features are optional and cannot be installed if ProjectWise
Orchestration Framework Service is not installed.

5. Select the features you want to install by clicking the feature's icon and selecting the appropriate option from
the menu. Items with an X to the left of them will not be installed.

 

 
6. Accept the default installation location or click the Change button (if available) to change it.

The default installation location is C:\Program Files\Bentley\ProjectWise.
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Note: The Change button will not display on this installer if another 64-bit application from this release is
already installed; in that case, the ProjectWise Design Integration Server will be installed to the same location
as the previously installed application.

7. When finished on the Custom Setup page, click Next.
8. On the Storage Location page, specify the physical location on this computer under which storage areas

hosted by this server can be created.
If no storage location is currently defined If a storage location is already defined

Click Browse to select the storage location, then
click Next.

Select Keep existing storage location and click
Next (the storage location shown will be used).
or
Select Specify new storage location, click Browse
to change the storage location, and click Next when
finished.

The location you specify is added to this server's DMSKRNL.CFG file under the section labeled, “Section
defines allowable locations for storage areas”. For example:
; -------------------------------------------------------------
; Section defines allowable locations for storage areas
; -------------------------------------------------------------

[FileStorageService]
StorageLocation0=D:\pwstorage

Now when you create storage areas for this server in ProjectWise Administrator, you will only be able to
create a storage area if the location you select is somewhere within the allowable storage location.
Tip: You can only add one local storage location through the installer, but you can manually edit the
DMSKRNL.CFG file after installation if needed to add additional local and/or remote storage locations for this
server.

9. When the Ready to Install page opens, click Install.
10. (Optional) On the last page of the wizard, the Launch License Management Tool option is on by default.

ProjectWise Design Integration Server Configuration
Setting Up the ProjectWise Design Integration Server Computer

ProjectWise Design Integration 43 Implementation Guide



 

 
11. Click Finish.

If you selected the Launch License Management Tool option, the Product Activation Wizard opens for you
to configure licensing (on page 260) for this server.

Important: After installation, you must manually start the service for this server in the Services window.

Installing ProjectWise Administrator

ProjectWise Administrator is the main administrative interface for ProjectWise. It provides tools for datasource
creation, as well as server, datasource, and user management. ProjectWise Administrator is typically installed on
the same computer as ProjectWise Design Integration Server, but can also be installed on other server or client
computers as needed.

Before You Install or Upgrade ProjectWise Administrator

Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.

1. Make sure the latest Windows updates have been installed.
Note: In particular, make sure you have the update for Universal C Runtime (CRT) in Windows installed:
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https://support.microsoft.com/en-us/help/3118401/update-for-universal-c-runtime-in-windows
2. Make sure Microsoft .NET Framework 4.5.1 or later is installed.
3. If ProjectWise Administrator V8 XM Edition or earlier is installed, uninstall it now.

If ProjectWise Administrator V8i or later installed, you can leave it installed and let the new ProjectWise
Administrator installer upgrade it for you.
Note: If you have additional ProjectWise applications installed from the same older (V8i or later) release
version, see Upgrading to the Current Version > Precautions (on page 253) for the recommended workflow
for upgrading.

4. Install the CONNECTION Client, delivered with ProjectWise Admin Setups.
Note: An internet connection is required to install the CONNECTION Client.

To Install ProjectWise Administrator

1. Double-click the SETUP.EXE file to open the ProjectWise Admin Setups master installer.
 

 
2. Click Install next to ProjectWise Administrator.

If this is a fresh install, the Setup Wizard opens. Skip to step 4.
If this is an upgrade, a second page of the ProjectWise Server Setups window opens. Continue with the next
step.

3. Do one of the following:
If upgrading from ProjectWise Administrator V8i or later, click Install. The installer will automatically
uninstall the old version and then install the new version.
or
If upgrading from ProjectWise Administrator V8 XM Edition or earlier, click Remove to uninstall the old
version. When uninstallation is complete, click Install to install the new version.

 

ProjectWise Design Integration Server Configuration
Setting Up the ProjectWise Design Integration Server Computer

ProjectWise Design Integration 45 Implementation Guide

https://support.microsoft.com/en-us/help/3118401/update-for-universal-c-runtime-in-windows


 
4. When the Setup Wizard opens, click Next.

 

 
5. When the License Agreement page opens, read and accept the agreement, then click Next.
6. When the Setup Type page opens, select Custom and click Next.

The Custom Setup page opens, showing you the features that can be installed, and the location to which the
product will be installed.
The following items can be installed through this installer:
ProjectWise Administrator (includes server and datasource management tools)
Environment Administration (environments, interfaces)
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General Administration (applications, departments, states, workflows, storage areas)
Messaging Services Management

ProjectWise Class Editor (installs ProjectWise Class Editor, a separate application)
Additional Administration Utilities (installs menu editor, a separate application)
iDesktop Attribute Administrator

Automated File Processing (thumbnails, full text, file properties)
Work Area Type Editor

Spatial Administrator (coordinate systems, symbologies, background maps, spatial metadata scanners)
PowerShell Extensions

Orchestration Framework Administrator (installs Orchestration Framework Administrator, a separate
application)

7. To change whether or not a feature gets installed, click the feature's icon and select the appropriate option
from the menu.
Items with an X next to them will not be installed.
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8. Accept the default installation location or click the Change button (if available) to change it.
Because ProjectWise Administrator is a 32-bit application, the default installation location is
C:\Program Files (x86)\Bentley\ProjectWise.
Note: When upgrading from a V8i or later version of ProjectWise Administrator, the Change button will not
display for you to change the installation location, and the new version will be automatically installed to the
same location as the previous version.

9. When finished on the Custom Setup page, click Next.
10. When the Ready to Install page opens, click Install.
11. When installation is complete, click Finish.

Installing the Example Dataset and Business Process Template for BS1192

ProjectWise Admin Setups delivers the following optional resources for setting up a datasource:
• ProjectWise Example Dataset, which includes:

• an example datasource template file
• an example attribute exchange rules file
• a generic workflow rules engine template

• ProjectWise Business Process Template for BS1192

By default, installing the example dataset installs files to:
• C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets\Example Template

Datasource Map.pdf
• C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets\Example Template
• C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets\Rules Engine

By default, installing the ProjectWise Business Process Template for BS1192 installs files to:
• C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets\BS1192

To use any of these items, you must install them first, and then import them into your datasource. The way in
which you import and set up these items depends on the item. See below.

General Steps for Importing the Example Datasource Template
1. Install the ProjectWise Example Dataset.
2. Create a datasource.
3. Either import the example datasource template (Example Template.aam) into the datasource through the

Data Import Wizard that opens at the end of datasource creation, or import it later using the ProjectWise
Import Wizard (this is a different wizard).

General Steps for Importing the Example Attribute Exchange Rules
1. Install the ProjectWise Example Dataset.
2. Create a datasource.
3. Either import the example attribute exchange rules file (Example Attribute Exchange Rules.ini) into

the datasource through the Data Import Wizard that opens at the end of datasource creation, or import it
later through the Attribute Exchange Rules node in ProjectWise Administrator.

ProjectWise Design Integration Server Configuration
Setting Up the ProjectWise Design Integration Server Computer

ProjectWise Design Integration 48 Implementation Guide



General Steps for Importing the Generic Workflow Rules Engine Template
1. Install the ProjectWise Example Dataset.
2. Create a datasource.
3. Import the workflow rules engine template (RulesEngineTemplate.aam) into the datasource using the

ProjectWise Import Wizard.
4. Export the workflow rules file (example_rules.xlsx) out of ProjectWise Explorer to a local folder.
5. Import example_rules.xlsx into a datasource through the Rules Engine node in ProjectWise

Administrator.

General Steps for Importing the ProjectWise Business Process Template for BS1192
1. Install the ProjectWise Business Process Template for BS1192.
2. Create a datasource.
3. Import the ProjectWise Business Process Template for BS1192 (BS1192 Template for SQL Server.aam

or BS1192 Template for Oracle.aam, depending on your database) into the datasource using the
ProjectWise Import Wizard.

4. Export the workflow rules file (bs1192_rules.xlsx) out of ProjectWise Explorer to a local folder.
5. Import bs1192_rules.xlsx into a datasource through the Rules Engine node in ProjectWise

Administrator.

To Install the Example Dataset

1. Double-click the SETUP.EXE file to open the ProjectWise Admin Setups master installer.
2. Click Install next to ProjectWise Example Dataset.

 

 
3. When the Setup Wizard opens, click Next.
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4. When the License Agreement page opens, read and accept the agreement, then click Next.
5. When the Destination Folder page opens, select where to install the dataset and click Next.
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6. When the Ready to Install page opens, click Install.
7. When installation is complete, click Finish.

To Install the ProjectWise Business Process Template for BS1192

1. Double-click the SETUP.EXE file to open the ProjectWise Admin Setups master installer.
2. Click Install next to ProjectWise Business Process BS1192 Template.

3. When the Setup Wizard opens, click Next.
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4. When the License Agreement page opens, read and accept the agreement, then click Next.
5. When the Ready to Install page opens, click Install.
6. When installation is complete, click Finish.

Creating Datasources
You create datasources in ProjectWise Administrator. Each datasource you create must have its own database in
SQL Server or Oracle. Creating multiple datasources that use a single database is not supported.
Creating a datasource will add the necessary ProjectWise database tables to the supporting database.
After creating the datasource you can:
• set up your datasource from scratch
• import data from a previously exported datasource
• import the delivered example datasource template
ProjectWise Admin Setups delivers an extensive example template, which you can use as a quick and easy way to
set up a datasource and become familiar with the new features of this version before setting up your own
production datasource.
Caution: The ProjectWise database schema is unpublished and is subject to change without notice.
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Before You Create the Datasource

1. If you want to create a datasource using the example template and you have not installed it yet, install the
example dataset (on page 48) now from ProjectWise Admin Setups.

2. Open ProjectWise Administrator:
• On Windows 8 or later / Windows Server 2012 or later:

Go to the Start page and type ProjectWise Administrator, or go to Start > Apps > Bentley and click
ProjectWise Administrator.

• On Windows 7 / Windows Server 2008:
Select Start > All Programs > Bentley > ProjectWise <version> > ProjectWise Administrator.

 

 
3. When ProjectWise Design Integration Server and ProjectWise Administrator are installed on the same

computer, the server's computer name is automatically registered and displayed under the Servers node
when you open ProjectWise Administrator. If you would like to create a datasource on a ProjectWise Design
Integration Server that is not displayed in ProjectWise Administrator, you need to register the name or IP
address of the ProjectWise Design Integration Server computer. To do this, right-click the Servers node in
ProjectWise Administrator and select Register Server. Type the computer name or IP address of the
computer on which ProjectWise Design Integration Server is installed and running, then click Finish.

4. The Applications node in ProjectWise Administrator is populated when you create the datasource, using the
information contained in the APPINFO.XML file (...\ProjectWise\bin). You can modify this file as needed
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using any text editor before creating your datasource, or you can simply modify the default list of
applications in ProjectWise Administrator after creating the datasource.

To Create a ProjectWise Datasource

1. In ProjectWise Administrator, right-click the Datasources node under your server and select New
Datasource.

 

 
2. When the New Datasource Wizard opens, click Next.
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3. On the Choosing datasource type page, select the default option, A datasource that is located on

<computername>, then click Next.
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4. On the Naming the datasource page, in the Datasource name field, type a name for your datasource.

Optionally, you can enter a display name for the datasource in the second field. If you only fill in the first field,
the datasource will be displayed to users as <computername>:<datasourcename>, for example,
shaup123:projectwise. Entering a display name lets you use a name that is more recognizable (or easier
to remember) for your users, and it also serves the purpose of hiding (from users) the computer name on
which the server is located. When finished, click Next.
Caution: The following characters may not be used in either the Datasource name or Display name fields:
\ / : * ? " < > | @
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5. On the Specifying ODBC connection details page, select the ODBC datasource that you have configured to

connect to your ProjectWise database instance, then click Next.
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6. On the Specifying database user account for client connections page, type the user name and password

that matches the user name and password of an existing account in your database instance, then click Next.
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7. On the Specifying administrator account page, create the initial ProjectWise administrator account for this

datasource by entering a user name and password of your choice, and then retyping the password to confirm.
Make a note of these credentials as you will need them later to log in to this datasource in ProjectWise
Administrator. When finished, click Next.
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8. On the Finishing New Datasource Wizard page, do one of the following:

Turn on Create datasource data from template (to import datasource settings from a template) and click
Finish.
or
Turn off Create datasource data from template (if you do not want to import datasource settings) and click
Finish.
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The Create Database Tables dialog opens.

 

 
9. Turn on Enable "Create" Button and then click Create.

The Creating Tables dialog opens, displaying the progress of the creation of the ProjectWise tables.
Soon after the Creating Tables dialog opens, the Create Administrator and Storage dialog opens to create
administrator group accounts, establish a storage area, and verify administrator account password.

 

ProjectWise Design Integration Server Configuration
Creating Datasources

ProjectWise Design Integration 61 Implementation Guide



 
10. On the Create Administrator and Storage dialog, do the following:

a. (Optional) In the Administrator Group section, change the name and description of the default
Administrator group if needed.
By default, the name is set to Administrator. You can leave it as is for now, and rename it later if
necessary in ProjectWise Administrator, after the datasource is created. After datasource creation, any
user you add to this group will be able to log in to the datasource in ProjectWise Administrator and will
have full control over all areas of the datasource.

b. (Optional) In the Restricted Administrator Group section, change the name and description of the
default Restricted Administrator group if needed.
By default, the name is set to Restricted Administrator. You can leave it as is for now, and rename it
later if necessary in ProjectWise Administrator, after the datasource is created. After datasource creation,
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any user you add to this group will be able to log in to the datasource in ProjectWise Administrator, but
will only have access to the areas of the datasource to which they are explicitly assigned access.

c. In the Storage section, select which type of file driver this storage server should use and set the location
for the storage area.
• Driver Type - Select Windows File System (the default) if the storage area will be on-premise. Only

select Azure Blob Storage if the storage area will be hosted in the cloud.
• Path - In the Path field, enter the location where you want the storage area folder for this datasource

to be created. For example, C:\pwstorage\pwtest. The folder you specify cannot already exist -
clicking OK in this dialog will create it for you. Only use the Browse button to help you find the root
storage folder you want to use, if one exists, for example, C:\pwstorage.

• The storage area Name, Description, and Host computer fields are already filled in by default. You
can accept the defaults or change them as necessary. The computer name listed in the Host field
defaults to the computer on which you are working (that is, the ProjectWise Administrator computer).
If you change the host, remember that either a ProjectWise Design Integration Server or a ProjectWise
Caching Server must be installed on that computer in order to create the storage area on that
computer.

Important: Make sure that the location you select for your storage area in the Path field is somewhere
within the allowable storage location, as set during server installation and defined in the server's
DMSKRNL.CFG file.

d. In the Administrative User section, enter the password of the new ProjectWise administrator account in
the Verify Password field, type the password of the Administrator account for this datasource (this is the
administrator account that was created in step 7).

e. Click OK.
At this point, the Creating Tables dialog resumes showing progress of the ProjectWise tables being created in
the database.

11. When the dialog informs you that the tables have been created, click Close.
 

 
12. If you turned off Create datasource data from template on the last page of the New Datasource Wizard,

then at this point, datasource creation is complete and you are logged in to the datasource. You can now
manually configure each node in your datasource as required.
or
If you turned on Create datasource data from template on the last page of the New Datasource Wizard,
then at this point the Data Import Wizard opens; click Next.
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The Selecting template page opens for you to select which data template file you want to import, and
optionally, which attribute exchange template you want to import.
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Assuming you have already installed the new example dataset (on page 48), the wizard automatically loads
the Example Template.aam file and supporting Example Attribute Exchange Rules.ini file.
You can import these files to set up an example datasource for testing, or you can import your own data from
a previously exported datasource. The Example Template.aam file is in the same format used by the
ProjectWise Export and Import Wizards. The Data Import Wizard accepts .AAM files exported from
ProjectWise versions 2.x, 3.x, and 8.x.
Tip: Importing the new example template files is recommended if you are new to ProjectWise, as it is a quick
and easy way to set up a datasource. It is also a good way for administrators to get familiar with the new
features of this version before you set up your own production datasource.

13. On the Selecting template page:
a. Either leave the default template selected, or click the Browser button (...) to select another template.
b. (Optional) Either leave the default Attribute Exchange template selected, or click the Browser button (...)

to select another template. You can also turn off Import Attribute Exchange template file altogether if
you do not want to import any Attribute Exchange template.

c. When finished, click Next.
The results of the import are displayed on the Review import results page.
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14. Review the import results and click Next.
15. Click Finish.
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You are now logged in to the datasource.
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Configuring the Example Datasource Template
The example datasource template is useful if you need to quickly setup a new datasource for testing and
demonstration purposes.
The easiest way to import the example datasource template, along with the corresponding example attribute
exchange rules file, is through the Data Import Wizard that opens at the end of the datasource creation process.
If you do not use the Data Import Wizard to import these items, you can import them into your datasource later.
To import the example datasource template later (after datasource creation), use the ProjectWise Import Wizard
(PWIMPT.EXE). Through this import wizard you can select which items from the example template you want to
import. It is not necessary to choose every option when using the import wizard; however, to use every feature
of the example template, all options should be selected. Because the ProjectWise Import Wizard does not import
the example attribute exchange rules file, you will need to import this separately (right-click the Attribute
Exchange Rules node in ProjectWise Administrator and select Import Mappings).
Tip: Installing the example dataset also installs a document called Example Template Datasource Map.pdf
that describes the example dataset and where to find things in ProjectWise Explorer once the example
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datasource template has been imported. To review this document, it is installed to
C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets.

To Manually Import the Example Template

1. Make sure you have already installed the new example dataset (on page 48).
2. Open a command prompt and enter:

pwimpt.exe /workflow
3. On the Welcome page of the ProjectWise Import wizard, select Yes to indicate that you will log in as the

administrator, then click Next.
4. When the ProjectWise Log in dialog opens, select the datasource you want to import the data into. Enter the

user name and password of an administrative user account in the selected datasource (Password is case
sensitive, User Name is not), and click Log in.

5. On the Define the import settings page, click the check box next to every option and click Next.
6. On the next page, turn on the check box next to Project/Folder in the Update if exists section, then click

Next.
7. On the next page, click Next to accept the default import settings for managed workspaces.
8. On the next page, click Browse to locate the Example Template.aam file.

By default the example template is installed to
C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets\Example Template.

9. Select the Example Template.aam file and click Open.
Selecting the AAM file automatically populates the Log file name field.

10. Click Next.
The next page lets you choose where the imported folders and documents will be placed.

11. Place all of the folders under the Documents root folder.
12. Select the storage area you want to use and click Import.
13. When finished, click Close.

To Manually Import the Example Attribute Exchange Rules

1. In ProjectWise Administrator, log in to your datasource.
2. Right-click the Attribute Exchange Rules datasource node and select Import Mappings.
3. When prompted, click Yes to confirm that you understand that the import will delete all existing mappings.
4. In the Open dialog, navigate to

C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets\Example Template, select the
Example Attribute Exchange Rules.ini file, and click Open.

Run a Reference and Link Set Scan on the Example Dataset

1. In ProjectWise Explorer, select Tools > Scan References and Link Sets and when the wizard opens, click
Next.

2. On the Specify Scan Options page, leave both options on (to scan for both master/reference documents and
link sets) and click Next.

3. On the Select Master Files and Folders page, select these folders to scan:
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• BSI200 - Peterborough Geospatial Investigation
• BSI300 - Medical Complex - Cordoba
• BSI400 - W01 - Intersection of I-9 and SR 32
• BSI900 - Adelaide Tower
• Gas Authority, Inc.
• Wedraw Drafters, Inc. - New Employee Training
• Templates

 

 
4. Click Next.
5. On the Master Folder Settings page, turn on the check box next to every folder so that all subfolders will be

searched for references and link sets. Leave the Application filter check boxes unchecked. Click Next.
6. On the Reference File Priority Search Options page, turn off Enable Priority Search and click Next.
7. On the Reference File Proximity Search Options page, turn on Search Subfolders for References, select

Advanced, and enter 5 for the number of folders above the master file’s folder. Click Next.
8. On the Reference File Search Options page, optionally specify a log file, then click Next.
9. On the final page of the wizard, click Scan to start the scan.

10. Click Close when the scan is complete.

Import a Coordinate System to Use with the Example Dataset

1. In ProjectWise Administrator, right-click the Coordinate System datasource node and select Add from
Dictionary.

2. In the Add Coordinate Systems dialog, from the Coordinate Systems Groups list, select Projected defs
from ESPG, area undetermined.

3. In the Available coordinate systems in the selected group list, select:
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EPSG:2029 NAD27(76) / UTM zone 17N
4. Click Add.

Create the Single Layer Background Maps To Use with the Example Dataset

Before background maps can be viewed on the Spatial tab in ProjectWise Explorer, they must be created in
ProjectWise Administrator. First, create the example template background maps with a single layer.
1. In ProjectWise Administrator, right-click the Background Maps datasource node and select Create

Background Map.
The Background Map Settings dialog opens.

2. In the Map Name field, enter: Natural City
3. Set Coordinate System to EPSG:2029.
4. Click Add Layer.

The Edit Map Layer Settings dialog opens.
5. Click the down arrow next to the URL field and select Add DPR Layer.

The Choose a document for the layer dialog opens.
6. In the dialog, navigate to the following folder: dmsSystem\Spatial\Background Map DPR Files

Take a moment to look at the descriptions for each of the documents in this folder.
• The first value tells you which background map the document is for.
• The second value tells you what order to add the documents in.
• The third and fourth values tell you the minimum and maximum scale values, respectively.

7. Select the document that has the description Natural City - Layer 1 - 0_0 and click Open.
8. Click OK in the Edit Map Layer Settings dialog.
9. In the Background Map Settings dialog, click Browse.

10. In the Select Folder dialog, navigate to the dmsSystem\Spatial\Background Map Settings Files
folder and click OK.

11. In the Background Map Settings dialog, click Save.
12. Repeat steps 1 to 11 to create the Rose City, South City and West City background maps.

Create the Multi-layer Background Map To Use with the Example Dataset

Background maps can also have multiple layers. The example template has one multi-layer background map
called East City.
1. In ProjectWise Administrator, right-click the Background Maps datasource node and select Create

Background Map.
The Background Map Settings dialog opens.

2. In the Map Name field, enter: East City
3. Set Coordinate System to EPSG:2029.
4. Click Add Layer.

The Edit Map Layer Settings dialog opens.
5. Click the down arrow next to the URL field and select Add DPR Layer.
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The Choose a document for the layer dialog opens.
6. In the dialog, navigate to the following folder: dmsSystem\Spatial\Background Map DPR Files

Take a moment to look at the descriptions for each of the documents in this folder.
• The first value tells you which background map the document is for.
• The second value tells you what order to add the documents in.
• The third and fourth values tell you the minimum and maximum scale values, respectively.

7. Select the document that has the description East City - Layer 1 - 0_0 and click Open.
8. Click OK in the Edit Map Layer Settings dialog.
9. Click Add Layer.

The Edit Map Layer Settings dialog opens.
10. Click the down arrow next to the URL field and select Add DPR Layer.

The Choose a document for the layer dialog opens.
11. In the dialog, navigate to the following folder: dmsSystem\Spatial\Background Map DPR Files and

select the document that has the description East City - Layer 2 - 4000_0 and click Open.
Remember the two numbers at the end of the description of this document (4000 and 0). You will use them
to specify the scale range in the next step.

12. In the Edit Map Layer Settings dialog, in the Minimum scale range field, enter 4000. In the Maximum scale
range field, enter 0. Click OK.

13. Repeat steps 9 to 12 to add Layer 3 and Layer 4.
14. In the Background Map Settings dialog, in the Folder field, click Browse. Navigate to and select the

dmsSystem\Spatial\Background Map Settings Files folder and click OK.
15. Click Save.

Because East City is the default background map for the example template, it needs to be set as the reference
map.

16. Right-click the East City background map and select Set as Reference.

Assign Background Maps to Their Corresponding Projects/Folders

Now that all five background maps have been created, they need to be assigned to their corresponding projects
in ProjectWise Explorer. Because East City is the reference map, it is currently set as the background map for all
folders and projects.
1. In ProjectWise Explorer, right-click the BSI200 – Peterborough Geospatial Investigation project

and select Properties.
2. On the Spatial tab, in the Background Map section, set the background map to Use default map and click

OK.
3. Repeat steps 1 and 2 for each of the following projects and folders.

Project/Folder Background Map

BSI200 – Peterborough Geospatial Investigation Use default map

BSI300 – Medical Complex – Cordoba Rose City
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Project/Folder Background Map

BSI400 – W01 – Intersection of I-9 and SR 32 West City

BSI900 – Adelaide Tower South City

Groningen Refinery (under the Gas Authority, Inc project) Natural City

Wedraw Drafters, Inc – New Employee Training Use default map

Each subfolder will inherit the map assigned to their parent project or folder.

Loading a Single Spatial Location File That Has Multiple Locations

1. In ProjectWise Explorer, select Tools > Load SLF.
2. When the Load SLF wizard opens, click Next.
3. On the Choose Spatial Location File page, click the folder icon next to the Spatial Location File field.

The Select Spatial Location File to Import dialog opens.
4. Navigate to the dmsSystem\Spatial\Background Maps\Spatial Location Files folder.
5. Set the Applications list to All Applications.
6. Select the East_City_SLF.slf document and click Open.
7. On the Choose Spatial Location File page, click Next.
8. On the Select the Coordinate System page, select ESPG:2029 and click Next.
9. On the Select the Target Folder page, click the folder icon next to the ProjectWise Target Folder field.

10. In the Select Folder dialog, select BSI200 – Peterborough Geospatial Investigation and click OK.
11. Back on the Select the Target Folder page, turn on Include subfolders and click Next.
12. On the Import Options page, select any option and click Next.
13. On the Logging Options page, optionally specify a log file, then click Next.
14. On the final page, click Start Import.
15. When the locations have been loaded, click OK then Exit.
16. Repeat steps 1 to 15 to load the Rose City_SLF_Building 1.slf document, using

BSI300 – Medical Complex – Cordoba as the project in step 10.
Note: The SLF documents loaded above add spatial locations to the following folders:
• BSI200 - Peterborough Geospatial Investigation\Project Data
• BSI300 - Medical Complex - Cordoba\CAD\MASTER FILES\3D MODELS\BUILDING 1

You can also add multiple spatial location files to a project.

Loading Multiple Spatial Location Files, Each Having One Location

1. In ProjectWise Explorer, select Tools > Load SLF.
2. When the Load SLF wizard opens, click Next.
3. On the Choose Spatial Location File page, click the folder icon next to the Spatial Location File field.
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The Select Spatial Location File to Import dialog opens.
4. Navigate to the dmsSystem\Spatial\Background Maps\Spatial Location Files folder.
5. Set the Applications list to All Applications.
6. Select the West City_SLF_03.slf document and click Open.
7. On the Choose Spatial Location File page, click Next.
8. On the Select the Coordinate System page, select ESPG:2029 and click Next.
9. On the Select the Target Folder page, click the folder icon next to the ProjectWise Target Folder field.

10. In the Select Folder dialog, select BSI400 – W01 – Intersection of I-9 and SR 32 and click OK.
11. Back on the Select the Target Folder page, turn on Include subfolders and click Next.
12. On the Import Options page, select any option and click Next.
13. On the Logging Options page, optionally specify a log file, then click Next.
14. On the final page, click Start Import.
15. When the locations have been loaded, click OK, then click Back until you get back to the Choose Spatial

Location File page.
16. Repeat steps 3 to 14 for the remaining two West City SLF documents.
17. After loading the final file click Exit.

The SLF documents loaded above add spatial locations to the following folder:
BSI400 – W01 – Intersection of I-9 and SR 32

Note: In order to view the spatial locations for folders and subfolders, you must enable View > Geometry
Display > Show Folder and View > Geometry Display > Show Subfolders. You can also change how the
spatial locations appear by selecting View > Manage Spatial Views and creating a new view. Select View >
Save Spatial Settings so that these settings do not need to be changed each time you open ProjectWise
Explorer.

Importing Example Access Control Settings

1. In ProjectWise Administrator, create two users: User 1 and User 2
The BSI300--Access Control Settings.csv file contains access control settings for the BSI300 -
Medical Complex - Cordoba project. This file gets installed when you install the example dataset, and is also
included in the example datasource in the Template Import Files folder. If you do not have access to the local
BSI300--Access Control Settings.csv file, you can export this document to a local folder first before
continuing with the next step.

2. In ProjectWise Explorer, select the BSI300 - Medical Complex - Cordoba project.
3. In the Preview Pane, select the Access Control tab.
4. Click Import Permissions.
5. In the Import dialog, navigate to the local BSI300--Access Control Settings.csv file and click Open.
6. In the Import dialog, make sure that the All Levels check box is on and then click OK.
7. When prompted, click Replace to replace the existing access control on the selected folder.
8. Click Apply on the Access Control tab.

Importing the Delivered Rules Engine Templates and Workflow Rules
After installing the Example Dataset (ProjectWise Admin Setups), you can then import the generic workflow
rules engine template into your datasource and set up workflow rules.
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Likewise, after installing the ProjectWise Business Process Template for BS1192 (ProjectWise Admin Setups),
you can then import the template into your datasource and set up BS1192 workflow rules.

To Import the Generic Workflow Rules Engine Template

Important: This procedure uses the ProjectWise Import Wizard, which must be launched from a command
prompt as described below in order to import the predefined workflow. Do not launch the wizard from the Start
menu.

1. Open a command prompt and navigate to:
...\Program Files (x86)\Bentley\ProjectWise\bin

2. Enter the following command:
pwimpt /workflow

The ProjectWise Import Wizard opens.
3. Select Yes (yes, you will log in as an administrator) then click Next.

The ProjectWise Log in dialog opens.
4. Select the datasource you want to import the template into, enter the user name and password of an account

that is a member of the Administrator group in the selected datasource (Password is case sensitive, User
Name is not), and click Log in.

5. On the Define the import settings page, turn on Environments, Projects\Folders, and Documents and
click Next.

6. Click Next to skip the following pages until you reach the Import Script File page.
7. In the Import script file name field, click the Browse button (...) to navigate to the location where the

template is installed and select the .AAM script file.
For example:
C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets\Rules Engine
\RulesEngineTemplate.aam

8. Click Next. On the next page, you specify where to import the projects, folders, and/or documents. The
window on the left shows a list of the projects and folders contained in the export file. The window on the
right shows the folder list of the destination datasource.
a. In the left window, select Manually exported folders.
b. In the right window, select the Documents root folder as the destination.
c. Click the arrow button (->).
d. From the Choose storage area list, select the storage area that will be used in the event that the Import

Wizard encounters folders with an associated storage area that does not exist in the destination
datasource.

e. Click Import.
The wizard displays the progress of the import.

9. When the import is complete, click Close.
Importing the template adds the following datasource objects:
• an environment called “Rules Engine”
• an interface called “Manager”
• a workflow called “Rules Engine Workflow”
• four states - “Approved”, “Draft”, “Obsolete”, “Pending Approval”
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Importing the template also adds a project called “P03HA-Shangha_Water” which has these datasource
objects already assigned to various items in the project.
At the root of the project is a file called example_rules.xlsx, which contains the default workflow rules of
the Rules Engine. You need to export the example_rules.xlsx file from ProjectWise Explorer, and then use
that file to import the workflow rules into ProjectWise Administrator.

10. Export the example_rules.xlsx file:
a. In ProjectWise Explorer, log in to the datasource where you imported the template.
b. Under the Documents root folder, select the project, P03HA-Shangha_Water.
c. In the document list, select the example_rules.xlsx file and select Document > Export.
d. In the Document Export Wizard, select Export and click Next. On the next page, select an export location

and click Next. The file is exported. Click Finish.
11. Open the local example_rules.xlsx file to review and edit settings as needed before importing to

ProjectWise Administrator.
The Super User and Rollback User specified on the Settings tab of the worksheet must exist in the
datasource, otherwise import will fail. The Super User will need elevated privileges above those of normal
users, and the Rollback User must be a member of the Administrator group in the datasource. Either add
these users to the datasource, or on the Settings tab of the worksheet add the names of existing users who
have the appropriate permissions. They can be the same user, if necessary.

12. Import the rules from the example_rules.xlsx file:
a. In ProjectWise Administrator, log in to the datasource where you want to import the workflow rules.
b. Right-click the Rules Engine node and select Import Rules.
c. Navigate to and select the exported local example_rules.xlsx file and select Open.

The rules are imported to the database. Note that nothing actually displays under the Rules Engine node -
this is expected.

13. Now go back to ProjectWise Explorer, select the exported example_rules.xlsx file and select Document >
Import to save any changes made to this file back to ProjectWise.

To Import the ProjectWise Business Process Template for BS1192

Important: This procedure uses the ProjectWise Import Wizard, which must be launched from a command
prompt as described below in order to import the predefined workflows and user lists. Do not launch the wizard
from the Start menu.

1. Open a command prompt and navigate to:
...\Program Files (x86)\Bentley\ProjectWise\bin

2. Enter the following command:
pwimpt /workflow /groups

The ProjectWise Import Wizard opens.
3. Select Yes (yes, you will log in as an administrator) then click Next.

The ProjectWise Log in dialog opens.
4. Select the datasource you want to import the template into, enter the user name and password of an account

that is a member of the Administrator group in the selected datasource (Password is case sensitive, User
Name is not), and click Log in.

5. On the Define the import settings page, turn on Environments, Projects\Folders, and Documents and
click Next.
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6. Click Next to skip the following pages until you reach the Import Script File page.
7. In the Import script file name field, click the Browse button (...) to navigate to the location where the

template is installed and select the .AAM script file related to your database (Oracle or SQL Server).
For example:
C:\Program Files (x86)\Bentley\ProjectWise\Example Datasets\BS1192\BS1192 Template
for SQL Server.aam

8. Click Next. On the next page, you specify where to import the projects, folders, and/or documents. The
window on the left shows a list of the projects and folders contained in the export file. The window on the
right shows the folder list of the destination datasource.
a. In the left window, select Manually exported folders.
b. In the right window, select the Documents root folder as the destination.
c. Click the arrow button (->).
d. From the Choose storage area list, select the storage area that will be used in the event that the Import

Wizard encounters folders with an associated storage area that does not exist in the destination
datasource.

e. Click Import.
The wizard displays the progress of the import.

9. When the import is complete, click Close.
Importing the template adds a few environments, a couple interfaces, several states, a group, and many user
lists.
Importing the template also adds various projects and folders with these datasource objects already
assigned.
Inside one of the folders is a file called bs1192_rules.xlsx, which contains BS1192-specific workflow
rules. You need to export the bs1192_rules.xlsx file from ProjectWise Explorer, and then use that file to
import the BS1192-specific workflow rules into ProjectWise Administrator.

10. Export the bs1192_rules.xlsx file:
a. In ProjectWise Explorer, log in to the datasource where you imported the template.
b. Under the Documents root folder, navigate to and select the folder,

System Admin\Rules Engine Configuration.
c. In the document list, select the bs1192_rules.xlsx file and select Document > Export.
d. In the Document Export Wizard, select Export and click Next. On the next page, select an export location

and click Next. The file is exported. Click Finish.
11. Open the local bs1192_rules.xlsx file to review and edit settings as needed before importing to

ProjectWise Administrator.
The Super User and Rollback User specified on the Settings tab of the worksheet must exist in the
datasource, otherwise import will fail. The Super User will need elevated privileges above those of normal
users, and the Rollback User must be a member of the Administrator group in the datasource. Either add
these users to the datasource, or on the Settings tab of the worksheet add the names of existing users who
have the appropriate permissions. They can be the same user, if necessary.

12. Import the rules from the bs1192_rules.xlsx file:
a. In ProjectWise Administrator, log in to the datasource where you want to import the workflow rules.
b. Right-click the Rules Engine node and select Import Rules.
c. Navigate to and select the exported local bs1192_rules.xlsx file and select Open.

The rules are imported to the database. Note that nothing actually displays under the Rules Engine node -
this is expected.
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13. Now go back to ProjectWise Explorer, select the exported bs1192_rules.xlsx file and select Document >
Import to save any changes made to this file back to ProjectWise.

Presetting the Full Text Index Storage Location
When you install ProjectWise Indexing Service, or when you install ProjectWise Design Integration Server with
Full Text Indexing enabled, ProjectWise sets the default full text index storage location to
C:\ProgramData\Bentley\pw-index-storage.
As you run text extractions, ProjectWise downloads copies of documents from the datasource and stores them in
a temporary extraction folder on the ProjectWise Design Integration Server computer. For each document that
gets processed, ProjectWise creates an intermediate file (*.DMSINDEX) which contains the text extracted from
the document. These intermediate files get stored in a subfolder (one subfolder for each indexed datasource)
under the main index storage folder. For example:
C:\ProgramData\Bentley\pw-index-storage\ed0bd9c2-bec8-4230-89f9-0852c75c7140\

0a4d8ed5-fbd7-4db2-943c-d22cb98efd69.dmsindex

0b4893b0-4a86-4d31-af30-1aac40b689f4.dmsindex

0bbb8aa2-49de-4819-99ab-251f69872dfd.dmsindex

0c3ea069-efb6-4d7b-bee6-7992a674afb7.dmsindex

0c25a091-bbe2-4f7d-a2c2-810873bd96f0.dmsindex

If you know you need the index storage to be located in a different folder or on a different drive, you can preset
the index storage location using the following procedure, and then install ProjectWise Indexing Service or
ProjectWise Design Integration Server as needed. (See the ProjectWise Administrator help for details about
changing the index storage location after installation.)

To Preset the Full Text Index Storage Location

1. Open the Windows Registry Editor on the computer on which you are about to install ProjectWise Design
Integration Server or ProjectWise Indexing Service.

2. Create the following registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\Bentley\ProjectWise\Automated File Processing

3. Under that key, create a string called FtrIndexDataDir, and for its value enter the path to the location
where you want the index storage folder to be.
For example: D:\Bentley\pw-index-storage

4. Close the Windows Registry Editor.
The folder specified in the FtrIndexDataDir string will be created when the first extraction occurs.

Moving Document Processors to a Secondary Server
Support for full text search, thumbnail images and file property display requires a number of processors to be
running on the ProjectWise Design Integration Server that extract the appropriate data from files managed by
ProjectWise and store that data in the ProjectWise database (or on the Indexing Service computer, in the case of
full text indexing). These processors can be somewhat resource intensive, and depending on the amount of
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documents that are changing and how current the user wants to keep the extracted data, this could potentially
affect the overall performance of the ProjectWise Design Integration Server (and therefore the perceived
performance of ProjectWise in general).
To reduce the load on the ProjectWise Design Integration Server computer, you can offload the document
processors to a second computer. These two computers would then coordinate through ProjectWise
Orchestration Framework Service and the Orchestration Framework database.

To Move the Document Processors to a Secondary Server

1. On the first computer, install and configure ProjectWise Design Integration Server as usual, along with the
automated file processing features (document processors).

2. On the second computer, install and configure ProjectWise Design Integration Server, again with the
automated file processing features, with the following considerations when installing ProjectWise
Orchestration Framework Service:
• when you get to the Configure Shepherd Credentials dialog, be sure to use the same Windows account

that is being used to run the ProjectWise Orchestration Framework Service on the original ProjectWise
Design Integration Server.

• when asked for the database to be used by the ProjectWise Orchestration Framework Service, select the
same database that is being used by the original ProjectWise Design Integration Server. It is also possible
at this time to designate a new Orchestration Framework database on the second server and reconfigure
the ProjectWise Orchestration Framework Service on the original ProjectWise Design Integration Server
to point to this new Orchestration Framework database.

3. On the second computer where ProjectWise Design Integration Server is now installed, in order to have this
server not require a ProjectWise Design Integration Server license, edit the DMSKRNL.CFG file and add the
line FullTextIndexSrv=1 to the [TeamMate] section. This will prevent this instance of ProjectWise Design
Integration Server from performing any of the real ProjectWise Design Integration Server functionality.

4. Install Bentley i-model Composition Server Administrator (from the Bentley i-model Composition Server for
PDF installer) on the original ProjectWise Design Integration Server computer. Open it and connect the
Orchestration Framework Browser to the database instance used by both computers. You should notice
that there are now Dispatchers and Processors running on both computers. Looking at the monitor for one of
the document processor instances you will notice that there are now two parallel sets of dispatchers and
processors for that instance that are not connected. Close Bentley i-model Composition Server Administrator.
Your next step is to connect those parallel paths.

5. On the original ProjectWise Design Integration Server computer, open a command prompt and navigate to
the ...\ProjectWise\bin folder and enter:
Dmsafpengine.exe -makeHead

This entry is case-sensitive so use an uppercase H.
6. On the second computer, open a command prompt and navigate to the ...\ProjectWise\bin folder and

enter:
Dmsafpengine.exe -makeTail

This entry is case-sensitive so use an uppercase T.
7. Open Bentley i-model Composition Server Administrator again and reconnect to the Orchestration

Framework Browser and select to monitor on one of the instances. You should notice that the parallel paths
are now connected and the processors have been removed from the original ProjectWise Design Integration
Server and the dispatcher from the original ProjectWise Design Integration Server is connected to processors
running on the second computer.
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8. Using ProjectWise Administrator, select Registered Full Text Indexing Services and make sure that the
second computer shows up in the list. If not, use the New > Indexing Service to add it. Log in to each
datasource and select Document Processors > Full Text Indexing > Properties and make sure that the
Indexing Service field shows the name of the second computer, if not select it from the list and click
Register Server.

9. Using ProjectWise Administrator, select one of the document processors and select a folder for reprocessing
and force processing now.

10. Using Bentley i-model Composition Server Administrator, validate that the queues of the processors on the
second computer are populated with documents for processing.

Installing ProjectWise Servers on Computers with Non-English Regional
Settings
There is an installation issue with the ProjectWise server products on computers with non-English regional
settings. This issue prevents ProjectWise performance counters from being registered during installation of
ProjectWise Design Integration Server, ProjectWise Caching Server, and ProjectWise Gateway Service, and thus
prevents these servers from starting correctly after installation. As a workaround, follow these steps to add
missing registry items that will allow the respective ProjectWise servers to start correctly.
1. Using the Windows Registry Editor, open the registry and go to the key HKey_Local_Machine\SOFTWARE

\Microsoft\Windows NT\CurrentVersion\Perflib and export the key named 009 to a file.
2. Open that file in a text editor and change all occurrences of 009 to the appropriate Primary Language

Identifier. See http://msdn.microsoft.com/en-us/library/windows/desktop/dd318693(v=vs.85).aspx for
details.

3. Import that registry file and a new key HKey_Local_Machine\SOFTWARE\Microsoft\Windows NT
\CurrentVersion\Perflib should be created that matches your Primary Language Identifier.

4. Re-register the performance counters:
• “regsvr32 dmsdbperf.dll”
• “regsvr32 dmskrnlperf.dll”
• “regsvr32 dmssrvperf.dll”

We are working with Microsoft to resolve this issue and eliminate the need for this workaround.

Setting Up ProjectWise Design Integration Servers in a Clustered
Environment
ProjectWise Design Integration Server supports Cluster Service and Network Load Balancing features of
Windows Server 2008 and 2012. This section discusses the basic configuration of ProjectWise Design
Integration Servers in a clustered environment. It is recommended that you consult Bentley Professional
Services for assistance with setting this up in production.
Note: ProjectWise User Synchronization Service, and the Automated File Processing features delivered with
ProjectWise Design Integration Server are NOT cluster-aware and therefore will not fail over if the server they
are installed on fails. These services can be installed on servers in a cluster, however in the event of a failure
manual steps must be taken to ensure they continue to function correctly.
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Setting Up Your Server Cluster

1. Before installing any ProjectWise software, you must first set up your cluster. This involves creating a cluster
using the Windows Cluster Management tool and then specifying each server that will be a part of the cluster.
See Microsoft documentation for details on this configuration. When ProjectWise clients need to connect to
the ProjectWise Design Integration Server, they point to the name of the cluster, which will then decide
which ProjectWise Design Integration Server will handle the request.

2. Once your basic cluster is configured, the next step is to set up a database to host the ProjectWise database.
Follow your normal database setup procedures, noting that the database server must reside outside the
cluster. Once the database is set up, on each ProjectWise Design Integration Server computer in the cluster
you must create an ODBC datasource that points to the database. Each of these ODBC datasources must have
the same name.

3. Next you need to decide how you will store your files. Your storage area must reside outside the cluster. You
can either host the storage area on a ProjectWise Caching Server outside the cluster, or you can provision
shared storage outside the cluster such that all clustered servers can access it. Examples of shared storage
include SAN (Storage Area Network), NAS (Network Attached Storage), or SMB Share. If you use shared
storage, the ProjectWise Design Integration Server service must be running as a user that has rights to the
shared storage location. Make sure this is set before you create any datasources. If needed, you can change
the user for the ProjectWise Design Integration Server service through the Services window. Make sure you
restart the service after changing the user.

4. Make sure the following reside outside the cluster:
• the ProjectWise database
• the full text index catalog (if full text indexing is used)
• ProjectWise Caching Server

Installing ProjectWise Design Integration Servers and Configuring the Datasource

Once you set up the cluster, the next step is to install ProjectWise Design Integration Server on each server in the
cluster. All installation paths and other details must be the same on each server. After installation, you will
create a datasource on one server, modify the dmskrnl.cfg file accordingly, and then copy the dmskrnl.cfg
file to the rest of the ProjectWise Design Integration Servers in the cluster.

To Configure a Datasource To Be Used in a Clustered Environment

1. Install ProjectWise Design Integration Server on each server in the cluster.
2. If you are using shared storage for your storage area, make sure the ProjectWise Design Integration Server

service is running as a user who has access to the shared storage location and rights to run a service on the
local server. This change must be made on all servers in the cluster. Restart the ProjectWise Design
Integration Server service after you make your changes.

3. On all but one of these servers, stop the service for the ProjectWise Design Integration Server.
4. On the server with the service still running, install ProjectWise Administrator and use it to create your

datasource.
When you create your datasource and you get to the Create Administrator and Storage dialog, the storage
area node (Host field) defaults to the ProjectWise Design Integration Server computer on which you are
working.

5. Do one of the following:
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If you are using a ProjectWise Caching Server outside the cluster, set the Host field to the server name on
which the ProjectWise Caching Server is installed, and in the Path field specify the storage area’s folder path
on that server.
or
If you are using shared storage, leave the Host field as is (pointing to the local server), and in the Path field
specify the address of the shared storage location. For example: \\sharedstorage\pw_storage

6. After you have created your datasource, stop the service for that ProjectWise Design Integration Server.
7. Open that ProjectWise Design Integration Server's dmskrnl.cfg file.
8. Uncomment the ServerName and ServerIPAddress properties and set their value to the cluster’s name and

IP address, respectively. For example:
[TeamMate]
...
ServerName=mycluster.mydomain.com
ServerIPAddress=192.168.1.10

9. If you want ProjectWise to only respond to requests that come in on the cluster network interface,
uncomment the BindAddress properties under the [Broadcast] and [Listener] sections and set their
value to the cluster's IP address. For example:
[Broadcast]
...
BindAddress=192.168.1.10 (cluster IP address)
...
[Listener]
...
BindAddress=192.168.1.10 (cluster IP address)

Note: This causes ProjectWise Design Integration Server's service to attach to this address on startup. If this
address is not assigned to an NIC on the server the service will fail to start. Do not set the BindAddress if
you want ProjectWise to respond to requests on more than one adapter / IP address, or if you are configuring
ProjectWise with a hardware load balancer.

10. Find the FileAcccessTokenMasterKey, LoginTokenMasterKey1, and LoginTokenMasterKey2
properties under the TeamMate section, and delete everything after the = for each property, so that they now
look like this:
[TeamMate]
...
FileAccessTokenMasterKey=
...
LoginTokenMasterKey1=
LoginTokenMasterKey2=

11. Add an entry in the Server Name Resolution section with the formatting, “cluster IP address = cluster
name”.
For example:
[ServerNameResolution]
192.168.1.10=mycluster.mydomain.com

12. Save and close the dmskrnl.cfg file.
13. Restart the service for that ProjectWise Design Integration Server.
14. Copy the newly modified dmskrnl.cfg file to the rest of the ProjectWise Design Integration Servers in the

cluster.
15. Start the services for the rest of the ProjectWise Design Integration Servers in the cluster.
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16. If using shared storage, log in to ProjectWise Administrator, select the Storage areas datasource node, right-
click the storage area that was just created and select Properties. In the Computer name or IP address
field, enter the cluster name and click OK.

Adding Servers to ProjectWise Design Integration Server's Trusted
Servers List
The IP addresses of computers on which you install the following applications need to be added to the Trusted
Servers list in the ProjectWise Design Integration Server's DMSKRNL.CFG file:
• Bentley i-model Composition Server for PDF
• Bentley i-model Composition Server Administrator
• Bentley Automation Service
• Bentley Automation Service Administrator

Note: Bentley Automation Service is a separate download.

To Add a Computer to the Trusted Servers List

1. Open the ProjectWise Design Integration Server's dmskrnl.cfg file.
2. Find the [Trusted Servers] section.
3. Under the [Trusted Servers] line, add a new line that includes your computer's IP address.

You can either add a specific IP address, or you can use a subnet mask. You can also add a new line for each
application, if they are installed on different computers.
For example:
[Trusted Servers]
ProjectWise Web Server=194.215.205.19
Bentley i-model Composition Server for PDF=192.168.100.0   255.255.255.0

The name before the = can be any name you choose.
The number after the = is the IP address.
The number after the IP address (with a space in between) is the optional subnet mask.
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 4
ProjectWise User Synchronization Service

Configuration

ProjectWise User Synchronization Service is the server module that lets you create user accounts in the
datasource, based on existing Windows domain or Active Directory accounts, and that also leverage the
credentials of those accounts. Once these ProjectWise user accounts are created, you can use ProjectWise User
Synchronization Service to keep those accounts synchronized with any changes made to their domain or Active
Directory counterparts.
The installer for ProjectWise User Synchronization Service has two options:
• ProjectWise User Synchronization Service Administrator
• ProjectWise User Synchronization Service Engine
You can install both options on the same computer, or you can install each option on a separation computer. The
ProjectWise User Synchronization Service Administrator option requires ProjectWise Administrator.
The ProjectWise User Synchronization Service Engine runs as a native Windows service, and is managed
through the User Synchronization Service datasource node in ProjectWise Administrator (which is available
when the ProjectWise User Synchronization Service Administrator option is installed on the ProjectWise
Administrator computer).
After installation, see “User and Group Management > User Synchronization Service” in the ProjectWise
Administrator help.
Note: If your ProjectWise Design Integration Server cannot access the local domain controller and authenticate
Windows users, you can install ProjectWise User Synchronization Service on a local network to act as an
intermediate login provider for ProjectWise users with Windows accounts.

Before You Install or Upgrade ProjectWise User Synchronization Service
1. Make sure the latest Windows updates have been installed.

Note: In particular, make sure you have the update for Universal C Runtime (CRT) in Windows installed:
https://support.microsoft.com/en-us/help/3118401/update-for-universal-c-runtime-in-windows

2. You can install ProjectWise User Synchronization Service on the same computer as ProjectWise Design
Integration Server, or on another computer.

3. You can install the ProjectWise User Synchronization Service Engine and the ProjectWise User
Synchronization Service Administrator together on the same computer, or each on separate computers. If you
install them on separate computers, make sure both computers are on the same domain.
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4. Before installing the ProjectWise User Synchronization Service Engine, you must install ProjectWise
Prerequisite Runtimes (available from ProjectWise Server Setups).

5. Before installing the ProjectWise User Synchronization Service Administrator, you must install ProjectWise
Administrator (on page 45).

To Install ProjectWise User Synchronization Service
1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to ProjectWise User Synchronization Service.

3. When the Setup Wizard opens, click Next.
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4. When the License Agreement page opens, read and accept the agreement, then click Next.
5. Do one of the following:

If ProjectWise Administrator is not installed, the next page that opens tells you that ProjectWise
Administrator is not detected, and that you can only install the ProjectWise User Synchronization Service
Engine on this computer. If you just want to install the ProjectWise User Synchronization Service Engine,
then click Next, otherwise click Cancel to exit the Setup Wizard, install ProjectWise Administrator, then go
back to step 1 of this procedure to launch the Setup Wizard again.
or
If ProjectWise Administrator is already installed, the Custom Setup page opens.
The Custom Setup page opens, showing you the features that can be installed, and the location to which the
product will be installed.
If ProjectWise Administrator is installed, you will see these options:
ProjectWise User Synchronization Service Administrator
ProjectWise User Synchronization Service Engine

If ProjectWise Administrator is not installed, you will see only this option:
ProjectWise User Synchronization Service Engine

6. (Optional) Select the features you want to install by clicking the feature's icon and selecting the appropriate
option from the menu. Items with an X to the left of them will not be installed.
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7. Do one of the following:

If ProjectWise Administrator is already installed, you will not be able to change the installation location, and
ProjectWise User Synchronization Service will automatically be installed to the same location as ProjectWise
Administrator.
or
If ProjectWise Administrator is NOT installed, and also no other module (not including ProjectWise
Orchestration Framework Service) from this release is installed, then you can either accept the default
installation location, or click the Change button to change it. Whichever installation location you select here,
each subsequent module (not including ProjectWise Orchestration Framework Service) you install from this
release will automatically be installed to the same location.
Because ProjectWise User Synchronization Service is a 64-bit application, the default installation location is
C:\Program Files (x86)\Bentley\ProjectWise.

8. When finished on the Custom Setup page, click Next.
9. When the Service Options page opens, type a valid Windows Domain name, Account Name and Password,

then click Next.
This account must have appropriate rights to connect to the Domain that you plan to synchronize with the
ProjectWise datasources.
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10. When the Ready to Install page opens, click Install.
11. When installation is complete, click Finish.
12. If you installed the ProjectWise User Synchronization Service Engine, then after installation, make sure the

ProjectWise User Synchronization Service is started in the local Services window.

To Set Up ProjectWise User Synchronization Service as an Intermediate
Login Provider for Users with Windows-based Accounts
1. Install ProjectWise User Synchronization Service on a computer in the local area network (LAN) that can

access the local domain controller.
2. Open the ProjectWise Design Integration Server's DMSKRNL.CFG file in a text editor and do the following:

a. Uncomment the following line and set the value after the = to be the host name of the computer on which
ProjectWise User Synchronization Service is installed:
UserSyncService=<User Synchronization Service host name>

b. Add the IP address of the ProjectWise User Synchronization Service host computer to the [Trusted
Servers] list.

3. Save and close the DMSKRNL.CFG file.
4. Make sure that the account under which ProjectWise User Synchronization Service runs is a logical user

account (not a Windows-based account), and that the user's user setting Enable as delegate user is turned
on.

ProjectWise User Synchronization Service Configuration
To Set Up ProjectWise User Synchronization Service as an Intermediate Login Provider for Users with Windows-based
Accounts

ProjectWise Design Integration 88 Implementation Guide



 5
ProjectWise Caching Server Configuration

ProjectWise storage areas can exist on the ProjectWise Design Integration Server computer, but they can also be
hosted on another computer. ProjectWise Caching Server is the ProjectWise server to install when you want to
set up and host a storage area on a computer other than the ProjectWise Design Integration Server computer.
ProjectWise Caching Server can also be used for storing local copies of files in remote storage areas, to improve
access speed.
When users create folders or projects in ProjectWise, they associate each folder or project with a particular
storage area so that all files added to that folder or project will be stored in the associated storage area. This
storage area, defined in ProjectWise Administrator, can be located on the ProjectWise Design Integration Server
computer, but for performance reasons you may decide to create multiple storage areas for your datasource,
each located on a different computer. Before you can define the location of a storage area in ProjectWise
Administrator, you must first install ProjectWise Caching Server on the computer that will host the storage area.
Once installed, use ProjectWise Administrator to set up a storage area on the ProjectWise Caching Server's
computer. The ProjectWise Administrator you work from can be, but does not need to be, installed on the same
computer as ProjectWise Caching Server.

Before You Install or Upgrade ProjectWise Caching Server
Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.

1. Make sure the latest Windows updates have been installed.
Note: In particular, make sure you have the update for Universal C Runtime (CRT) in Windows installed:
https://support.microsoft.com/en-us/help/3118401/update-for-universal-c-runtime-in-windows

2. Make sure that the computers on which you install ProjectWise Design Integration Server and all ProjectWise
Caching Servers have their clocks synchronized with the time of an authoritative computer. If the clocks are
not properly synchronized, then any tokens issued by ProjectWise Design Integration Server may expire
prematurely when a user attempts to check out a document, causing the operation to fail. See the following
Microsoft article for details:
http://technet.microsoft.com/en-us/library/cc773013(WS.10).aspx

3. ProjectWise Caching Server cannot be installed on a computer on which ProjectWise Design Integration
Server, ProjectWise Gateway Service, or ProjectWise Indexing Service is already installed.

4. If ProjectWise Caching Server V8 XM Edition or earlier is installed, uninstall it now.
If ProjectWise Caching Server V8i or later is installed, you can leave it installed and let the new ProjectWise
Caching Server installer upgrade it for you.
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Note: If you have additional ProjectWise applications installed from the same older (V8i or later) release
version, see Upgrading to the Current Version > Precautions (on page 253) for the recommended workflow
for upgrading.

5. Install ProjectWise Prerequisite Runtimes (available from ProjectWise Server Setups).
6. If you plan to use the Product Activation Wizard as launched from the final page of the Setup Wizard, then

you must launch the ProjectWise Server Setups master installer using the Run as Administrator option. This
ensures that the Product Activation Wizard is also run as an administrator, which in turn ensures that the
licensing information you enter gets registered to the correct location in the Windows Registry.

Note: The ProjectWise Caching Server installer automatically adds the ProjectWise broadcasting and listening
ports of 5799 and 5800 to the Windows Firewall exception list on this computer.

To Install ProjectWise Caching Server
1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to ProjectWise Caching Server.

 

 
If this is a fresh install, the Setup Wizard opens. Skip to step 4.
If this is an upgrade, a second page of the ProjectWise Server Setups window opens. Continue with the next
step.

3. Do one of the following:
If upgrading from ProjectWise Caching Server V8i or later, click Install. The installer will automatically
uninstall the old version and then install the new version.
or
If upgrading from ProjectWise Caching Server V8 XM Edition or earlier, click Remove to uninstall the old
version. When uninstallation is complete, click Install to install the new version.
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4. When the Setup Wizard opens, click Next.
 

 
5. When the License Agreement page opens, read and accept the agreement, then click Next.

The Custom Setup page opens.
6. Accept the default installation location or click the Change button (if available) to change it.

The default installation location is C:\Program Files\Bentley\ProjectWise.
Note: The Change button will not display if another 64-bit application from this release is already installed on
this computer; if that is the case, ProjectWise Caching Server will simply be installed to the same location as
the previously installed application.
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Note: When upgrading from a V8i or later version of ProjectWise Caching Server, the Change button will not
display for you to change the installation location, and the new version will be automatically installed to the
same location as the previous version.

7. When finished on the Custom Setup page, click Next.
8. On the Storage Location page, specify the physical location on this computer under which storage areas

hosted by this server can be created.
If no storage location is currently defined If a storage location is already defined

Click Browse to select the storage location, then
click Next.

Select Keep existing storage location and click
Next (the storage location shown will be used).
or
Select Specify new storage location, click Browse
to change the storage location, and click Next when
finished.

The location you specify is added to this server's DMSKRNL.CFG file under the section labeled, “Section
defines allowable locations for storage areas”. For example:
; -------------------------------------------------------------
; Section defines allowable locations for storage areas
; -------------------------------------------------------------

[FileStorageService]
StorageLocation0=D:\pwstorage

Now when you create storage areas for this server in ProjectWise Administrator, you will only be able to
create a storage area if the location you select is somewhere within the allowable storage location.
Tip: You can only add one local storage location through the installer, but you can manually edit the
DMSKRNL.CFG file after installation if needed to add additional local and/or remote storage locations for this
server.

9. When the Ready to Install page opens, click Install.
10. (Optional) On the last page of the wizard, the Launch License Management Tool option is on by default.
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11. Click Finish.

If you selected Launch License Management Tool, the Product Activation Wizard opens for you to
configure licensing (on page 260) for this module.

Important: After installation, you must manually start the service for this server in the Services window.
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 6
ProjectWise Gateway Service Configuration

ProjectWise Gateway Service is the server module to install for datasource list publishing.
For example, when the ProjectWise Design Integration Server is on a computer that your ProjectWise Explorer
clients cannot access, you can install a ProjectWise Gateway Service on a computer that both the clients and the
ProjectWise Design Integration Server can access, and then configure the ProjectWise Gateway Service to
retrieve the datasource list from the server. ProjectWise Explorer clients on the same subnet as the ProjectWise
Gateway Service, or those connected to it using the ProjectWise Network Configuration Utility, will be able to see
the ProjectWise Design Integration Server's datasources, as published through the ProjectWise Gateway Service.

Before You Install or Upgrade ProjectWise Gateway Service
Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.

1. Make sure the latest Windows updates have been installed.
Note: In particular, make sure you have the update for Universal C Runtime (CRT) in Windows installed:
https://support.microsoft.com/en-us/help/3118401/update-for-universal-c-runtime-in-windows

2. If ProjectWise Gateway Service V8 XM Edition or earlier is installed, uninstall it now.
If ProjectWise Gateway Service V8i or later is installed, you can leave it installed and let the new ProjectWise
Gateway Service installer upgrade it for you.
Note: If you have additional ProjectWise applications installed from the same older (V8i or later) release
version, see Upgrading to the Current Version > Precautions (on page 253) for the recommended workflow
for upgrading.

3. ProjectWise Gateway Service cannot be installed on a computer on which ProjectWise Design Integration
Server, ProjectWise Caching Server, or ProjectWise Indexing Service is already installed.

4. Install ProjectWise Prerequisite Runtimes (available from ProjectWise Server Setups).
5. The ProjectWise Gateway Service installer automatically adds the ProjectWise broadcasting and listening

ports of 5799 and 5800 to the Windows Firewall exception list on this computer.
6. If you plan to use the Product Activation Wizard as launched from the final page of the Setup Wizard, then

you must launch the ProjectWise Server Setups master installer using the Run as Administrator option. This
ensures that the Product Activation Wizard is also run as an administrator, which in turn ensures that the
licensing information you enter gets registered to the correct location in the Windows Registry.
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Note: ProjectWise Gateway Service only requires a license if you enable local file caching on this computer. If
you do not plan to enable local file caching, then ProjectWise Gateway Service does not require a license, and
you do not need to run the Product Activation Wizard.

To Install ProjectWise Gateway Service
1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to ProjectWise Gateway Service.

 

 
If this is a fresh install, the Setup Wizard opens. Skip to step 4.
If this is an upgrade, a second page of the ProjectWise Server Setups window opens. Continue with the next
step.

3. Do one of the following:
If upgrading from ProjectWise Gateway Service V8i or later, click Install. The installer will automatically
uninstall the old version and then install the new version.
or
If upgrading from ProjectWise Gateway Service V8 XM Edition or earlier, click Remove to uninstall the old
version. When uninstallation is complete, click Install to install the new version.
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4. When the Setup Wizard opens, click Next.

 

 
5. When the License Agreement page opens, read and accept the agreement, then click Next.

The Custom Setup page opens.
6. Accept the default installation location or click the Change button (if available) to change it.

The default installation location is C:\Program Files\Bentley\ProjectWise.
Note: The Change button will not display if another 64-bit application from this release is already installed; if
that is the case, ProjectWise Gateway Service will simply be installed to the same location as the previously
installed application.
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Note: When upgrading from a V8i or later version of ProjectWise Gateway Service, the Change button will not
display for you to change the installation location, and the new version will be automatically installed to the
same location as the previous version.

7. When finished on the Custom Setup page, click Next.
8. When the Ready to Install page opens, click Install.
9. On the last page of the wizard, the Launch License Management Tool option is off by default because

ProjectWise Gateway Service does not normally require a license. If you plan to use this ProjectWise Gateway
Service for local file caching, then turn on Launch License Management Tool, otherwise you can leave it off.

 

 
10. Click Finish.

If you selected the Launch License Management Tool option, the Product Activation Wizard opens for you
to configure licensing (on page 260) for this module.

Important: After installation, you must manually start the service for this server in the Services window.
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 7
ProjectWise Indexing Service Configuration

ProjectWise Indexing Service is the server to install when you want the full text indexing feature’s text index
catalog (for one or more datasources) to be hosted and maintained on a computer other than the ProjectWise
Design Integration Server computer. In this configuration, the ProjectWise Design Integration Server forwards
full text searches, and any text extraction updates, to the ProjectWise Indexing Service, which in turn uses its
own local Windows Search service.
Once ProjectWise Indexing Service is installed, you need to register this ProjectWise Indexing Service computer
with the ProjectWise Design Integration Server in ProjectWise Administrator. Once the computer is registered,
you will be able to designate this ProjectWise Indexing Service as the Indexing Service to use for any of that
ProjectWise Design Integration Server's datasources.
You can also have more than one Indexing Service computer registered and then decide on a per-datasource
basis (when configuring text indexing extractions) which Indexing Service will maintain the datasource's full
text index catalog.

Before You Install or Upgrade ProjectWise Indexing Service
Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.

1. On another computer, install ProjectWise Design Integration Server with the Automated File Processing >
Full Text Indexing option enabled.

2. ProjectWise Indexing Service cannot be installed on a computer where ProjectWise Design Integration
Server, ProjectWise Caching Server, or ProjectWise Gateway Service is already installed.

3. Make sure the latest Windows updates have been installed.
Note: In particular, make sure you have the update for Universal C Runtime (CRT) in Windows installed:
https://support.microsoft.com/en-us/help/3118401/update-for-universal-c-runtime-in-windows

4. Make sure these Windows features are installed:
• .NET Framework 3.5
• Windows Search
See Installing Required Windows Server Features (on page 267).
After installation, make sure the Windows Search service is running in the Services window.

5. If you need to preset the index storage folder to a location other than the default (on page 78), you must do so
before installing this ProjectWise Indexing Service.
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6. If a previous version of ProjectWise Indexing Service is installed, uninstall it now, then restart your
computer.

7. Install ProjectWise Prerequisite Runtimes (available from ProjectWise Server Setups).

To Install ProjectWise Indexing Service
1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to ProjectWise Indexing Service.

3. When the Setup Wizard opens, click Next.
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4. When the License Agreement page opens, read and accept the agreement, then click Next.

The Custom Setup page opens, showing you the location to which the product will be installed.
Note: The ProjectWise Indexing Connector for SharePoint feature of ProjectWise Indexing Service is
currently unsupported and should not be installed.
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5. Accept the default installation location or click the Change button (if available) to change it.
The default installation location is C:\Program Files\Bentley\ProjectWise.
Note: The Change button will not display on this installer if another 64-bit application from this release is
already installed; if that is the case, ProjectWise Indexing Service will simply be installed to the same location
as the previously installed application.

6. When finished on the Custom Setup page, click Next.
7. When the Ready to Install page opens, click Install.
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8. When installation is complete, click Finish.

The Launch License Management Tool option is off by default on the last page of the wizard. If you turned
it on, the Product Activation Wizard opens now for you to configure licensing (on page 260) for this module.

Important: The option to automatically start ProjectWise Indexing Service after installation is disabled in this
release. If you are not using the Product Activation Wizard, you can go ahead and manually start the service for
this server in the Services window now. If you did run the Product Activation Wizard after installation, then
make sure you start or restart the service only after running the Product Activation Wizard.

To Register a Standalone ProjectWise Indexing Service
1. In ProjectWise Administrator, log in to at least one datasource for a particular server.
2. Under that server, select the Registered Full Text Indexing Services node.

The <local> server listed represents the ProjectWise Design Integration Server's built-in Indexing Service.
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3. Right-click the Registered Full Text Index Servers node and select New > Index Server.

The New Index Server Properties dialog opens.
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4. In the Server name field, type a display name for the Indexing Service.
5. In the Server DNS name or IP address field, type the actual computer name or IP address of computer on

which the ProjectWise Indexing Service is installed.
6. Click OK.

The new Indexing Service is added to the list of Registered Full Text Index Servers. You can later modify its
properties by right-clicking it and selecting Properties, or you can remove it from the list by right-clicking
and selecting Delete.

Implementing Microsoft® Search Server 2010 Express
The purpose of this section is to provide organizations that are already using ProjectWise full text indexing with
the ability to index up to (approximately) 10 million documents.

Background:

The ProjectWise full text indexing feature uses Windows Search, which allows the indexing of up to one million
documents based on Microsoft's recommendations.
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One million indexed documents is not a hard limit, and both Bentley testing and user experience in production
have shown success with indexing higher numbers of documents. Still, there is a risk of corrupting the indexing
database when it reaches capacity. Therefore, it is recommended that you use caution as you significantly exceed
one million indexed documents and consider implementing Microsoft Search Server 2010 Express at such time.
This section describes how to implement Microsoft Search Server 2010 Express into your existing full text
indexing configuration. You will install Microsoft Search Server 2010 Express on the computer that is hosting the
full text index catalog.
Tip: Basic ProjectWise server installation and full text indexing configuration details remain the same. Details
about running full text indexing extractions can be found in the ProjectWise Administrator help.

Planning Your Server Configuration

This configuration will not change the way in which full text indexing extractions are performed; they are
performed as usual by the (standalone, or tail) ProjectWise Design Integration Server, as configured through
ProjectWise Administrator.
You can either set up a new computer to host the full text index catalog, or you can continue to use the computer
on which the full text index catalog is currently being hosted.
If you are setting up a new computer, you can reuse the DMSINDEX files from your existing full text index catalog
by copying them over to the new computer. The ProjectWise Administrator help describes how to do this in
detail (see “Managing Document Extractions > Changing the Indexing Service Storage Location”).
If you are reusing the existing full text indexing computer, you will leave the existing DMSINDEX files where they
are on that computer.
Consider the following standard full text indexing server configurations to determine which server you need to
install or upgrade (on the same computer you will also install and configure Microsoft Search Server 2010
Express):
A. Standalone ProjectWise Design Integration Server Configuration:

You can install and run ProjectWise Design Integration Server as a standalone server on a single computer,
where ProjectWise Design Integration Server handles the main server responsibilities of ProjectWise, as well
as all full text indexing responsibilities (meaning it handles both the extraction and the indexing of text from
documents in the datasource).

B. Head/Tail ProjectWise Design Integration Server Configuration:
You can install ProjectWise Design Integration Server on two different computers and set them up to run
together in a head/tail configuration, where the head server handles the main server responsibilities of
ProjectWise, and the tail server only handles the full text extraction and indexing responsibilities.

C. Standalone ProjectWise Indexing Service Configuration:
After configuring ProjectWise Design Integration Server using either option A or B above, you can optionally
install a standalone ProjectWise Indexing Service on another computer, where it will only handle the full text
indexing responsibilities. In this configuration, full text extraction is handled by the (standalone or tail)
ProjectWise Design Integration Server.

Note: Microsoft Search Server 2010 Express requires either the full or express version of SQL Server. For this
solution, the full version of SQL Server should be used so that Microsoft Search Server 2010 Express can index
the maximum amount of documents (Microsoft Search Server 2010 Express can only index up to 300,000
documents when using SQL Server Express).
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Note: For better performance it is recommended that Microsoft Search Server 2010 Express and SQL Server are
not installed on the same computer. Also, make sure the individual SQL Server database you use for Microsoft
Search Server 2010 Express is not being used by anything else.

Note: If you need to index more than 10 million documents, you can set up Microsoft Search Server 2010 Express
on multiple computers as needed (that is, one Microsoft Search Server 2010 Express for roughly each 10 million
documents). For example, you might have Microsoft Search Server 2010 Express installed on the tail server in a
head/tail configuration, and then you might also install Microsoft Search Server 2010 Express and ProjectWise
Indexing Service together on another computer.

Implementing the Solution

On one computer you will:
1. Install and configure Microsoft Search Server 2010 Express.
2. Reuse the existing ProjectWise Design Integration Server or ProjectWise Indexing Service that is installed on

this computer, or if you are setting up a new computer, install ProjectWise Design Integration Server or
ProjectWise Indexing Service.

3. Run the delivered configuration script (gets installed with ProjectWise Design Integration Server or
ProjectWise Indexing Service).

4. Use Microsoft Search Server 2010 Express to crawl the existing ProjectWise full text index catalog.

Preparing the Search Server and SQL Server Computers
Before installing any Search Server or ProjectWise software, you need to do the following:
1. Download the following:

• Microsoft Search Server 2010 Express (http://www.microsoft.com/en-us/download/details.aspx?
id=18914)

• Microsoft Search Server 2010 Service Pack 1 (KB2460070) (http://www.microsoft.com/en-us/
download/details.aspx?id=26633)

2. See the following Microsoft article for Search Server and SQL Server requirements and recommendations: 
http://technet.microsoft.com/library/bb905370%28office.14%29.aspx

3. On the computers where you plan to install Search Server and SQL Server, set up a domain user account with
Log on as a service rights.

4. On the SQL Server computer:
• Make sure this computer is on the domain.
• Install SQL Server 2008 R2, if not already installed.
• In SQL Server Management Studio, add the domain user mentioned in step 3 (Security > Logins > New

Logins) and turn on the sysadmin server role for this user.
5. On the Search Server computer:

• Make sure this computer is on the domain.
• Install Windows Updates.
• Add the domain user mentioned in step 3 to the Windows Administrators group.
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To Install and Configure Search Server 2010 Express
Before you begin installing, make sure you are logged in as the domain user.
1. Launch the executable file for Microsoft Search Server 2010 Express (SearchServerExpress.exe).

The Search Server 2010 Express installation home page opens.

2. Click Install software prerequisites.
The Microsoft SharePoint 2010 Products Preparation Tool opens. Click through this wizard until all
prerequisites have been installed or enabled. This may take several minutes.

3. Next, go back to the installation home page and click Install Search Server Express.
4. When the license agreement page opens, accept it and click Continue.
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5. On the Choose the installation you want page, click Server Farm.
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6. On the Server Type tab, select Complete.
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7. On the File Location tab, set the installation location for Microsoft Search Server 2010 Express, then set the
location for the index storage area. Make sure the index storage area has enough disk space for the indexes.

8. Click Install Now.
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9. When installation is complete, turn OFF the option to Run the SharePoint product Configuration Wizard
and click Close.
(You will run this wizard later, after you install the service pack.)

10. Next, launch the executable file for Microsoft Search Server 2010 Service Pack 1 (KB2460070)
(searchserver2010sp1-kb2460070-x64-fullfile-en-us.exe).

11. When the license agreement page opens, accept it and click Continue.
12. When installation of the service pack is complete, check for more Windows updates and install them if

needed.
13. Next, launch the SharePoint Products Configuration Wizard (Start > All Programs > Microsoft SharePoint

2010 Products > SharePoint 2010 Products Configuration Wizard).
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14. When the wizard opens, click Next.

15. When prompted, click Yes to restart the necessary services.
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16. On the Connect to a server farm page, select Create a new server farm and click Next.
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17. On the Specify Configuration Database Settings page, specify the following:
Database server The name of the computer on which SQL Server is

installed.
Database name The name of a database inside SQL Server. If it does

not exist, it will be created when you click Next.
Username The name of a domain user account in SQL Server

with administrative access to the database.
Password The password for the specified user account.
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18. On the Specify Farm Security Settings page, specify a passphrase and click Next.
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19. On the Configure SharePoint Central Administration Web Application page, accept the default settings
and click Next.
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20. On the Completing the SharePoint Products Configuration Wizard page, review your settings and click
Next.
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21. On the Configuration Successful page, click Finish.
The SharePoint Administration site opens in your browser, prompting you to select how you want to
configure your SharePoint farm (using a wizard, or manually).
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22. Click Start the Wizard.
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23. Specify a service account, make sure Business Data Connectivity Service and Search Service Application
are selected, and click Next.
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24. On the Create Site Collection page, do the following:
• In the Title and Description section, in enter Search center in the Title field.
• In the Template Selection section, select the Enterprise tab and select Basic Search Center
• Click OK.
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25. Click Finish, then go to Central Administration > System Settings > Servers > Manage services on server
and verify that Business Data Connectivity Service and SharePoint Server Search are both started.

Microsoft Search Service 2010 Express setup is now complete.

To Set Up the ProjectWise Server

1. If you are reusing the computer on which the full text index catalog is currently hosted, you can continue to
use the ProjectWise server (from this release) that is installed on this computer (whether a standalone
ProjectWise Design Integration Server, a tail ProjectWise Design Integration Server, or a standalone
ProjectWise Indexing Service).

2. If you are configuring a new computer to host the full text index catalog, make sure you install or configure all
of the full text indexing prerequisites before installing ProjectWise Design Integration Server or ProjectWise
Indexing Service from this release as documented in this ProjectWise Implementation Guide .

3. Install the ProjectWise Design Integration Server or ProjectWise Indexing Service from this release.
4. If you are installing ProjectWise Design Integration Server to be a tail server in a head/tail configuration,

configure it as a tail server now, as described in the section, Moving Document Processors to a Secondary
Server (on page 78).

5. If you are configuring a new computer and you have an existing full text index catalog on another computer,
at this point you can copy over the DMSINDEX files from the existing full text index catalog as described in the
ProjectWise Administrator help (see “Managing Document Extractions > Changing the Indexing Service
Storage Location”). Make sure you follow all of the steps described.

6. In the local Services window, open the Properties dialog for the ProjectWise server you just installed
(ProjectWise Design Integration Server or ProjectWise Indexing Service) and set the log on account to be the
domain user account you set up before installation. Restart the service after you change the account.

ProjectWise Indexing Service Configuration
Implementing Microsoft® Search Server 2010 Express

ProjectWise Design Integration 122 Implementation Guide



7. In ProjectWise Administrator, log in to your datasource and go to Document Processors > Full Text
Indexing > Properties > General tab. Make sure Index Server is pointing to the Microsoft Search Server
2010 Express computer. If not, change it now.
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Note: You can skip this step if you installed Microsoft Search Server 2010 Express on the same computer that
was already hosting the full text index catalog, or if the full text index catalog is being hosted on a standalone
ProjectWise Design Integration Server.

Running the Delivered Configuration Script
The script file SETUP_MSSE.PS1 gets installed when you install ProjectWise Design Integration Server or
ProjectWise Indexing Service. Running this script does the following:
• Adds the necessary registry settings to enable the dmsindex iFilter
• Registers the DMSINDEX file extension in Microsoft Search Server 2010 Express
• Creates a Windows share of the ProjectWise full text index catalog (default location is

C:\ProgramData\Bentley\pw-index-storage) and adds “pw-index-storage” as a content source in
Microsoft Search Server 2010 Express

• Modifies the MaxResultsReturned setting in Microsoft Search Server 2010 Express
• Configures ProjectWise to use Microsoft Search Server 2010 Express for full text searches

To Run the Configuration Script

1. Launch the Sharepoint 2010 Management Shell with administrative privileges.
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(Select Start > All Programs > Microsoft SharePoint 2010 Products, then right-click Sharepoint 2010
Management Shell and select Run as administrator.)

2. Navigate to C:\Program Files\Bentley\ProjectWise\Bin and enter:
.\setup_msse.ps1

You can now use Microsoft Search Server 2010 Express to crawl the ProjectWise full text index catalog.

To Crawl the Full Text Index Catalog

1. Open the SharePoint Central Administration page (Start > All Programs > Microsoft SharePoint 2010
Products > SharePoint 2010 Central Administration).
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2. Under Application Management click Manage service applications.
3. On the Service Applications page click Search Service Application.
4. On the Search Administration page click Content Sources.
5. Click the down arrow next to pw-index-storage and select Start Full Crawl.
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The dmsindex files from the ProjectWise full text index catalog are now indexed in Microsoft Search Server
2010 Express, and full text searches can be performed as usual from ProjectWise Explorer.
Tip: Click the pw-index-storage content source on the Search Administration page if you want to configure a
schedule for crawling the ProjectWise full text index catalog. You will need to crawl the full text index
periodically for updates as new full text indexing extractions are run.

Troubleshooting

The following are some notes gathered during the testing of this solution.

Error Messages in the Crawling Log After the First Full Crawl
After performing the first full crawl, the crawling log (SharePoint site > Crawling log) may contain the
following error for some files:
The file exists. (Exception from HRESULT: 0x80070050)

This is a SharePoint issue, unrelated to ProjectWise.
To remove these errors from the log, simply crawl that content source again using an incremental crawl.
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Error Message, “Too many results were returned”
ProjectWise is by default configured to return only 10,000 documents per search. If the search returns more
than 10,000 documents, you will see this error in ProjectWise Explorer:
Last Error [ 58270 ]  
Too many results were returned. Please refine your search.

To increase the number of documents allowed in the search results:
1. On the ProjectWise Design Integration Server computer (or the tail server in a head/tail Integration Server

configuration), navigate to the ...\ProjectWise\Bin directory.
2. Open the DmsAfpHost.exe.config file in a text editor.
3. Under <appSettings>, increase the value of the QueryService_MaxResultsCount setting as needed.

Resetting Expired Passwords
If the password expires for the domain user account under which all the services and processes are running,
there are several places on the Search Service Express computer where the password should be reset:
1. Go to Start > Administrative Tools > Services and change the user password for all the services that have

“Log On As” set as your domain account.
2. Go to Start > Administrative Tools > Internet Information Services (IIS) Manager, expand server node

and select Application Pools. In the Application Pools list, change the user password for all items that have
the Identity set as your domain user account. The password can be changed by right-clicking the item and
selecting Advanced Settings > Process Model > Identity. After changing passwords, restart those
application pools.

Large Files Missing from Search Results
In some cases, large files may not be fully indexed, causing those documents not to be found in a full text search.
To fix this, you can increase the value of the following two registry keys under HKEY_LOCAL_MACHINE
\SOFTWARE\Microsoft\Office Server\14.0\Search\Global\Gathering Manager:
• CB_ChunkBufferSizeInMegaBytes
• CB_MinBytesReservedForDoc

After editing these registry keys, you must do the following:
1. Restart the SharePoint Server Search 14 service.
2. Restart Internet Information Services (IIS).
3. Perform an incremental crawl for those large .dmsindex files. For an incremental crawl to be successful, you

should modify those files first, so that the crawl knows to search them again (for example, open the file and
add a space somewhere inconsequential save the file).
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ProjectWise Explorer Configuration

ProjectWise Explorer is the main client interface for ProjectWise, from which users can check out, open, modify,
and otherwise manage their ProjectWise documents.
iDesktop Integration is an option of the ProjectWise Explorer installer that adds ProjectWise functionality to
supported applications such as MicroStation, AutoCAD, Revit, Microsoft Office, and others. When an application
is integrated with ProjectWise, you can access your datasources, check out and open ProjectWise documents,
and check them back in, all from inside the application without having to open ProjectWise Explorer. The level of
integration differs from application to application, but typically the commands affected in each application are
those which open and save files, automatically presenting you the option to open from and save to ProjectWise
rather than the Windows file system.
Other client tools, and the on-premise components for ProjectWise Connection Services, can also be installed
through the ProjectWise Explorer installer.
After installation, open ProjectWise Explorer. If the ProjectWise Explorer client you just installed is on the same
computer or within the same subnet as the ProjectWise Design Integration Server or a ProjectWise Gateway
Service that is publishing datasource lists, ProjectWise Explorer will automatically display that server’s
datasources, assuming the server is running and you have permission to see that server’s datasources. If the
ProjectWise Explorer client is not on the same subnet as the ProjectWise Design Integration Server or a
ProjectWise Gateway Service, you need to configure the ProjectWise network on the ProjectWise Explorer client
computer so that the appropriate datasources display in ProjectWise Explorer. See Connecting Individual Clients
to the Server (on page 170) for details.

Before You Install or Upgrade ProjectWise Explorer
Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.

1. Make sure the latest Windows updates have been installed.
2. Make sure Microsoft .NET Framework 4.5.1 or higher is installed.
3. If ProjectWise Explorer V8 XM Edition or earlier is installed, uninstall it now.

If ProjectWise Explorer V8i or later is installed, you can leave it installed and let the new ProjectWise
Explorer installer upgrade it for you.
Note: If you have additional ProjectWise applications installed from the same older (V8i or later) release
version, see Upgrading to the Current Version > Precautions (on page 253) for the recommended workflow
for upgrading.

4. A normal uninstallation of ProjectWise Explorer removes the PW.CFG and MCM.CFG files related to
MicroStation integration. Likewise, an upgrade will also remove the existing PW.CFG and MCM.CFG files and
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replace them with new ones. If you have made changes in these files, make a copy of these files before you
upgrade.

5. (Existing Revit integrations) If this is an upgrade and you also have the ProjectWise Integration Module for
Revit installed for an earlier version of ProjectWise Explorer, then before you upgrade, you must first
manually uninstall the integration module. Then when you go to install the new ProjectWise Explorer, the
installer will install the necessary Revit integration.

6. Install the applications you want to integrate with ProjectWise Explorer.
See the ProjectWise readme for a list of supported applications.

7. Integration with Microsoft Office requires a corresponding version of Office Primary Interop Assemblies.
Office Primary Interop Assemblies may already be installed as part of your Office installation, however, make
sure it is installed before you install ProjectWise Explorer.

8. If installing ProjectWise Explorer on a computer on which ProjectWise Design Integration Server is already
installed, the installer may display a “Files in Use” message. If this happens, you can simply click Ignore and
the installation will continue without any problems. If you want to avoid this message, you can stop the
service for the ProjectWise Design Integration Server before you install ProjectWise Explorer, and then
restart the service once installation is complete.

9. The CONNECTION Client is a delivered prerequisite and gets installed automatically if needed as part of the
ProjectWise Explorer installation.
Note: An internet connection is required to install the CONNECTION Client, therefore you must be connected
to the internet to carry out the ProjectWise Explorer installation.

To Install ProjectWise Explorer
1. Double-click the Setup_ProjectWisex64_10.00.03.xx.exe file.

The Installation Wizard opens.

ProjectWise Explorer Configuration
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2. Accept or change the default installation location, read and accept the license agreement, then click Next.
The ProjectWise Explorer installer delivers both 64-bit and 32-bit components.
The default installation location for the 32-bit components is
C:\Program Files (x86)\Bentley\ProjectWise.
The default installation location for the 64-bit components is C:\Program Files\Bentley\ProjectWise.
The Select feature to install page opens.
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The following features can be installed:
• ProjectWise Explorer

• ProjectWise Explorer and Tools

• ProjectWise 64-bit components
• ProjectWise Explorer

• Bentley Viewing, Printing and Markup
• Messaging Services
• Document Creation Wizard

ProjectWise Explorer Configuration
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• Project Form Preview Tab
• iDesktop Integration

Expand this feature and look at the items listed. The applications listed (if any) are the installed
applications (such as MicroStation, AutoCAD, Revit, Microsoft Office) for which iDesktop
Integration can be installed. This feature also includes the following:
• Bentley Application Base Integration - required for integration with MicroStation and

MicroStation PowerDraft, as well as other MicroStation-based applications such as InRoads and
AECOsim Building Designer.

• Bentley Application Base Integration (x64)

Note: The Bentley MicroStation integration option is only available for pre-CONNECT Edition
versions of MicroStation and MicroStation PowerDraft. This option does not appear at all when
CONNECT Edition versions of MicroStation or MicroStation PowerDraft are installed, because they
deliver their own integration. If pre-CONNECT Edition versions of both MicroStation and
MicroStation PowerDraft are installed, then installing this option installs integration support for
both applications. Also, if two MicroStation V8i versions are installed, then turning on the iDesktop
Integration option for MicroStation V8i will install iDesktop Integration support for both versions
of MicroStation.

• Tools

• Administrative Tools

• Menu Editor
• Export-Import Tools

• Export-Import to AAM File - installs the (Datasource) Export and Import tools
(PWEXPT.EXE, PWIMPT.EXE)

• Export-Import to Excel - used to bulk import files and attribute data from external sources
into ProjectWise, or to bulk export files and attribute data out of ProjectWise. The tool uses a
Microsoft Excel spreadsheet as the data interchange format. This tool was previously a
separate installation.

• User Tools
• Spatial Extension
• Dependency Viewer
• ProjectWise Data Shortcut Project Editor
• Workflow Rules Engine

• Bentley DGN Navigator Control 2.1 x64
• Projectwise Analytics Data Upload Service - on premise component for ProjectWise Project

Performance Dashboards
• ProjectWise Deliverables Management connector for ProjectWise Explorer - on premise component

for ProjectWise Deliverables Management
3. The ProjectWise Explorer item is preselected. Check the check box next to each feature you want to install,

then click Install.
Installation of the selected features begins. At this time the installer will also install the following
prerequisites, if they are not already installed:
• ProjectWise Prerequisite Runtimes
• CONNECTION Client

4. When installation is complete, click Finish.
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Related Links
• On-Premise Configuration for ProjectWise Connection Services (on page 203)

Silent Installation from a Command Prompt
You can install ProjectWise Explorer silently (without using the wizard) from a command prompt.
To find out which features you can include or exclude from your install, open a command prompt with elevated
privileges (run as administrator) and then enter the following command:
"path_to_PWEinstaller\Setup_ProjectWisex64_10.00.03.xx.exe" 
ExportCliArgs=path_to_output\FeatureIDTree.txt

For example:
"C:\PW_installs\Setup_ProjectWisex64_10.00.03.24.exe" ExportCliArgs=C:\PWinstalls
\FeatureIDTree.txt

This creates a file called FeatureIDTree.txt which contains a list of all the features that can potentially be
installed through the ProjectWise Explorer installer. Open this file in a text editor and review which features you
want to include in your installation command. Items with an asterisk * next to them (for example,
ProjectWiseExplorerPackage*) are required features that will always be installed and therefore do not need
to be specified in the command.
Features that are normally turned on by default in the wizard do not need to be specified in the installation
command unless you want them not to be installed. Likewise, features that are normally turned off by default in
the wizard do not need to be specified unless you want them to be installed. If the installer delivers integration
for an application you have installed, integration will be turned on for that application by default unless you
specify to not install it. Use the ADDLOCAL property in your command to install a feature that is not normally
installed by default, or if modifying the installation, to install a feature that was previously not installed. Use the
REMOVE property in your command to turn off a feature that is normally installed by default, or if modifying the
installation, to uninstall a feature. If you need to install more than one feature, or turn off more than one feature,
separate those features in the command with a comma. The feature names are case sensitive and should be
typed exactly as they appear in the FeatureIDTree.txt and without the leading dashes (for example, type
Office2016 instead of ---Office2016).
Example: Install ProjectWise Explorer silently, with all default features and integration for installed applications:
“C:\PW_installs\Setup_ProjectWisex64_10.00.03.24.exe” -silent

Example: Install ProjectWise Explorer silently, and do not install the Document Creation Wizard (which is
normally installed by default):
“C:\PW_installs\Setup_ProjectWisex64_10.00.03.24.exe” 
REMOVE=ProjectWiseExplorerPackage_DocumentCreationWizard -silent

Example: Install ProjectWise Explorer silently and do not install Office 2016 integration (assuming Office 2016 is
installed), or modify the installation and turn off Office 2016 integration (if it was installed and now you want to
turn it off):
“C:\PW_installs\Setup_ProjectWisex64_10.00.03.24.exe” REMOVE=Office2016 -silent

Example: Modify the ProjectWise Explorer installation, and turn on Office 2016 integration (if it was not
installed and now you want it installed):
“C:\PW_installs\Setup_ProjectWisex64_10.00.03.24.exe” ADDLOCAL=Office2016 -silent
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Example: Install ProjectWise Explorer silently, with the Bentley DGN Navigator Control and the ProjectWise
Deliverables Management connector for ProjectWise Explorer (which are both normally turned off by default):
“C:\PW_installs\Setup_ProjectWisex64_10.00.03.24.exe” 
ADDLOCAL=DgnNavigatorControlAx,PWDeliverablesMGTClient -silent

By default, the installation log file is saved to
C:\Users\<user.name>\AppData\Local\Temp
\ProjectWise_Explorer_CONNECT_Edition_<datetime>.log. You can change where the log file gets saved
adding the -log argument to your command.
Example: Install ProjectWise Explorer silently, and send the log file to a different folder:
“C:\PW_installs\Setup_ProjectWisex64_10.00.03.24.exe” -log="C:\PW_installs" -silent

Example: Uninstall ProjectWise Explorer silently:
“C:\PW_installs\Setup_ProjectWisex64_10.00.03.24.exe” -uninstall -silent

Tip: Always test your installation configuration by running your command without the -silent argument. This
will open the installation wizard and show which features your command has turned on or off, on the Select
feature to install page. If this page shows what you are expecting, then you can assume that running the same
command silently will install everything you instructed it to install.

Office Integration: Add 'Bentley Systems' as a Trusted Publisher
After installing ProjectWise Explorer with iDesktop Integration support for Microsoft Office, in order to use
integrated Word or Excel, you must add 'Bentley Systems' to Microsoft Office's Trusted Publishers list by
opening integrated Word or Excel, and then when prompted, selecting to trust all content from this publisher
('Bentley Systems'). You only need to do this once. For example, if you add 'Bentley Systems' to the Trusted
Publishers list through integrated Word, then the next time you open integrated Word or Excel, you will not be
prompted about it again. See your Microsoft Office documentation for more information about trusted
publishers.

Changing ProjectWise Explorer Installation and Integration Options
If you need to install (turn on) or uninstall (turn off) any option of the installer that was not selected when you
originally installed ProjectWise Explorer, of if you need to integrate with an application that was installed after
ProjectWise Explorer was installed, you can either completely uninstall ProjectWise Explorer and then reinstall
it and select the options you want, or you can modify (change) the installation and turn on the options that were
not previously selected.
To uninstall:
1. In the Programs and Features window, right-click the ProjectWise Explorer CONNECT Edition item and

select Uninstall.
or
Double-click the ProjectWise Explorer installer file (Setup_ProjectWisex64_10.00.03.xx.exe) and then
select Uninstall when the installation wizard opens.

To modify the installation:
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1. In the Programs and Features window, right-click the ProjectWise Explorer CONNECT Edition item and
select Change.
or
Double-click the ProjectWise Explorer installer file (Setup_ProjectWisex64_10.00.03.xx.exe) and then
select Modify when the installation wizard opens.

2. In the installation wizard, turn on the options you want (only options that were not previously turned on can
be changed) and click Modify.

Upgrading the Version of an Integrated Application

If you installed ProjectWise Explorer with integration support for particular application and then later need to
upgrade your version of that application, follow these steps:
• Uninstall ProjectWise Explorer. This also removes the integration for your application.
• Upgrade the version of the application (for example, Microsoft Office).
• Reinstall ProjectWise Explorer and turn on the option to integrate with the newer version of the application.

Desktop Integration for Bentley Applications
Desktop integration is handled slightly differently depending on which Bentley application you have installed.

Bentley Application Base Integration

The Bentley Application Base Integration options on the ProjectWise Explorer installer are required for
integration with MicroStation and all MicroStation-based Bentley applications, regardless of version, and
therefore are automatically enabled, and cannot be disabled.

Integration with CONNECT Edition Versions of MicroStation and MicroStation
PowerDraft

CONNECT Edition versions of MicroStation, MicroStation PowerDraft and other MicroStation-based applications
deliver their own integration, and therefore specific integration options for those applications do not appear in
the ProjectWise Explorer installer under the iDesktop Integration section (besides the required and enabled
Bentley Application Base Integration options).
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Integration with V8i Versions of MicroStation

When a supported V8i version of MicroStation is installed, then the ProjectWise Explorer installer will display an
integration option for that application under the iDesktop Integration section.
Installing ProjectWise Explorer with iDesktop Integration support for a V8i version of MicroStation delivers a
configuration file called PW.CFG to the Bentley\<program name>\config\appl folder of your MicroStation
installation. This configuration file loads the MDL applications necessary for ProjectWise integration and for
starting MicroStation in integrated mode, when launched from the desktop. To disable desktop integration,
uninstall ProjectWise Explorer, and then reinstall ProjectWise Explorer and turn off integration for MicroStation.

To Disable Desktop Integration for Bentley Navigator, Bentley View, or Bentley i-
model Composer

1. Go to the application's Bentley\<program name>\config\appl folder.
Bentley Navigator C:\Program Files\Bentley\Navigator V8i

\config\appl

Bentley View C:\Program Files\Bentley\View V8i\config
\appl

Bentley i-model Composer C:\Program Files\Bentley\imodelComposer
V8i\config\appl

2. Find the PW.CFG file in that folder and open it in a text editor.
3. Find the line #PW_DISABLE_INTEGRATION_FROM_DESKTOP=1
4. Remove the # character to uncomment and enable the variable.
5. Save and close the PW.CFG file.

When desktop integration is disabled, you can launch the application from the desktop, and it will not be
integrated with ProjectWise Explorer (you will not be prompted to log in to a ProjectWise datasource). The
application will still be integrated, however, whenever you open a document into it from ProjectWise
Explorer.

Running ProjectWise Explorer on Citrix XenApp
ProjectWise Explorer can be configured to run in a Citrix XenApp environment. For this release, Citrix XenApp
6.0 and 6.5 are supported.
Before getting started, make sure the ProjectWise Design Integration Server computer can communicate with
the main Citrix XenApp computer.
Tip: When a user’s working directory node identifier is configured to use a logical name or a GUID, that user
must not use multiple computers to work with documents in ProjectWise.

Tip: The User Tools, Data Export and Import Wizards, Menu Editor, and Attribute Bulk Update tool that can also
be installed through the ProjectWise Explorer installer are not supported when running in a Citrix XenApp
environment.
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Tip: Currently, you cannot drag local files into ProjectWise Explorer when running in a Citrix XenApp
environment. This is a Citrix XenApp issue and has nothing to do with ProjectWise. If you need to add local files
to ProjectWise, use Document > New in ProjectWise Explorer.

Tip: Saving the audit trail report when using ProjectWise Explorer through Citrix XenApp may take a long time.

To Configure ProjectWise Explorer to Run in a Citrix XenApp Environment

1. In ProjectWise, log in to your datasource and select the Users datasource node.
2. Open the Properties dialog for a user and select the Settings tab.
3. Expand Working Directory > When Using ProjectWise Explorer and use a UNC path (for example, \

\workdirs\bobs_workdir) to define the folder path to the user’s working directory.
4. Next, expand Working Directory > When Using ProjectWise Explorer > Node identifier.

This setting is used to define the node name that will be used when the user checks out documents from
ProjectWise Explorer. Because Citrix XenApp users cannot use the user’s host computer name as the node
name, you must change the default value for this setting to one of the other options.

 

 
5. Do one of the following:
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To use the user's user name as the node name, select Use the user's host computer name or user name
and change the value from $HOSTNAME$ to $USERNAME$.
or
To create a random global unique identifier (GUID) to be used as the node name, select Use a global unique
identifier (GUID), then in the Unique Node ID dialog that opens, click Generate New ID and click OK.
or
To enter a logical name to be used as the node name, select Use a logical name, then in the Unique Node ID
dialog that opens, enter a logical name for the node (for example, Bob's Computer) and click OK.

6. Click OK in the User Properties dialog.
7. On the Citrix XenApp computer (or computers, if you are using a Citrix XenApp farm) install ProjectWise

Explorer.
8. On each Citrix XenApp computer where ProjectWise Explorer is installed, establish a connection to the

ProjectWise Design Integration Server computer using the ProjectWise Network Configuration Settings
dialog (Control Panel > ProjectWise V8i Network).

9. On the main Citrix XenApp computer, open the Citrix Delivery Services Console and use the Publish
Application wizard to publish the 'ProjectWise Explorer' application.
Among other settings, in this wizard you will set the display name that users will see (ProjectWise Explorer)
and also the location of the ProjectWise Explorer program executable (pwc.exe).
When publishing is completed, 'ProjectWise Explorer' will appear next to all other applications which are
available for Citrix XenApp users.
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 9
Bentley i-model Composition Server for PDF

Configuration

Bentley i-model Composition Server for PDF runs on top of ProjectWise Orchestration Framework Service and
uses ProjectWise InterPlot Organizer to automate the creation of renditions (PDF, JPEG, TIFF, and/or CALS)
from documents stored in ProjectWise.
Administrators use the Bentley i-model Composition Server Administrator interface (inside Orchestration
Framework Administrator) to create, schedule, run, monitor, and review batch rendition jobs, while ProjectWise
Explorer users can run on-demand rendition jobs on selected documents, flat sets, folders, and/or work areas.
Upon completion of the job, the new rendition documents are stored in ProjectWise, and if selected an email
notification is sent to the user who ran the job. As part of the system configuration, the administrator must
define various rendition settings in ProjectWise Administrator.
Tip: As delivered, Bentley i-model Composition Server for PDF lets you distribute the newly created renditions
(and/or source documents) to any folder or work area in the same datasource, or to another datasource.
Through custom connectors you can distribute to other document management systems. Contact Bentley
Professional Services about the availability of custom connectors.

Configuration Checklist for Bentley i-model Composition Server for PDF
The following is a checklist of what you need to do to set up Bentley i-model Composition Server for PDF. It is
assumed that you already have an operational ProjectWise Design Integration Server and datasource configured
on another computer.
Note: Bentley i-model Composition Server for PDF requires a Bentley i-model Composition Server license.

Caution: For performance reasons it is recommended that you install Bentley i-model Composition Server for
PDF on a dedicated server, and that you do not install it on the same computer as any of these:
• ProjectWise Design Integration Server
• ProjectWise Caching Server
• ProjectWise Web Server
• ProjectWise Publishing Server

1. Make sure the latest Windows updates have been installed.
2. On this or another computer, install Microsoft SQL Server, or use the SQL Server Express that is delivered

with ProjectWise Server Setups.
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3. On this computer, open Server Manager and make sure the Web Server (IIS) role is installed, along with the
following role services and features.
Role services:
on Windows Server 2016 on Windows Server 2012 R2 on Windows Server 2008 R2 SP1

• Web Server
• Common Http Features

• Default Document
• Static Content

• Health and Diagnostics
• HTTP Logging

• Performance
• Static Content

Compression
• Security

• Request Filtering
• Application Development

• .NET Extensibility 4.6
• ASP.NET 4.6
• ISAPI Extensions
• ISAPI Filters

• Management Tools
• IIS Management Console
• IIS 6 Management

Compatibility
• IIS 6 Metabase

Compatibility

• Web Server
• Common HTTP Features

• Default Document
• Static Content

• Security
• Request Filtering

• Application Development
• .NET Extensibility 4.5
• ASP.NET 4.5
• ISAPI Extensions
• ISAPI Filters

• Management Tools
• IIS Management Console
• IIS 6 Management

Compatibility
• IIS 6 Metabase

Compatibility

• Web Server
• Common HTTP Features

• Default Document
• Static Content

• Application Development
• ASP.NET
• .NET Extensibility
• ISAPI Extensions
• ISAPI Filters

• Security
• Request Filtering

• Management Tools
• IIS Management Console
• IIS 6 Management

Compatibility
• IIS 6 Metabase

Compatibility

Features:
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on Windows Server 2016 on Windows Server 2012 R2 on Windows Server 2008 R2 SP1

• .NET Framework 4.6 Features
• WCF Services

• HTTP Activation
• Message Queuing

• Message Queuing Services
• Message Queuing Server

• Windows Process Activation
Service
• Process Model
• Configuration APIs

• .NET Framework 3.5 Features
• HTTP Activation

• .NET Framework 4.5 Features
• .NET Framework 4.5
• ASP.NET 4.5
• WCF Services

• HTTP Activation
• TCP Port Sharing

• Message Queuing
• Message Queuing Services

• Message Queuing Server

• .NET Framework 3.5.1
Features
• WCF Activation

• HTTP Activation
• Non-HTTP Activation

• Message Queuing
• Message Queuing

Services
• Message Queuing

Server

4. On this computer, install or configure the prerequisites needed for ProjectWise Orchestration Framework
Service.
See Before You Install or Upgrade ProjectWise Orchestration Framework Service (on page 26) for details.

5. On this computer, set up the Bentley i-model Composition Server for PDF working directory (on page 143).
6. On this computer, install the Prerequisites for Bentley Desktop Applications (a separate download on the

Bentley Software Fulfillment Center).
7. On this computer, install the applications (print engines) (on page 143) that will be used to create the

renditions.
8. On this computer, install ProjectWise InterPlot Organizer CONNECT Edition (a separate download on the

Bentley Software Fulfillment Center).
ProjectWise InterPlot Organizer requires that you restart the computer after installation, however you can
wait until after you finish fully configuring Bentley i-model Composition Server for PDF on this computer to
do the restart.

9. On this computer, install the following applications delivered with this release:
• ProjectWise Orchestration Framework Service (on page 27) (ProjectWise Server Setups)
• ProjectWise Explorer (on page 130) (ProjectWise Client Setups)
• Bentley i-model Composition Server for PDF (on page 146) (ProjectWise Server Setups)

10. On the ProjectWise Design Integration Server computer, open the DMSKRNL.CFG file and do the following:
• add the Bentley i-model Composition Server for PDF computer to the Trusted Servers list (on page 163)
• configure the [RenditionWebServices] section (on page 163)

11. Set up the default user (on page 167).
12. In order to receive email notifications, make sure that each user who runs a job has a valid email address

specified in their user properties (on page 168).
13. Make sure that the storage area used by the destination folder/datasource has adequate disk space for the

new rendition documents. You should estimate about the same amount of free disk space that you set aside
for the Bentley i-model Composition Server for PDF working directory.

14. In ProjectWise Administrator, configure your rendition settings:
• create the rendition profile components necessary to run jobs in Bentley i-model Composition Server

Administrator
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• create the rendition profiles necessary for users to create renditions in ProjectWise Explorer
See “Configuring Rendition Settings for Bentley i-model Composition Server for PDF” in the ProjectWise
Administrator help for details.

15. In ProjectWise Explorer, optionally assign rendition profiles to folders and work areas. See the ProjectWise
Explorer help for details.

16. Restart the Bentley i-model Composition Server for PDF computer.

Setting Up the Bentley i-model Composition Server for PDF Working
Directory
Bentley i-model Composition Server for PDF needs a shared working directory so it can copy out the files it has
been told to process. Before installing Bentley i-model Composition Server for PDF, you need to set up this
working directory by:
• creating and sharing a folder (for example, C:\ics_workingdir)
• making sure your users have access to the shared working directory. Specifically, the user installing Bentley

i-model Composition Server for PDF needs full control, as well as any user who will be creating, modifying, or
running Bentley i-model Composition Server for PDF jobs.

• making sure that the number of simultaneous users that can access the working directory is high enough for
your needs. This is a Windows permission, set on the folder itself.

The working directory is recommended to be set up on the same computer as Bentley i-model Composition
Server for PDF. Make a note of the path to this working directory, as you will be prompted to specify the location
of this folder during Bentley i-model Composition Server for PDF installation.
To get an idea of how much free disk space to set aside for the working directory, consider that the working
directory will hold:
• a copy of all files selected for a job along with all of their reference files
• all renditions created by the job
• job history
• additional data extracted from ProjectWise such as document and folder properties
• system files, such as installed connectors, installed extensions, and logging files
Tip: As you run jobs, the working directory will continue to grow in size. You can periodically empty the working
directory using Orchestration Framework Administrator. It is recommended that you never manually delete files
from the working directory.

Installing the Necessary Print Engines
Bentley i-model Composition Server for PDF uses ProjectWise InterPlot Organizer to manage the creation of plot
output files (renditions) through the use of one or more print engines that are also installed on the Bentley i-
model Composition Server for PDF computer. ProjectWise InterPlot Organizer loads the correct print engine at
runtime depending on the type of file being processed.
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Print Engines for CAD Files

If you need to create renditions from DGN and DWG files, you need to have at least one print engine installed on
the server that can process your DGN and DWG files. ProjectWise InterPlot Organizer uses MicroStation (or
other MicroStation-based applications) to process CAD files. For some organizations, MicroStation (or
MicroStation PowerDraft or Bentley View) is sufficient and might be the only application needed to create
adequate renditions from your DGN and DWG files. Other organizations may have some DGNs which require
special processing and which MicroStation alone cannot adequately publish. In those cases, you may need to
install some other MicroStation-based applications to process those DGNs. If you do not install the appropriate
print engine, some of the renditions may not properly display all of the graphics or all of the property
information you are expecting. For example, AECOsim Building Designer is the preferred print engine to use for
DGN documents authored by Bentley building and architecture applications. When you have multiple
MicroStation-based applications installed, ProjectWise InterPlot Organizer uses ProjectWise application
associations to determine which source documents require which print engine.
ProjectWise InterPlot Organizer is compatible with:
• MicroStation (CONNECT Edition and V8i versions)
• MicroStation PowerDraft (CONNECT Edition and V8i versions)
• Bentley View V8i (SELECTseries 4)
• Other MicroStation-based applications including (but not limited to) AECOsim Building Designer, Power

InRoads
• MicroStation/J (required for legacy support)
Note:

• Some geo/mapping products may need to be installed, to ensure full fidelity with the screen display.
• Other products may need to be installed, to ensure that the output PDFs display all of the property

information that would normally display in the source documents.

Tip: Open one of your DGNs in MicroStation. If the graphics appear correct and the Items dialog (File > Item
Browser) shows the correct properties, then you can safely use MicroStation as the print engine. If not, then you
should install the application that the DGN was created in.

Print Engines for Office Documents

ProjectWise InterPlot Organizer uses a PDF creator as the print engine for processing Microsoft Word and
Microsoft Excel documents, therefore you must install a PDF creator if you plan to create renditions from Word
and Excel source documents (Ghostscript is the recommended PDF creator application). The PDF creator
application works in conjunction with the Word and Excel providers delivered with ProjectWise InterPlot
Organizer and a specified Windows postscript printer. Note that you must install a PDF creator application even
if you are not creating PDF renditions from Word and Excel documents.
In addition to installing a Postscript to PDF converter such as Ghostscript, you should do the following:
• Install the native Microsoft application (Microsoft Word/Excel) for each type of document you plan to create

renditions for.
• Create a Windows postscript printer and specify that printer on the ProjectWise InterPlot Organizer

Configure - Integrate dialog.
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For prints up to 11 x 17, use the HP Color LaserJet 8500 PS printer driver. For prints larger than 11 x 17, use
the HP DesignJet T7100ps PS3 printer driver.

• Install the Word and Excel providers when installing ProjectWise InterPlot Organizer by selecting the
Specifications feature (the Specifications feature is installed by default).

To Configure the Word and Excel Providers with Ghostscript

1. Open the ProjectWise InterPlot Organizer Configure dialog (Start > All Programs > Bentley > ProjectWise
InterPlot Utilities > ProjectWise InterPlot Organizer Configure) with elevated privileges (Run as
administrator).

2. Click Integrate.
The ProjectWise InterPlot Organizer Configure - Integrate dialog opens.

3. On the Office tab, turn off Use Specifications Provider.
4. Click Browse next to the PDF Creator Application field and navigate to the Ghostscript installation folder.
5. Select gswin32c.exe or gswin32.exe, and then click Open.
6. (Optional) Enter any additional PDF creator application arguments.
7. Select a postscript printer from the list.

If you do not see a postscript printer in the list, you can exit the dialog and create one.
 

 
8. Click OK.

Bentley i-model Composition Server for PDF Configuration
Installing the Necessary Print Engines

ProjectWise Design Integration 145 Implementation Guide



A dialog opens stating that the product has been successfully integrated with your installed products.
9. Click OK.

10. Click Exit Configure.

Installing Bentley i-model Composition Server for PDF
The Bentley i-model Composition Server for PDF installer guides you through the installation and general
configuration of Bentley i-model Composition Server for PDF. When installation is complete, the Configuration
Wizard is immediately launched. Among other things, the Configuration Wizard is used to specify the location of
the working directory and to select which type of configuration to perform.
There are two configuration types to select from (Standard or Custom), but there are really three types of
configurations you can perform:
• Standard — Creates a Bentley i-model Composition Server for PDF orchestration instance and automatically

installs one of each dispatcher and processor on the computer.
• Custom (with an orchestration instance) — Creates an orchestration instance and gives you the option to

increase the default number of the dispatchers and processors that are installed on the computer.
• Custom (without an orchestration instance) — Does not create an orchestration instance, but gives you the

option to select which dispatchers and/or processors to install on the computer, and how many of the
selected dispatchers and/or processors to install. This configuration type is used to distribute the workload
across multiple computers, and requires that you perform a Standard or Custom configuration on another
computer. In this case, you would use the same Orchestration Framework database for each installation so
that the orchestration instance will be aware of and make use of any additional dispatchers and processors
installed on extra computers.

Bentley i-model Composition Server Administrator is the main client interface for Bentley i-model Composition
Server for PDF, and is an option of the Bentley i-model Composition Server for PDF installer. Typically you install
this with the server, but you can install it on a separate computer for remote administration if needed. Installing
Bentley i-model Composition Server Administrator installs Orchestration Framework Administrator with the
Bentley i-model Composition Server Administrator extension.
To install just Bentley i-model Composition Server Administrator, you run the same Bentley i-model
Composition Server for PDF installer and simply turn off the server and IIS components. Note that Bentley i-
model Composition Server Administrator does not require ProjectWise InterPlot Organizer or ProjectWise
Orchestration Framework Service, but it does require ProjectWise Explorer, and it does require MSMQ (with
HTTP Support) to be enabled and running. If Bentley i-model Composition Server for PDF is on the domain, then
the computer on which you install Bentley i-model Composition Server Administrator must also be on the
domain, you must be logged in to the computer with a domain account, and the domain account used to open
Bentley i-model Composition Server Administrator must also be a member of the local administrators group.

Before You Install or Upgrade Bentley i-model Composition Server for PDF

1. See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.

2. Review the Configuration Checklist for Bentley i-model Composition Server for PDF (on page 140).
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To Perform a Standard Installation of Bentley i-model Composition Server for PDF

1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to Bentley i-model Composition Server for PDF.
3. When the Setup Wizard opens, click Next.

 

 
4. When the License Agreement page opens, read and accept the agreement, then click Next.

The Custom Setup page opens, showing you the features that can be installed, and the location to which the
product will be installed.
The following items can be installed through this installer:
Bentley i-model Composition Server for PDF
IIS Web Service for Bentley i-model Composition Server for PDF (required for ProjectWise Explorer jobs
only)
Bentley i-model Composition Server Administrator (installs Orchestration Framework Administrator with
the Bentley i-model Composition Server Administrator extension; required to configure batch rendition
jobs only, not required for ProjectWise Explorer jobs)

5. (Optional) If you do not want to install one of the features, click the feature's icon and select X — This feature
will not be available.
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6. When finished on the Custom Setup page, click Next.

If you selected to install the IIS Web Service for Bentley i-model Composition Server for PDF, then the Select
Website page opens with a list of IIS websites available on this computer.
If, for testing purposes, you have other Bentley applications installed that are already deployed to IIS then
make sure you select a different website to deploy this IIS Web Service to.
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7. Select a website to deploy the service to and click Next.
8. When the Ready to Install page opens, click Install.
9. When installation is complete, click Finish.
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Next, the Bentley i-model Composition Server for PDF Configuration Wizard opens.
The Configuration Wizard automatically finds the Orchestration Framework database instance you created
during the ProjectWise Orchestration Framework Service installation, and shows you which version of the
Bentley i-model Composition Server for PDF schema will be installed, in order to configure the Orchestration
Framework database for Bentley i-model Composition Server for PDF.
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10. Click Next.

The Working Directory Type page opens for you to select whether you want to use a shared or non-shared
folder for the working directory for Bentley i-model Composition Server for PDF jobs.
• Local Working Directory - Select this type if you want to use a local, non-shared folder for the working

directory.
• Shared Working Directory - Select this type if you want to use a shared folder for the working directory

located on this or another computer in the network.
If you select Local Working Directory, Bentley i-model Composition Server for PDF and Bentley i-model
Composition Server Administrator must both be installed on the same local computer. Use Shared Working
Directory if you need to install Bentley i-model Composition Server for PDF on multiple computers, or if you
need to install Bentley i-model Composition Server for PDF and Bentley i-model Composition Server
Administrator on separate computers.
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11. Select a working directory type and click Next.
The Working Directory page opens for you to specify the location of the working directory.
(If you have not yet created, or created and shared, the folder you want to use for the working directory, do
so now before continuing.)
You can either type the location of the working directory in the field provided, or click the Browse button to
locate and select the working directory folder. When typing the path to a local, non-shared folder, use the
local file system path (C:\ics_localworkdir).
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When typing the path to a shared folder, use the UNC path (\\computername\ics_sharedworkdir).
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12. Specify the location of the working directory and click Next.
The User Credentials page opens. On this page you must specify the ProjectWise user whose working
directory ProjectWise InterPlot Organizer will use to copy out any managed workspace files. Specifically,
whenever a user runs a rendition job from ProjectWise Explorer, ProjectWise InterPlot Organizer will use the
ProjectWise working directory of the user specified here, for the purpose of downloading managed
workspace files. The user you specify here does not need to exist now, but it must exist, of course, by the time
you run a job in ProjectWise Explorer.
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13. Enter the user name and password of a ProjectWise account and click Next.

The next page that opens lets you specify email server information, so that the user can opt to receive an
email notification whenever a job is complete.
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14. Do one of the following:

If you do not plan to use email notifications with rendition jobs, or if you want to configure this information
later, you can skip this page and click Next.
or
If you do plan to use email notifications with rendition jobs and you have the information ready, enter
information about your email server. When finished, click Next.
The Configuration Type page opens with two options, Standard and Custom. The Standard option installs all
of the individual processors and dispatchers that make up Bentley i-model Composition Server for PDF; the
Custom option is only used when you want to install additional processors and/or dispatchers on another
computer, to share the workload of the main Bentley i-model Composition Server for PDF instance.
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15. Select Standard and click Next.
16. When the DMS Connectors page opens, select the ProjectWise Connector and click Next to begin

configuration of Bentley i-model Composition Server for PDF.
As delivered, Bentley i-model Composition Server for PDF only delivers one connector — the ProjectWise
Connector. This connector is selected by default, and is required to store the newly created rendition
documents in the same or other datasource.
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17. When the word “Done” appears over the progress bar on the Configuration In Progress page, click Close.
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To Perform a Custom Installation of Bentley i-model Composition Server for PDF,
with an Orchestration Instance

1. Follow the steps in To Perform a Standard Installation of Bentley i-model Composition Server for PDF (on
page 147) until you get to the Configuration Type page.
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2. Select Custom and click Next.

The Orchestration Components page opens.
3. Turn on Create orchestration instance.
4. Leave all of the dispatchers selected.
5. To install more than one of a particular processor, increase the number next to the processor as needed.
6. Leave the other processors set to 1.
7. Click Next.
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8. When the word “Done” appears over the progress bar on the Configuration In Progress page, click Close.

To Perform a Custom Installation of Bentley i-model Composition Server for PDF,
Without an Orchestration Instance

1. Follow the steps in To Perform a Standard Installation of Bentley i-model Composition Server for PDF (on
page 147) until you get to the Configuration Type page.
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2. Select Custom and click Next.

The Orchestration Components page opens.
3. Turn off Create orchestration instance.
4. Turn off any dispatcher you do not need to install on this computer.
5. To install more than one of a particular processor, increase the number next to the processor as needed.
6. Set the number to 0 next to the ProjectWise Connector Processor; you do not need to install this processor

when you are not creating an orchestration instance.
7. Set the number to 0 next to any other processor you do not want to install on this computer.
8. Click Next.
9. When the word “Done” appears over the progress bar on the Configuration In Progress page, click Close.

Note:

You can rerun the Configuration Wizard any time after installation by doing the following:
• On Windows Server 2012 or later:

Go to the Start page and type Bentley i-model Composition Server Configuration, or go to Start > Apps >
Bentley and click Bentley i-model Composition Server Configuration.

• On Windows Server 2008:
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Select Start > All Programs > Bentley > ProjectWise <version> > Bentley i-model Composition Server
for PDF > Bentley i-model Composition Server Configuration.

Note: If you create an orchestration instance during installation (either by Standard or Custom configuration),
and then on another computer perform a Custom configuration without creating an orchestration instance, you
will need to configure the orchestration instance on the main computer so that the additional processors and
dispatchers are included in the instance. For details, see “Configuring Bentley i-model Composition Server for
PDF Orchestration Instances” in the Bentley i-model Composition Server for PDF help.

Adding Bentley i-model Composition Server for PDF to the Trusted
Servers List
Before you can define and run Bentley i-model Composition Server for PDF jobs, you need to add the IP address
of the Bentley i-model Composition Server for PDF computer to the Trusted Servers list in the ProjectWise
Design Integration Server's DMSKRNL.CFG file. If you install Bentley i-model Composition Server Administrator
on a different computer than Bentley i-model Composition Server for PDF, then you also need to add the IP
address of the Bentley i-model Composition Server Administrator computer to the Trusted Servers list.
See Adding Servers to ProjectWise Design Integration Server's Trusted Servers List (on page 83).

Adding the Location of the Bentley i-model Composition Server for PDF
IIS Web Service to DMSKRNL.CFG
The [RenditionWebServices] section in the ProjectWise Design Integration Server's DMSKRNL.CFG file is
used to specify the location of the Bentley i-model Composition Server for PDF IIS Web Service, in order to route
rendition requests submitted from ProjectWise Explorer users. You do not need to configure this section to be
able to create or run batch rendition jobs from Bentley i-model Composition Server Administrator.
1. On the ProjectWise Design Integration Server computer, open the DMSKRNL.CFG file.
2. Find the [RenditionWebServices] section.
3. Under that, add a new line to represent the location of the IIS Web Service on the Bentley i-model

Composition Server for PDF computer.
For example:
[RenditionWebServices]
Bentley iCS for PDF web service=http://iCSforPDFcomputername/RenditionService/
RenditionService.svc

Note: To configure Rendition Web Services for a secure website, see Configuring a Secure Website for Bentley
i-model Composition Server for PDF (on page 164).
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Configuring a Secure Website for Bentley i-model Composition Server for
PDF
Sensitive information such as login credentials is sent in plain text from the rendition web service, therefore it is
recommended that the connection be secure. Using IIS, you can easily configure an SSL certificate to establish a
secure connection.
Note: This task assumes that you have already created a website and imported an SSL certificate. If you are
securing the website after installing Bentley i-model Composition Server for PDF, make sure you secure the
website that you selected during the installation of Bentley i-model Composition Server for PDF.

1. Open Internet Information Services (IIS) Manager.
2. Select the website in the left pane tree view, and then right-click and select Edit Bindings.

3. In the Site Binding dialog, click Add.

4. In the Add Site Binding dialog, do the following:
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a. Set Type to https.
b. From the SSL certificate list, select the SSL certificate you previously imported.

The Add Site Binding displays the following information.

5. Click OK.

The “https” binding is added to the Site Bindings dialog.

6. Click Close.
7. To verify that your secure website is working, do one of the following:

If you selected the default website when you installed Bentley i-model Composition Server for PDF, then
open a web browser and enter:
https://servername/RenditionService/RenditionService.svc

or
If you selected a website other than the default website when you installed Bentley i-model Composition
Server for PDF, then open a web browser and enter:
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https://servername:443/RenditionService/RenditionService.svc

You should get a web page that resembles the one below. The lock icon next to the address field means the
website is secure.

8. Update the ProjectWise Design Integration Server's DMSKRNL.CFG file with the location of the Bentley i-
model Composition Server for PDF IIS Web Service (on page 163). .

9. Modify the WEB.CONFIG file located in the
C:\Program Files (x86)\Bentley\ProjectWise\iCS for PDF\Websvc folder to enable https by
removing the comment lines beginning with “ <!-- ” and ending in “ --> ”, as shown below.
<!-- Uncomment this section if your web site supports HTTPS.
        <endpoint address="" binding="wsHttpBinding" 
bindingConfiguration="MyWsHttpBinding" 
           contract="Bentley.Rendsvc.IRenditionWebService">
          <identity>
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            <dns value="localhost" />
          </identity>
        </endpoint>
        -->

Setting Up the Default User
During Bentley i-model Composition Server for PDF installation, you specified the log in credentials of a default
ProjectWise user. This default user is used by ProjectWise InterPlot Organizer whenever a user creates
renditions from ProjectWise Explorer. Specifically, ProjectWise InterPlot Organizer uses the default user’s
working directory to copy out any managed workspace files and also any ancillary InterPlot files, such as pen
tables and color tables.
You can change the default user at any time either by rerunning the Bentley i-model Composition Server for PDF
configuration wizard, or by changing the default user through Orchestration Framework Administrator.
This same user is entered by default in the ProjectWise Datasource Selection dialog which opens when you
create a job in Bentley i-model Composition Server Administrator. At that point, you can either leave the default
user selected and log in to the selected datasource, or you can enter a different user name and password and log
in.
Perform the following procedure in each datasource you plan to use with Bentley i-model Composition Server
for PDF. The following procedure should also be performed to configure the user(s) who will create and run jobs
in Bentley i-model Composition Server Administrator, if you decide not to use the default user for those jobs.

To Set Up the Default User, and Other Bentley i-model Composition Server
Administrator Users

1. Open ProjectWise Administrator, log in to your datasource, and select Users datasource node.
2. You can either edit the properties of an existing user, or create and configure a new user.

To edit an existing user, right-click a user in the list and select Properties.
or
To create a user, right-click the Users node and select New > User.

3. Set the user name and password for the user as follows:
If you are setting up the default user, give this user the same user name and password as the user you
specified as the default user during Bentley i-model Composition Server for PDF installation.
or
If this user is not the default user, the user name and password can be different from the default user you
specified during Bentley i-model Composition Server for PDF installation.

4. On the Settings tab of the User Properties dialog, do the following:
a. Expand the category. Under When Using ProjectWise Explorer, enter the folder path of the folder you

want to set for this user’s working directory.
b. Expand the General category. Double-click Credential expiration policy. The default setting is Server

default. Double-click Server default. In the dialog that opens, select No expiration and click OK.
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Note: You must do this step for any user (including the default user) who will create and run jobs in
Bentley i-model Composition Server Administrator. You can skip this step if the user is only submitting
renditions jobs through ProjectWise Explorer.

c. Expand the General category. Turn off Use access control.
Note: It is recommended that you do this step for any user (including the default user) who will create
and run jobs in Bentley i-model Composition Server Administrator. This ensures that the user account
under which the job runs always has access to all of the source documents in the input set. You can skip
this step if the user is only submitting renditions jobs through ProjectWise Explorer.

5. Click OK to save the changes and close the User Properties dialog.
6. On the Bentley i-model Composition Server for PDF computer, create the default user's working directory,

and also the working directory for any user who will create and run jobs in Bentley i-model Composition
Server Administrator.
You can do this by opening ProjectWise Explorer on the Bentley i-model Composition Server for PDF
computer, logging in to the datasource as the required user, and then creating the user’s working directory
when prompted.
Tip: Repeat this last step for each default user in each datasource you plan to use with Bentley i-model
Composition Server for PDF. Make sure that each default user is using its own working directory, and is not
sharing the working directory of a default user of another datasource.

Configuring Users to Receive Email Notifications
For users to be able to receive an email notification when a rendition job is complete, the following must be true:
1. During installation of Bentley i-model Composition Server for PDF, you can configure email server

information to be used by the email notification feature. If you do not configure this during installation, you
can rerun the Configuration Wizard to configure it, or you can configure this information in Bentley i-model
Composition Server Administrator.
You can rerun the Configuration Wizard any time after installation by doing the following:
• On Windows Server 2012 or later:

Go to the Start page and type Bentley i-model Composition Server Configuration, or go to Start >
Apps > Bentley and click Bentley i-model Composition Server Configuration.

• On Windows Server 2008:
Select Start > All Programs > Bentley > ProjectWise <version> > Bentley i-model Composition
Server for PDF > Bentley i-model Composition Server Configuration.

2. Any user who runs a rendition job and who wants to receive email notifications first must have a valid email
address specified in their ProjectWise user account’s properties. You can do this in ProjectWise
Administrator by logging into your datasource, selecting the Users node, and then modifying the properties
of the users who plan to create renditions from ProjectWise Explorer.

3. When configuring jobs in Bentley i-model Composition Server Administrator, or when configuring rendition
profiles in ProjectWise Administrator, turn on the option for the user running the job to receive an email
after a rendition job is complete.

4. When creating renditions from ProjectWise Explorer, turn on the option to receive an email after a rendition
job is complete.
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Changing the ProjectWise InterPlot Organizer Printer
During installation, the Bentley i-model Composition Server for PDF configuration wizard adds the default
printer that ProjectWise InterPlot Organizer uses for creating renditions (ProjectWise InterPlot Organizer
already delivers the corresponding driver). This printer is named “ProjectWise Dynamic Composition Server”
and supports various paper sizes. The ProjectWise InterPlot Organizer configuration variable
IP_DCS_RENDITION_PRINTER lets you change the default printer if necessary.
Note: If you remove the printer for any reason, rerunning the configuration wizard will add the printer back
again. Also, uninstalling Bentley i-model Composition Server for PDF will remove the printer.

1. Open the ProjectWise InterPlot Organizer Configure dialog (Start > All Programs > Bentley > ProjectWise
InterPlot Utilities > ProjectWise InterPlot Organizer Configure) with elevated privileges (Run as
administrator).

2. Click Configure.
The Edit Configuration dialog opens.

3. Under Data formats, select Common, then click Edit.
The Edit Common Configuration dialog opens.

4. Locate the IP_DCS_RENDITION_PRINTER configuration variable and change the printer.
5. Click OK on the Edit Common Configuration dialog.
6. Click Close on the Edit Configuration dialog.
7. Click Exit Configure.

Upgrading Job Schedules Created in “ProjectWise Dynamic Composition
Server for PDF”
When the name of the product changed from “ProjectWise Dynamic Composition Server for PDF” to “ Bentley i-
model Composition Server for PDF ”, various internal process names were changed as well. As a result, any job
schedule you created in “ProjectWise Dynamic Composition Server for PDF” will no longer display in the Job
Scheduler window in the current version. (The job definitions themselves will still display in the Bentley iCS
for PDF Browser and can still be run manually.)
To upgrade these older job schedules:
1. Open the Windows Task Scheduler (%windir%\system32\taskschd.msc).
2. Open the Task Properties dialog for each job schedule (task).
3. Select the Actions tab and click the Edit button.
4. In the argument field, change “ProjectWise DCS” to “Bentley iCS”.
5. Click OK to close the Task Properties dialog.
6. Click OK to close the Windows Task Scheduler.
If you have a significant number of job schedules to update, contact Bentley technical support for assistance.
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 10
Configuring the ProjectWise Network

Connecting Individual Clients to the Server
The ProjectWise Network Configuration Settings dialog is primarily used to establish a TCP connection from
the ProjectWise client computer to one or more ProjectWise servers in order to obtain datasource list
information and populate the datasource lists in the ProjectWise applications installed on the client computer.
This dialog is delivered with ProjectWise Explorer and ProjectWise Administrator.

 

 
You can also use the ProjectWise Network Configuration Settings dialog to:
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• Block the client from broadcasting UDP requests.
This shortens the time it takes to retrieve the datasource list by not searching for local datasources, and
instead only retrieving the datasources of the servers you explicitly connect to here.

• Direct the client to a server from which they can get server name resolution information.
Depending on the client's socket version and/or the network configuration, the client may have problems
solving IP addresses by host name. For example, a client may be really slow at solving IP addresses by host
name, or may not be able to solve them at all, or the client may fail to retrieve a file from the storage area, or
file operations may be really slow. To eliminate these problems, you should configure the
[NameResolution] section of a server's DMSKRNL.CFG file, and then point the client to that server.

• Configure auto-login settings for integrated applications (for ProjectWise Explorer only)
The iDesktop Auto-Login tab is used to control whether or not ProjectWise Explorer users will be
automatically logged into a particular integrated application, when that integrated application is opened
from the desktop.

• Enable ProjectWise clients to use IPv6
Note: Information entered on the DNS Services and Datasource Listing tabs of the ProjectWise Network
Configuration Settings dialog only affects the client computer you are working on. The information you enter
gets added to the computer's registry under the key HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node
\Bentley\ProjectWise\10.00\NetworkConfig.

Note: Although ProjectWise permits you to enter a hostname (computer name), an IP address, or a fully-
qualified domain name (hostname + domain name) in the Hostname fields on the DNS Services and
Datasource Listing tabs, it is recommended that you use fully-qualified domain names (FQDN) here. Direct use
of IP addresses should only be reserved for cases when using DNS names is not an option.

Note: When using host names, make sure the host names are configured for reverse lookup.

Note: If ProjectWise Explorer or ProjectWise Administrator is installed on the same computer as your
ProjectWise Design Integration Server, that server's datasources will always display in ProjectWise Explorer and
ProjectWise Administrator, even if you turn on Prevent UDP. However, in the case of ProjectWise Explorer
clients only, if you do turn on Prevent UDP on the Datasource Listing tab, the datasources of the server on the
same computer as ProjectWise Explorer will not display in the datasource list of the ProjectWise Log in dialog
that opens when you launch integrated applications from the desktop, or when you open the ProjectWise Export
Wizard or the ProjectWise Import Wizard. In those cases, you can still log in to the datasource by entering the
servername:datasourcename in the Datasource field.

To Open the ProjectWise Network Configuration Settings Dialog

ProjectWise Explorer: Tools > Network Configuration Settings

Control Panel: ProjectWise Network (or if View by is set to Category, go to Network and Internet >
ProjectWise Network)
Command prompt: control.exe /name Bentley.ProjectWiseNetConfiguration

To Connect to a Server and Get Its List of Datasources (TCP)

1. Open the ProjectWise Network Configuration Settings dialog (on page 171).
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2. Select the Datasource Listing tab.
3. Enter values for Name, Hostname, and Port and click Add.

• Name is just a descriptive name for the ProjectWise server. For example, Production Server
• Hostname is the fully-qualified domain name (FQDN) of the computer where the ProjectWise server is

installed. For example, server.domain.com
• Port is the specified ProjectWise server's listener port number, which is 5800 by default. You only need to

enter a port number here if the listener port on the server has been changed to something other than
5800. Otherwise you can leave it blank.

4. Click Save.
 

 

To Point to the Server from Which the Client Can Get Server Name Resolution
Information

1. Open the ProjectWise Network Configuration Settings dialog (on page 171).
2. Select the DNS Services tab.
3. Enter values for Name, Hostname, and Port and click Add.

• Name is just a descriptive name for the ProjectWise server. For example, Production Server
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• Hostname is the fully-qualified domain name (FQDN) of the computer where the ProjectWise server is
installed. For example, server.domain.com

• Port is the specified ProjectWise server's listener port number, which is 5800 by default. You only need to
enter a port number here if the listener port on the server has been changed to something other than
5800. Otherwise you can leave it blank.

4. Click Save.
 

 

To Prevent the Use of UDP

1. Open the ProjectWise Network Configuration Settings dialog (on page 171).
2. To prevent the use of UDP entirely, turn on Prevent UDP for DNS and Listing on the General tab.
3. To prevent the use of UDP for just server name resolution information, turn on Prevent UDP on the DNS

Services tab.
4. To prevent the use of UDP for just datasource list information, turn on Prevent UDP on the Datasource

Listing tab.
5. Click Save.

Tip: When turning on any of these options, make sure the check box is fully checked, as shown here:
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Publishing Datasource Lists to Multiple Clients
It may not always be practical to use the ProjectWise Network Configuration Settings dialog on every client
computer that needs to connect to the ProjectWise Design Integration Server. For one reason, you might have
too many users that need to connect to the server. Or maybe your users need to connect to multiple ProjectWise
Design Integration Servers. Or maybe your ProjectWise Design Integration Server is on a computer that you do
not want users to have direct access to.
In these situations it is better to set up a ProjectWise Gateway Service on the same subnet as your clients, and
then configure the ProjectWise Gateway Service so that it gets the datasource lists from one or more ProjectWise
Design Integration Servers. By default, the ProjectWise Gateway Service (like the ProjectWise Design Integration
Server) also broadcasts configuration information to clients using UDP. Ultimately this makes configuration
much easier, since you can set up one ProjectWise Gateway Service that connects to as many ProjectWise Design
Integration Servers as you like, and the only configuration you need to perform on your clients' computers is the
installation of the client software itself. Also, users who need to access multiple servers will experience faster
datasource list refreshing when using the ProjectWise Gateway Service instead of the ProjectWise Network
Configuration Settings dialog.
Note: If the ProjectWise Gateway Service you have set up is not on the same subnet as some of your clients, you
can use the ProjectWise Network Configuration Settings dialog (on page 170) on those client computers to
connect to the ProjectWise Gateway Service.
If you have ProjectWise Administrator installed on the same computer as ProjectWise Gateway Service, you can
also use the New Datasource Wizard in ProjectWise Administrator to create a link to a datasource located on
another server. Afterwards, ProjectWise Explorer clients on the same subnet as the ProjectWise Gateway Service
will automatically see the linked datasource the next time they refresh their datasource list in ProjectWise
Explorer.
Note: Though the following procedure is typically performed on ProjectWise Gateway Service computers, you
can also use it on a ProjectWise Design Integration Server computer, to create a link to a datasource on another
ProjectWise Design Integration Server.

To Set Up a Gateway Service to Publish Datasource Lists from One or More
Servers

1. Install ProjectWise Gateway Service on a computer that your ProjectWise clients can access (a computer on
the same subnet, if possible).

2. In any text editor, open the ProjectWise Gateway Service's dmskrnl.cfg file located in
the ...\ProjectWise\Bin directory.
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3. Find and make sure the lines Databases=db0 is uncommented.
To uncomment a line, remove the semicolon from the beginning of the line.

4. Find and make sure the line ConnectionSrv=1 is also uncommented.
5. Below the line ConnectionSrv=1 you will see several commented out settings that enable datasource list

publishing. To enable publishing of just one server's datasource list, configure the following section of lines:
Databases=db0
[db0]
DsServer=1
Server=INTSERVER

Though it is actually further up in the dmskrnl.cfg file, the line Databases=db0 is shown in this location to
give context.
The line Server= is where you specify the name or IP address of the ProjectWise Design Integration Server
computer. In this example, we are assuming the ProjectWise Design Integration Server computer name is
INTSERVER.

6. For each additional server you want to publish, add another entry to the Databases= line (db1, db2, and so
on), and then add a corresponding server section below it. For example, the following section enables the
publishing of three ProjectWise Design Integration Server's datasource lists:
Databases=db0,db1,db2
[db0]
DsServer=1
Server=INTSERVER
[db1]
DsServer=1
Server=INTSERVER2
[db2]
DsServer=1
Server=INTSERVER3

To Create a Link to a Datasource on Another Server

1. In ProjectWise Administrator, right-click the Datasources node and select New > Datasource.
2. When the New Datasource Wizard opens, click Next.
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3. When the Choosing Datasource Type page opens, select the option, A link to a datasource that is located on

another server, then click Next.
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4. When the Specifying the linked server page opens, type the name of the server that publishes the datasource

to which you want to link, or click Browse to select the server, then click Next.
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5. When the Selecting the linked datasource page opens, select a ProjectWise datasource from the list, and

optionally, type a display name in the field below the Datasource name. If no display name is set, then users
will see this internal name, plus the name of the computer on which the datasource's ProjectWise server is
located (for example: <computername>:<datasourcename>). If a display name is specified, users will see only
the display name. When finished, click Next.
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6. When the Finishing New Datasource Wizard page opens, click Finish.

The New Datasource Wizard closes and the selected remote datasource is now listed in ProjectWise
Administrator. The icon for this datasource has an arrow on it, signifying that this is just a link pointing to a
datasource that is actually located on another server.

Setting Up Gateway Information to Redirect Client Requests
By configuring the [Gateway] section the dmskrnl.cfg file of a ProjectWise Design Integration Server or
ProjectWise Gateway Service, you can instruct clients listening to or connected to that server, to redirect their
requests normally bound for one server to another server instead. When requests to one server are redirected
through another server or servers, the requests are said to be routed, and the destination of the request is
referred to as the routed server.
For example, you might want to configure a ProjectWise Gateway Service's [Gateway] section so that clients
listening to or connected to that server send their requests to it, instead of directly to the ProjectWise Design
Integration Server. (In this example you would also configure the ProjectWise Gateway Service's [Routing]
section to forward those requests to the ProjectWise Design Integration Server (on page 182)). This way you
can set up your network so that no clients have any direct contact with the ProjectWise Design Integration
Server. The following simple diagram illustrates this example:
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Gateway information is echoed to all clients listening to or connected to that ProjectWise Design Integration
Server or ProjectWise Gateway Service, so that those clients automatically know where to send their requests. In
this way you can change the way information travels between clients and servers, without changing the
configuration on client computers. Only those clients explicitly allowed (in the [Gateway] section) to be
redirected will have their requests redirected; clients not listed, or those explicitly denied (also in the
[Gateway] section), will not have their requests redirected when connected to or listening to this particular
server.
Note: Currently, when a client is on a different subnet than the ProjectWise Design Integration Server or
ProjectWise Gateway Service you want them to obtain Gateway information from, that client must add the
server's information to both the DNS Services and Datasource Listing tabs in the ProjectWise Network
Configuration Settings dialog (on page 171).
A sample, commented out [Gateway] section exists in each dmskrnl.cfg file by default, with general
instructions of usage and syntax. It is recommended that you make a copy of the delivered examples so you can
use the original as a reference. The following is the entire [Gateway] section as delivered in any dmskrnl.cfg
file:
;[Gateway]
;This section provides PW Explorer clients information about where to direct
;requests when a Routing configuration is desired. All DMS communication will
;be directed to the Gateway server rather then the Routed server. This information
;is sent to the PW Explorer client, so it is critical that the Gateway Server hostname
;be a hostname that the PW Explorer can route to, for example the external host name
;configured in the NAT server
;Format
;Routed Server = Gateway Server(typically the server on which this config file appears)
;Integration Server host name = Gateway Service host name

;Examples
;server1 = server2

Tip: There may be cases in which you do not need to specify clients to allow, however it is still good practice to
do so. For example, at the time of configuration, the clients you are allowing may happen to be the only clients
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connected to the server. In that case it would not be necessary to explicitly allow them. However, in the future
you might set up other clients that connect to this server, and you may not want those clients' file requests to be
redirected. Or maybe there are newly set up clients, connected to the server, which you do not know about. If
you have already configured the Allow portion to allow certain clients, the new clients will automatically be
denied.

To Configure the [Gateway] Section to Redirect Client Requests

1. Open the dmskrnl.cfg file on the server (ProjectWise Design Integration Server or ProjectWise Gateway
Service) to which clients are connected or listening.

2. Uncomment the line ;[Gateway] by removing the semicolon (;) from the beginning of the line.
3. Below that, add a line that specifies the server that would normally be the recipient of client requests, and the

server to which those client requests will now be directed.
For example:
[Gateway]
INTSERVER=PGS

This example tells all clients connected or listening to this particular server that any requests they would
normally send to the server called INTSERVER, to send them to the ProjectWise Gateway Service called PGS
instead.

4. If you only want specific clients to have their requests redirected, append a list of those clients to the line you
added in the previous step.
For example:
[Gateway]
INTSERVER=PGS[Allow(userA,userB,userC)]

The Allow list in this example says that regardless of the clients connected to or listening to this server, only
clients userA, userB, and userC will have their requests to INTSERVER redirected to PGS.
Note: The clients you specify in the Allow list can be specific computer names, IP addresses, or a range of IP
addresses. IP addresses can include wildcards. If you want to allow all clients with the exception of specific
clients, add a Deny list just after the Allow list. For example: [ALLOW(*.*.*.*),DENY(62.236.163.*,
62.236.164.*)]

5. Add additional lines to redirect requests bound for other servers through this server or to another server.
For example, maybe your ProjectWise network consists of one ProjectWise Gateway Service and multiple
ProjectWise Design Integration Servers, and you want all client requests to those ProjectWise Design
Integration Servers to be sent to the ProjectWise Gateway Service instead. In that case, you would configure
the [Gateway] section like this:
[Gateway]
INTSERVER1=PGS
INTSERVER2=PGS
INTSERVER3=PGS

For simplicity, none of the lines in the example above use an Allow list, but as needed you can append an
Allow list (or an Allow/Deny list) for each line you add to this section.

6. On the server now receiving redirected requests, you need to configure the Routing section in that server's
dmskrnl.cfg file (on page 182) so that server can forward these requests on to the appropriate server.
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Setting Up Routing Information to Forward Redirected Client Requests
After you configure a server's [Gateway] section to redirect client requests to another server, you must then go
to the server now receiving the requests (often the same server, as in many ProjectWise Gateway Service
configurations) and configure the [Routing] section in its dmskrnl.cfg file so that that server will know
where to forward these requests. Most often you will configure the server now receiving the requests (referred
to as the gateway server) to forward requests to the routed server (that is, the final destination of the request). In
some cases, however, you may find it necessary to forward requests to another gateway server, which will then
forward the request to its destination. This subtle difference affects the way you configure the [Routing]
section, as you will see below.
A sample, commented out [Routing] section exists in each dmskrnl.cfg file by default, with general
instructions of usage and syntax. It is recommended that you make a copy of the delivered examples so you can
use the original as a reference. The following is the entire [Routing] section as delivered in any dmskrnl.cfg
file:
;[Routing]
;This section is used by the Gateway server that this config file is installed on
;to determine where to route requests that have been sent to it on behalf of a Routed 
Server
;If there are multiple hops necessary to get to the Routed server, this will direct 
this server
;to forward to the next hop on a particular port, otherwise only the information about 
what
;port number the Routed server is listening on is necessary
;Format
;Routed Server = Port Number,Next Gateway Server

;Examples (shows two different scenarios)
;server1=5800,server3
;server1=5800

Note: The servers specified on both sides of the = character can be represented by the server's name or IP
address.

Note: The port number specified in these examples must match the port number set as the listening port in the
dmskrnl.cfg file of the server you are forwarding the request to. 5800 is the port used in these examples
because it is the default listening port on any ProjectWise Design Integration Server, ProjectWise Gateway
Service, or ProjectWise Caching Server.

To Configure a Server to Forward Requests

1. Open the dmskrnl.cfg file on the server that is receiving redirected client requests.
2. Uncomment the line ;[Routing] by removing the semicolon (;) from the beginning of the line.
3. To forward requests directly to the routed server (that is, to forward a request to its final destination), use

the following example:
[Routing]
INTSERVER1=5800
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This example tells the server that if it receives any requests bound for the server called INTSERVER1, to go
ahead and forward it to INTSERVER1 through port 5800.

4. To forward requests to another gateway server (that is, to a server which will also forward the request) on
its way to the routed server, use the following example:
[Routing]
INTSERVER2=5800,PGS2

This second example tells the server that if it receives any requests bound for the server called INTSERVER2,
to forward it to the ProjectWise Gateway Service called PGS2 through port 5800. Your next step would be to
open PGS2's dmskrnl.cfg file and configure its [Routing] section to forward requests to the appropriate
server.

5. Add additional lines for each routed server this server is forwarding requests to.

Configuring Server-to-Server Routing
Server-to-server routing lets you set up a ProjectWise Gateway Service in a DMZ in order to route connections
from a ProjectWise Design Integration Server to a ProjectWise Caching Server, in cases where the ProjectWise
Design Integration Server cannot directly connect to the ProjectWise Caching Server. For example, if the
ProjectWise Caching Server is hosted behind a firewall of another organization.

 

 
To configure this feature, routing information is needed in the dmskrnl.cfg file of the ProjectWise Design
Integration Server, the ProjectWise Caching Server, and the connecting ProjectWise Gateway Service.
For the configuration examples below, assume the following host names for these servers:
PWIS = ProjectWise Design Integration Server
PWGS = ProjectWise Gateway Service
PWCS = ProjectWise Caching Server
When a client requests a file from a ProjectWise Caching Server, the Caching Server uses the ProjectWise Design
Integration Server's public key to validate the request and verify the user's access. In a standard configuration,
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the Caching Server requests the ProjectWise Design Integration Server's public key directly, but in a routed
scenario the Caching Server may not be able to connect to the ProjectWise Design Integration Server. If this is
the case, you must manually specify the ProjectWise Design Integration Server's public key in the
[FileTokenPublicKeys] section of the Caching Server's dmskrnl.cfg file.

To Set Up a Standard Server-to-Server Routing Configuration

1. In the dmskrnl.cfg file of the ProjectWise Design Integration Server (PWIS), add the following information:
[ServerGateway]
PWCS=PWGS

[Routing]
PWGS=5800

2. In the dmskrnl.cfg file of the ProjectWise Gateway Service (PWGS), add the following information:
[Gateway]
PWIS=PWGS
PWCS=PWGS

[Routing]
PWIS=5800
PWCS=5800

3. In the dmskrnl.cfg file of the ProjectWise Caching Server (PWCS), add the following information:
[ServerGateway]
PWIS=PWGS

[Routing]
PWGS=5800

To Set Up a Unidirectional Server-to-Server Routing Configuration

1. In the dmskrnl.cfg file of the ProjectWise Design Integration Server (PWIS), add the following information:
[ServerGateway]
PWCS=PWGS

[Routing]
PWGS=5800

2. In the dmskrnl.cfg file of the ProjectWise Gateway Service (PWGS), add the following information:
[Gateway]
PWCS=PWGS

[Routing]
PWCS=5800

3. In the dmskrnl.cfg file of the ProjectWise Caching Server (PWCS), add the ProjectWise Design Integration
Server's public key (note the key below is just an example):
[FileTokenPublicKeys]
PWIS=BgIAAACkAABSU0ExAAQAAAEAAQBb6A14vA1opzUqBH0PFdmYNN1+TzfOyWLumgvuv8FvYgi8eqwmVKW
8gReJBWx7Ogr
+Wj0psFMNzUZCqBFuYxQTtqxBL5+udhTUz74QbttqVAfolhwkDuVTRfVGblDO1MKLDUnHpavttFr6UoC71Ox
8g79kKxa3AzPZxtbt2XEWsA==

Your ProjectWise Design Integration Server's public key can be found by right-clicking the host name of the
ProjectWise Design Integration Server in ProjectWise Administrator and selecting Properties. In the
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Properties dialog, select the Encryption tab. You can then copy the key found on this tab and paste it into the
[FileTokenPublicKeys] section above as shown.

 

 

Broadcasting and Listening Ports Used by Servers
When ProjectWise Explorer clients use UDP to broadcast requests to ProjectWise servers on the network, the
default port open on the ProjectWise server to receive and respond to these requests is 5799. This is referred to
as the broadcast port. When clients use the ProjectWise Network Configuration Settings dialog to establish a
TCP connection to the server, the default port that the server listens for client connections on is port 5800. This
is referred to as the listener port. The following sections are included in a ProjectWise server's DMSKRNL.CFG file
for configuring broadcasting and listening settings:
; ------------------------------------------------------------ 
; Section defines broadcasting settings (UDP connections)
; ------------------------------------------------------------
[Broadcast]
; Port number for broadcasting list of datasources
Port=5799

; Name of service in etc\services file to use if port is not specified
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;Name=dmsbdr
...

; ------------------------------------------------------------
; Section defines listening settings (TCP connections)
; ------------------------------------------------------------
[Listener]
; Port number for incoming TCP connections
Port=5800
; Name of service in etc\services file to use if port is not specified
;Name=dms
...

You can leave the defaults as is or change them as necessary. If you change the broadcasting (UDP) port on the
server, no configuration on your client computers is necessary. If you change the listening (TCP) port on the
server, you will have to also change the port specified on your clients' ProjectWise Network Configuration
Settings dialog.
Note: If the TCP listening port is changed from the default value of 5800, and you have UDP datasource discovery
disabled, you must create an entry for that server in the DNS Services tab of the ProjectWise Network
Configuration Settings dialog, on any client computer that will access that server.

To Change the Default Ports Used by the Server

1. Open the dmskrnl.cfg file (...\ProjectWise\bin) in a text editor.
2. To change the default broadcasting port, find [Broadcast] and below that line, change Port=5799 to

Port=new broadcasting port #.
3. To change the default listening port, find [Listener] and below that line, change Port=5800 to Port=new

listening port #.
4. When finished, save and close the dmskrnl.cfg file and restart the server in the Services window.

ProjectWise Server Name Resolution
Depending on a ProjectWise Explorer client's socket version and/or the network configuration, the client may
have problems solving IP addresses by host name. For example, a client may be really slow at solving IP
addresses by host name, or not able to solve it at all, or the client may fail to retrieve a file from the storage area,
or file operations may be really slow. To eliminate these problems, you can configure the [NameResolution]
section of a server's dmskrnl.cfg file, and then point the client to that server through the ProjectWise Network
Configuration Settings dialog (on page 172).
For each NameResolution entry, the value name is the IP address (recommended) or host name. The value is a
comma separated host name list that can be extended with allow and deny masks if required. In some
installations the same host name can be bound to different IP addresses depending on the client who is
requesting the internal DNS information.
For example, we could have a server with a host name serverA having an internal IP address of
62.236.163.41. The internal IP address will be used by the clients located in the local networks 62.236.136.*
or 62.236.164.*. This address cannot be used by clients located outside the local networks. There may be a
firewall machine that has an internal IP address of 62.236.136.98 (accessible by clients located in local
networks) and an IP address outside (accessible by clients that are not located in the local network) of
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75.129.120.98. Then there is port to port mapping configured, so that requests sent to 75.129.120.98 to
port 5800 are transferred to 62.236.163.41 to port 5800.
In this scenario host name serverA must be bound to 62.236.163.41 when requests are sent by
62.236.136.* or 62.236.164.* clients. But for all other clients the same host name serverA must be bound
to 75.129.120.98.
Let us also include in this scenario a server with the host name serverB with an IP address of 65.230.152.1
that is accessible by all clients. Also in this example we have serverC and we let the server solve the IP address
for it on runtime when the configuration file is loaded.
This case can be solved by adding two entries for serverA in the [NameResolution] section, both having
allow/deny masks and one entry for serverB and one for serverC:
[NameResolution]
62.236.163.41=serverA.domain.com[ALLOW(62.236.163.*,62.236.164.*)]
75.129.120.98=serverA.domain.com[ALLOW(*.*.*.*),DENY(62.236.163.*,62.236.164.*)]
65.230.152.1=serverB.domain.com
serverC=serverC.domain.com

All the [NameResolution] section entries that do not have allow/deny masks can also be used by the server
itself to solve the addresses of routed servers and datasource server addresses, and so on.
In this example serverB and serverC entries would be echoed to clients and could be used by the server itself,
but entries for serverA are only echoed to the clients and not used by the server itself.

Setting Up ProjectWise to Use IPv6
ProjectWise fully supports Internet Protocol Version 6 (IPv6).
Caution: Before you begin, it is highly recommended that you contact Bentley Professional Services to assist you
in setting up ProjectWise on IPv6.
To run ProjectWise on IPv6:
• You must have a fully-configured IPv6 DNS server.
• All ProjectWise clients and servers must be part of the IPv6 network.
• All ProjectWise clients and servers must be configured to use IPv6, by enabling the IPv6 settings on the

ProjectWise Network Configuration Settings dialog.
• All ProjectWise servers must be configured to use IPv6, by enabling the IPv6 settings in the DMSKRNL.CFG

file.
Note: For situations in which you need to enter a datasource name using both the IP address and the datasource
name (IP:datasource) — for example, when logging in through ProjectWise Explorer or integrated
applications — when using IPv6 you need to enter the IP address inside square brackets [ ]. For example:
[2001:ffff:ffff::1]:datasource

The same is true, when using IPv6, for situations in which you need to enter a server address using the IP
address followed by a port number (IP:port). For example:
[2001:ffff:ffff::1]:port
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To Enable ProjectWise Clients to Use IPv6

Do these steps on each of the ProjectWise Explorer, ProjectWise Administrator, and ProjectWise Web Server
computers in your IPv6 network.
1. Open the ProjectWise Network Configuration Settings dialog (on page 171).
2. On the General tab, turn on IPv6 Enabled and IPv6 Preferred.
3. Click OK.

To Enable ProjectWise Servers to Use IPv6

1. Open the dmskrnl.cfg file (...\ProjectWise\bin) on the server computer you are configuring.
2. Find ;IPV6Enabled=0. Uncomment the line and change the value to 1. For example:

IPV6Enabled=1
3. Find ;IPV6Preferred=0. Uncomment the line and change the value to 1. For example:

IPV6Preferred=1
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 11
Bentley Web Services Gateway Configuration

Bentley Web Services Gateway enables any type of service, client, or mobile application, running on any platform
to easily access data and files from an extensible list of Bentley enterprise service repositories.
When used with the ProjectWise Plug-in, Bentley Web Services Gateway is used to provide mobile users with a
list of ProjectWise datasources that they can connect to.
Note: No license is required for Bentley Web Services Gateway itself, however a license is required for each user
who connects to a ProjectWise datasource through Bentley Web Services Gateway.

Before You Install and Deploy Bentley Web Services Gateway
Note: See the ProjectWise readme (readme_ProjectWise.chm) for a list of supported operating systems and
other system requirements.

1. Make sure the latest Windows updates have been installed.
2. Be an administrator of the computer.
3. In Server Manager, make sure the Web Server (IIS) role is installed along with the following role services:

• Web Server
• Performance

• Dynamic Content Compression
• Security

• Windows Authentication
• Application Development

• ASP.NET
• .NET Extensibility
• ISAPI Extensions
• ISAPI Filters

4. Make sure .NET Framework 4.6.1 or later is installed.
See Installing Required Windows Server Features (on page 267).

5. In Internet Information Services (IIS) Manager, configure the following Authentication settings for the
website you plan to deploy Bentley Web Services Gateway to:
a. In the Connections pane, under your server > Sites, select your website.
b. On the Home page (middle), under IIS, double-click the Authentication feature.
c. Set Anonymous Authentication to Enabled.
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d. Set Basic Authentication to Disabled.
e. Set Windows Authentication to Disabled.

6. In Internet Information Services (IIS) Manager, enable SSL for the website you plan to deploy Bentley Web
Services Gateway to:
a. In the Connections pane, under your server > Sites, right-click your website and select Edit Bindings.
b. In the Site Bindings dialog, click Add.
c. In the Add Site Bindings dialog, change Type to https, select an SSL certificate from the list, and click OK.
d. Click Close to close the Add Site Binding dialog.
e. Add the SSL port 443 to the Windows Firewall exception list on this computer.

Tip: Contact your IT department if you need help obtaining an official SSL certificate. To create a self-signed
certificate, see the following Microsoft topic: http://technet.microsoft.com/en-us/library/cc753127(v=ws.
10).aspx

7. Install ProjectWise Explorer (on page 130).
This is a prerequisite of the ProjectWise Plug-in for Bentley Web Services Gateway. You will not be able to
install the plug-in if ProjectWise Explorer is not installed.

8. Configure the ProjectWise network in order to provide a list of datasources that your users can connect to
through Bentley Web Services Gateway.
a. Open the ProjectWise Network Configuration Settings dialog (Tools > Network Configuration

Settings, in ProjectWise Explorer).
b. On the General tab, turn on Prevent UDP for DNS and Listing (make sure there is a check mark in the

check box).
c. On the Datasource Listing tab:

• In the Name field, enter a descriptive name for the ProjectWise server you are connecting to. For
example, Main Production Server

• In the Hostname field, enter the fully-qualified domain name (FQDN) of the computer on which the
ProjectWise server you want to connect to is installed.

• If the ProjectWise server's listener port is set to the default (5800), then you can leave the Port field
empty. If the ProjectWise server's listener port is set to something other than 5800, then you must
enter the server's listener port in the Port field.

• Click Add.
• At the bottom of the tab, turn on Prevent UDP (make sure there is a check mark in the check box).

d. On the DNS Services tab, repeat the same steps you just performed on the Datasource Listing tab.
e. Click Save, then Close.

You are done configuring the ProjectWise network on this computer. Open ProjectWise Explorer and verify
that you can see and log into the datasources you expect to see, based on how you configured the ProjectWise
network.

To Install Bentley Web Services Gateway
1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to Bentley Web Services Gateway.
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3. When the Setup Wizard opens, click Next.

4. When the License Agreement page opens, read and accept the agreement, then click Next.
5. When the Destination Folder page opens, accept the default installation location or click Change to change

it, then click Next.
The default installation location is
C:\Program Files\Bentley\Bentley Web Services Gateway 02.06\.

6. When the Ready to Install page opens, click Install.
Your next steps are to:
• Install the ProjectWise Plug-in for Bentley Web Services Gateway (requires ProjectWise Explorer)
• Deploy Bentley Web Services Gateway to an IIS website
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To Install the ProjectWise Plug-in for Bentley Web Services Gateway
1. Make sure ProjectWise Explorer is already installed.
2. On the ProjectWise Server Setups master installer, click Install next to Bentley WSG ProjectWise Plugin.

3. When the Setup Wizard opens, click Next.

4. When the License Agreement page opens, read and accept the agreement, then click Next.
5. When the Ready to Install page opens, click Install.
6. When installation is complete, click Finish.
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To Deploy Bentley Web Services Gateway
1. Go to the Start page and in the Bentley group select Deploy Web Services Gateway .
2. When the Deployment Wizard opens, select Deploy Web Services Gateway and click Next.

3. On the Web Site page, select the IIS website you want to deploy Bentley Web Services Gateway to and click
Next.
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4. On the Virtual Directory page, enter the name of the directory you want to create for Bentley Web Services
Gateway under the selected IIS website.
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The name is set to 'ws' by default. You can accept the default or change it if needed. When the ws is used,
users connecting to this Bentley Web Services Gateway website from a mobile app only need to specify the
fully-qualified domain name of the computer on which Bentley Web Services Gateway is installed (for
example, servername.domain.com). If you change the default virtual directory name from ws to anything
else, then ProjectWise Explorer Mobile app users will have to specify the fully-qualified domain name of the
computer plus the virtual directory name, when entering the address (for example,
servername.domain.com/virtualdirectoryname).

5. (Optional) On the Configure URL redirection page, turn on Use URL redirection and click Next.
You can skip this page if URL redirection is not needed.
URL Rewrite must be installed to be able to turn on Use URL redirection. You can download URL Rewrite
from here: https://www.iis.net/downloads/microsoft/url-rewrite
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6. On the Working Directory page:
a. Accept the default working directory (C:\ProgramData\Bentley\WSG\WorkDir\02.06) or click

Browse to select a different folder.
b. If the application connecting to this website requires CORS, then in the second field enter the URL(s) of

trusted origins that will be allowed to make cross-origin requests to this website.
Important: ProjectWise Share requires CORS configuration.

c. Click Next.
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Notes about the working directory:
• The working directory is used by Bentley Web Services Gateway to store files that are being transferred

between the main ProjectWise server and the app making the request.
• Make sure the folder you specify is not already being used by any other deployment.
• The working directory must be located on the Bentley Web Services Gateway computer.
• The working directory cannot be located under the website's home directory (for example, it cannot be

here: C:\inetpub\wwwroot)
• Make sure the local system account has Write permission to the specified folder.
• UNC paths (\\servername\sharename) are not supported.

7. On the Plug-ins page, select the ProjectWise plug-in and click Next.

Bentley Web Services Gateway Configuration
To Deploy Bentley Web Services Gateway

ProjectWise Design Integration 197 Implementation Guide



8. Configure ProjectWise plugin settings and click Deploy.
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9. When deployment is complete, click Finish.
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To Test Your Deployment By Logging In Through Bentley Web Services
Gateway
After you have installed and deployed Bentley Web Services Gateway, use these steps to confirm that you can log
in to your datasources through Bentley Web Services Gateway.
Note: Bentley Web Services Gateway supports logging in with all ProjectWise account types, namely: logical
accounts, Windows accounts, and Bentley IMS accounts.

1. Enter your website’s address into a web browser. For example:
From the local computer:
https://localhost/ws

or
From another computer:
https://maestrovm.bentley.com/ws

Where ws is the name you gave to the virtual directory when you deployed Bentley Web Services Gateway
(To Deploy Bentley Web Services Gateway (on page 193)).
The following page displays:
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2. Double-click Web API Explorer.
The WSG Explorer opens.

3. On the Navigation tree page, expand Repositories.
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This displays the list of datasources that have been made available by your configuration of the ProjectWise
network on this computer.

4. Expand one of the datasources and log in when prompted.
If your credentials are accepted, you have successfully configured Bentley Web Services Gateway and can let
your users begin using it to access any of the available ProjectWise datasources.
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 12
On-Premise Configuration for ProjectWise

Connection Services

ProjectWise Connection Services are a collection of Bentley Cloud Services that work with ProjectWise
CONNECT Edition to improve collaboration with distributed organizations through the use of ProjectWise cloud
projects.
This section discusses the configuration of the on-premise components delivered with ProjectWise for use with
the following ProjectWise Connection Services:
• ProjectWise Deliverables Management connector for ProjectWise Explorer - included in the ProjectWise

Explorer installer (ProjectWise Client Setups download)
ProjectWise Deliverables Management connector for ProjectWise Explorer is the on-premise component for
ProjectWise Deliverables Management.

• ProjectWise Analytics Data Upload Service - included in the ProjectWise Explorer installer (ProjectWise
Client Setups download)
ProjectWise Analytics Data Upload Service is the on-premise component for ProjectWise Project
Performance Dashboards.

• ProjectWise Sync Service - included in the ProjectWise Server Setups master installer (ProjectWise Server
Setups download)
ProjectWise Sync Service is the on-premise component for ProjectWise Project Synchronization.

Register a ProjectWise Cloud Project
Note: This task assumes that your organization is already registered with Bentley and that you have already
created a Bentley CONNECTIONS Profile for yourself.
The first step in using any of the ProjectWise Connection Services is to register (create) a ProjectWise cloud
project for your organization. You can register as many projects as you need.
Note: To register a project you must have Administrator or Co-administrator privileges associated with your
Bentley CONNECTIONS Profile.

1. Go to the CONNECTION Center (https://connect.bentley.com) and sign in with your Bentley Cloud Services
credentials.
Note: You can also click the Personal Portal tab in ProjectWise Explorer.

2. In the CONNECTION Center, under ProjectWise Projects, click + (Register a new project).

ProjectWise Design Integration 203 Implementation Guide

HTTPS://CONNECT.BENTLEY.COM/


3. Fill out the Register a Project form as needed. Required fields are marked with an asterisk (“*”).
Number * The unique project code or ID number that is officially used in your organization for

internal tracking purposes. For example, DMO-063 VP 778.
Name * The common name for the project within your organization. For example, I-565

Interchange at County Line Road.
Asset industry * The asset industry this project belongs to.

An asset industry is a group of like organizations with a common business function
centered on a like set of infrastructure assets. For example, Electric Utility.

Asset type * The type of asset this project will focus on.
An asset type is a set of related assets. For example, the Asset Class Electric Network
is comprised of the following assets: Distribution Network, Substation, and
Transmission Network.

Allow External
Team Members

Allows the invitation process to include team members from external organizations.

Use Location Displays a Location field, where you can enter the name of the project location. For
example, city/state/country.

Use Latitude/
Longitude

Displays the Latitude and Longitude fields, where you can enter the specific
coordinates of where the project is located.

Time Zone The time zone of the project location.
Status The state of the project.

Active means the project is open for participation. Inactive means the project is
closed for participation.

4. Click Save.

Associate a Work Area with a ProjectWise Cloud Project
Once you register a ProjectWise cloud project (on page 203), you can associate it to a new or existing work area
from ProjectWise Explorer. This procedure shows how you can make the association from an existing work area.
Note that you can also make the association while you are creating a work area or upgrading a folder to a work
area in the Work Area Creation Wizard.
1. Open ProjectWise Explorer and log in to your datasource.
2. Right-click a work area and select Properties.
3. In the Work Area Properties dialog, select the ProjectWise Project tab.
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4. Click Associate.
The Select Project to Associate dialog opens.
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5. Select a ProjectWise cloud project from the list and click Assign.
Note: If you need to create and associate a new project:
1. Click Register Project.
2. In the Register a project web page that opens, fill out the form and click Save.
3. Back in the Select Project to Associate dialog, click Refresh to make your new project appear in the list.
4. Select the new project and click Assign.
To register a project you must have Administrator or Co-administrator privileges associated with your
Bentley CONNECTIONS Profile.

6. Click Apply in the Work Area Properties dialog.

On-Premise Configuration for ProjectWise Connection Services
Associate a Work Area with a ProjectWise Cloud Project

ProjectWise Design Integration 206 Implementation Guide



This work area is now associated with the selected ProjectWise cloud project.
When a work area is associated to a ProjectWise cloud project and you select the work area, or any folder in it, a
ProjectWise Project Portal tab displays in the preview pane. The ProjectWise Project Portal provides a
window to the ProjectWise cloud project (the same as opening a browser and going to the CONNECTION Center
(https://connect.bentley.com/) and selecting your ProjectWise cloud project), and shows the available cloud
services you can use with this project.
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ProjectWise Deliverables Management Configuration
ProjectWise Deliverables Management provides secure deliverables exchange between business entities. It
ensures that deliverables package information can be trusted, speeds up preparation process, and makes it easy
to identify and resolve urgent issues.
Key benefits:
• Provides status visibility of all incoming and outgoing deliverables, and RFIs.
• Ensures that only authorized contractors and subcontractors have access to deliverables and RFIs.
• Enables recipients to easily acknowledge, download, review, and respond to the documents through the web

portal.
• Makes the deliverables review process easy to track through email notifications and the built-in audit trail.

User Interfaces for Sending and Receiving Deliverables

ProjectWise Deliverables Management has two interfaces that users can use to send and receive deliverables:
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• the ProjectWise Deliverables Management portal
• the ProjectWise Deliverables Management connector for ProjectWise Explorer
The ProjectWise Deliverables Management portal is accessible from a web browser and does not need any
additional software installed in order to use it. The administrator simply registers a ProjectWise cloud project
and then turns on ProjectWise Deliverables Management in that project. If you have ProjectWise Explorer
installed, you can also access the same ProjectWise Deliverables Management portal through the ProjectWise
Project Portal tab (Preview Pane) which is active whenever you select a work area that is associated to a
ProjectWise cloud project.
The ProjectWise Deliverables Management connector for ProjectWise Explorer is a plug-in that you install on
top of ProjectWise Explorer. Installing the connector adds a Deliverables Management node within any work
area that is associated to a ProjectWise cloud project which has ProjectWise Deliverables Management turned
on.
You can send and receive deliverables in either interface. The main difference is that the ProjectWise
Deliverables Management connector for ProjectWise Explorer lets ProjectWise users create deliverable
packages directly from ProjectWise Explorer that contain ProjectWise documents, whereas the ProjectWise
Deliverables Management portal can be used by non-ProjectWise users and lets you create deliverable packages
from content uploaded from the local file system.

Enabling ProjectWise Deliverables Management

Multiple organizations can participate in the deliverables exchange process. Each organization can use
ProjectWise Deliverables Management with or without ProjectWise.
Before any deliverables can be exchanged, all organizations need to perform these basic steps:

Set Up Bentley Accounts and Register Projects
1. Each organization must be registered with Bentley Cloud Services and each user who plans to participate

must have a Bentley CONNECTIONS Profile.
2. An administrator from each organization needs to register a ProjectWise cloud project (on page 203) for

their organization.

Configure the ProjectWise Deliverables Management Portal for Your Organization
1. Each organization must turn on ProjectWise Deliverables Management in their ProjectWise cloud project (on

page 210).
2. The ProjectWise Deliverables Management portal administrator (initially, this is the person who turned on

ProjectWise Deliverables Management in the ProjectWise cloud project) from each organization needs to add
people from their organization, and invite people from other organizations, to be participants of their project.

If your organization does not use ProjectWise, your basic configuration is done and you can begin using the
ProjectWise Deliverables Management portal.
If your organization does use ProjectWise and wants to use it with ProjectWise Deliverables Management, then
continue with the next steps.

Integrate ProjectWise Deliverables Management with ProjectWise
1. For each work area in ProjectWise from which you want to be able send and receive packages, associate the

work area with your organization's ProjectWise cloud project (on page 204).
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2. Have each ProjectWise Explorer user who wants to send and receive packages install the ProjectWise
Deliverables Management connector for ProjectWise Explorer.

3. ProjectWise Explorer V8i (SELECTseries 4) users will also need to download and install the CONNECTION
Client from the Bentley Software Fulfillment Center. (ProjectWise Explorer CONNECT Edition and later
already delivers the CONNECTION Client.)
Installing the ProjectWise Deliverables Management connector for ProjectWise Explorer adds a Deliverables
Management node under every work area in ProjectWise Explorer that is associated to a ProjectWise cloud
project that has ProjectWise Deliverables Management turned on (on page 210). The Deliverables
Management node is the location in the work area from which you will send and receive deliverables.
Note: The Deliverables Management node will not display if you are not signed in with the CONNECTION
Client.

Note: Currently there is no path for upgrading or converting a Transmittals Management-enabled work area
(Bentley Transmittal Services) to a Deliverables Management-enabled work area. However, you can use
Deliverables Management and Transmittals Management in the same work area.

Turn On ProjectWise Deliverables Management in Your Project

1. Go to the ProjectWise cloud project portal, either from a web browser or from ProjectWise Explorer (Preview
Pane > ProjectWise Project Portal tab).
Tip: To access the ProjectWise cloud project portal from ProjectWise Explorer you must first associate a work
area to a ProjectWise cloud project (on page 204).

2. Click the Deliverables Management tile.

3. Click Turn on.
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You can now begin using the ProjectWise Deliverables Management portal in this project. Also, ProjectWise
Explorer users who also have the ProjectWise Deliverables Management connector for ProjectWise Explorer
installed can begin using it with this project.

ProjectWise Project Performance Dashboards Configuration
ProjectWise Project Performance Dashboards helps managers track project status and progress by collecting
statistical information about documents, and also deliverable packages created using either ProjectWise
Deliverables Management or Bentley Transmittal Services.
ProjectWise Analytics Data Upload Service is the on-premise component of ProjectWise Project Performance
Dashboards. The service is used to upload and then regularly update the ProjectWise Project Performance
Dashboards portal with the latest information from your ProjectWise and Bentley Transmittal Server databases.
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Requirements

Note: ProjectWise Analytics Data Upload Service is an option of the ProjectWise Explorer installer beginning in
ProjectWise Explorer CONNECT Edition Update 2. See To Install ProjectWise Explorer (on page 130).
The following are the system requirements for ProjectWise Analytics Data Upload Service.

Operating Systems
• Windows Server 2012 R2
• Windows Server 2012
• Windows Server 2008 R2 SP1
• Windows Server 2008 SP2

Prerequisites
• Microsoft .NET Framework 4

Database Connections
You can establish a connection to the following databases:
• ProjectWise database (required)
• Bentley Transmittal Services V1.0 database (optional)
The ProjectWise database can be from the following ProjectWise versions:
• ProjectWise CONNECT Edition Update 2
• ProjectWise CONNECT Edition Update 1 (10.00.01.25) or later
• ProjectWise CONNECT Edition (10.00.00.20)
• ProjectWise V8i (SELECTseries 4) (08.11.11.559 or 08.11.11.590)
ProjectWise Analytics Data Upload Service supports the same SQL Server and Oracle versions that are supported
by the above versions of ProjectWise and Bentley Transmittal Services.
Note: ProjectWise Analytics Data Upload Service collects and stores change baseline information in the same
ProjectWise and Bentley Transmittal Services databases that you make connections to. This information is not
stored in the ProjectWise and Bentley Transmittal Services tables, but rather is copied in advance from the
ProjectWise and Bentley Transmittal Services tables and then cached in separate ProjectWise Analytics Data
Upload Service tables. This can cause the database to significantly increase in size (up to twice the original size).
Make sure the database server has enough space to accommodate this growth.

Ports
ProjectWise Analytics Data Upload Service uses the following ports through which it collects and uploads data:
[TCP:1433] ProjectWise Design Integration Server database
[TCP:1433] Bentley Transmittal Services V1.0 database
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[HTTPS(443)] Bentley Identity Management Service (https://
ims.bentley.com/)

[HTTPS(443)] ProjectWise Project Performance Dashboards service
(https://connect-analytics.bentley.com/)

Supported Browsers for ProjectWise Project Performance Dashboards
• Microsoft Edge
• Microsoft Internet Explorer 10 (32-bit only) and 11 (32-bit only)
• Google Chrome (latest version) on Windows

Supported ProjectWise Explorer Versions
• ProjectWise Explorer CONNECT Edition Update 2
• ProjectWise Explorer CONNECT Edition Update 1 (10.00.01.25) or later
• ProjectWise Explorer CONNECT Edition (10.00.00.20)
• ProjectWise Explorer V8i (SELECTseries 4) (08.11.11.559 or 08.11.11.590) with the ProjectWise Explorer

Cloud Integration Module installed

Basic Configuration Steps

1. Register a CONNECTED project (on page 203).
2. Install the ProjectWise Analytics Data Upload Service (on page 213)

This task should be done by the database administrator. It can be done on any computer, as long as you can
make a connection to the ProjectWise and Bentley Transmittal Server databases from that computer.

3. Associate a Work Area with a ProjectWise Cloud Project (on page 204)
This task is done from ProjectWise Explorer.

4. Turn on the ProjectWise Project Performance Dashboards service (on page 225) for your newly associated
project.
This task is done from the ProjectWise Project Performance Dashboards portal.

Install the ProjectWise Analytics Data Upload Service

1. Launch the ProjectWise Explorer installer and turn on the ProjectWise Analytics Data Upload Service
option.
See To Install ProjectWise Explorer (on page 130).

2. When the ProjectWise Analytics Data Upload Service Setup Wizard opens, click Next, read and accept the
license agreement, and accept all default settings to complete the installation.
The installer delivers two components - the Upload Service and the Upload Administrator. You can install
each component on its own computer, but for simplicity this procedure assumes you are installing both on
the same computer. The upload service does the actual work of uploading data to the ProjectWise Project
Performance Dashboards service, while the upload administrator, which opens at the end of installation, is
used to configure which databases the upload service will upload data from, and optionally set a schedule for
uploading.
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3. When installation is complete, turn on the option to Launch Analytics Data Source Administrator and click
Finish.
The ProjectWise Analytics Data Source Administrator window opens.
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4. Go to Connect to the Databases You Want to Upload Data From (on page 215).

Connect to the Databases You Want to Upload Data From

1. Open the ProjectWise Analytics Data Source Administrator window.
This window opens automatically if you turn on the option to Launch Analytics Data Source Administrator
at the end of the standalone installation.
If you install ProjectWise Analytics Data Upload Service from the ProjectWise Explorer installer, you can
open this window by going to Apps > Bentley > ProjectWise Analytics Data Source Administrator.
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2. Click Set account to sign in with your Bentley account.
After signing in, the following dialog opens:
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3. Click Allow.
4. Back in the Analytics Data Source Administrator window, click Add Data Source.

This opens the Data upload pipeline configuration wizard, which is used to specify and configure which
ProjectWise database and optionally which Bentley Transmittal Services database the upload service will
upload data from.

5. When the wizard opens, click Next.
6. On the ProjectWise database information page, do the following:

a. Set Database Type to Microsoft SQL Server or Oracle, depending on which database ProjectWise is
using.
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b. Enter the Connection Information of the specific ProjectWise database you want the service to upload
data from:
SQL Server:
• Database server name - Enter the name of the computer on which the database server is installed.

For SQL Server databases: If your SQL Server installation has named instances, enter the name of the
computer, followed by a backslash, followed by the SQL Server instance name you want to connect to.
For example, computername\SQLServerinstancename.

• Database user name - Enter the name of the database user who has access to the database you want
to connect to on the specified database server.

• Database user password - Enter the password of the specified database user.
• Database name - Enter the name of the database on the specified database server you want to

connect to.
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Oracle:
• Datasource or TNS Name
• Database user name - Enter the name of the database user who has access to the database you want

to connect to.
• Database user password - Enter the password of the specified database user.
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c. Upload existing Audit Trail information - Leave this option on (the default) if you want the service to
collect ProjectWise audit trail information from the database. Turn this option off if you do not want to
collect audit trail information.

d. Click Next.
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7. On the Transmittal database information page, do one of the following:
If you never installed Bentley Transmittal Services, or if you have but do not want to upload data from its
database, just click Next.
or
Otherwise turn on Transmittal Services V1.0 is configured, enter the Connection Information of the
Bentley Transmittal Services database you want the service to upload data from, and click Next.
Connection Information:
• Database server name - Enter the name of the computer on which the database server is installed. If

your SQL Server installation has named instances, enter the name of the computer, followed by a
backslash, followed by the SQL Server instance name you want to connect to. For example, computername
\SQLServerinstancename.

• Database user name - Enter the name of the database user who has access to the database you want to
connect to on the specified database server.

• Database user password - Enter the password of the specified database user.
• Database name - Enter the name of the database on the specified database server you want to connect to.
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8. On the Database schema verification page, do the following:
When configuring a database for the first time, the database will not yet be instrumented for analytics data
collection and you must upgrade the database to continue.
a. Click the Upgrade link next to Database is instrumented for change collection.
b. When the Confirm database upgrade dialog opens, click Yes.
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c. Click Next.

9. On the Scheduled data processing jobs page, configure schedules for running data collection and data
upload jobs (these are two separate jobs) and click Next when finished.
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For data collection and data upload, each has a default schedule defined. You can edit the default schedules
(select one and click Modify) or use them as is. You can also click Add to define new schedules.

10. On the Summary page, click Finish.
The new configuration is added to list of datasources in the Analytics Data Source Administrator window.

11. Click Add Data Source if you want to connect to more databases, otherwise click Close.
The ProjectWise Analytics Data Upload Service will begin collecting and uploading data to the ProjectWise
Project Performance Dashboards service according to the configured schedules.
Note: Please be aware of the following:
• After datasource configuration and the first run of the service, the transaction log can fill up quickly.
• Data upload and processing could take up to a few hours or more depending on the size of your database.

Data will not be available in the ProjectWise Project Performance Dashboards portal until data upload and
processing is finished.

Tip: To change a datasource configuration, select the datasource from the list and click Re-configure. This
reopens the configuration wizard and lets you change settings and schedules as needed.

Tip: To remove a datasource configuration, select the datasource from the list and click Remove. This removes
all the instrumentation that was added to the database when it was upgraded in order to allow for data
collection.
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Turn On ProjectWise Project Performance Dashboards in Your Project

1. Go to the CONNECTED project portal, either from a web browser or from ProjectWise Explorer (Preview
Pane > ProjectWise Project Portal tab).
Note: To access the CONNECTED project portal from ProjectWise Explorer you must first associate a
ProjectWise project to CONNECTED project (on page 204).

2. Click the ProjectWise Performance Dashboards tab and then click Go.

3. Click Turn on.

You will see the following message, informing you that no project data has been uploaded to the dashboard yet.
This is expected, since you have just enabled ProjectWise Project Performance Dashboards for this CONNECTED
project and it takes time to upload and process project data.
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Known Issues

The following are some known issues with this release.

ProjectWise Analytics Data Upload Service
• When configuring the schedule for data collection and data upload jobs, the Database utilization setting is

set to 100%, and is currently disabled from changing.
• ProjectWise Analytics Data Upload Service connection to ProjectWise and Bentley Transmittal Server

databases through Windows authentication is not supported.

ProjectWise Project Performance Dashboards
• Document completion values are shown incorrectly formatted in ProjectWise Project Performance

Dashboards charts when completion attributes are of floating point type.
• Count of documents is incorrect in ProjectWise Project Performance Dashboards charts if documents were

moved from one folder to another in ProjectWise Explorer.
• The Documents in <selected> group by completeness chart tooltip does not show the correct Count

information for documents that do not have any % complete attribute value set.

ProjectWise Project Synchronization Configuration
ProjectWise Project Synchronization facilitates the sharing and receiving of project content among multiple
organizations for the purpose of design coordination. Administrators install ProjectWise Sync Service locally,
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and use it to associate ProjectWise work areas or local Windows folders with ProjectWise cloud projects. Once
the association is made, people from your organization can go to the ProjectWise Project Synchronization portal
within the ProjectWise cloud project and share the associated ProjectWise or Windows content with people
from other organizations, who will themselves go to the ProjectWise Project Synchronization portal to receive
the content.
Attention: The use of ProjectWise Project Synchronization in your organization requires approval by your
CONNECT administrator before it can be used. Please have your CONNECT administrator contact Bentley
Support for assistance in approving this service for your organization.

ProjectWise Sync Service Requirements

The following are the system requirements for ProjectWise Sync Service.

Operating Systems
ProjectWise Sync Service can be installed on:
• Windows 10 (64-bit)
• Windows 8.1 (64-bit)
• Windows 7 SP1 (64-bit)
• Windows Server 2012 R2, Standard and Enterprise Editions (64-bit)
• Windows Server 2012, Standard and Enterprise Editions (64-bit)
• Windows Server 2008 R2 SP1, Standard and Enterprise Editions (64-bit)

Basic Hardware Specs
• Processor: 2 GHz x64 processor or better, dual-core or multiple-processor architecture is strongly

recommended
• Memory: 1 GB of RAM minimum, more recommended based on the number of associations
• Hard Disk: 200 MB of free hard disk space for installation, plus additional free hard disk space for

appropriate file storage

Windows Domain
The computer on which you install ProjectWise Sync Service must be a member of your organization's Windows
domain.

Prerequisite
• Windows Identity Framework 3.5

You can turn on this Windows feature if using Windows Server 2012 or Windows 8.1 or later.
You can download Windows update KB974405 from Microsoft if using Windows Server 2008 or Windows 7.

Database
ProjectWise Sync Service requires some version of SQL Server, and can use any version of SQL Server that is
supported by Microsoft Sync Framework.
For convenience, the ProjectWise Sync Service installation installs these versions of SQL Server:
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• Microsoft SQL Server Compact 3.5 (used by default if this is an upgrade)
• Microsoft SQL Server 2012 Express LocalDB (used by default if this is a new installation)
You can change the default version of SQL Server being used by editing the PSS.exe.config file in the
C:\Program Files\Bentley\ProjectWise Sync Service folder after installation.

ProjectWise Explorer
The ProjectWise Sync Service installer delivers a Windows File Adapter and a ProjectWise Adapter.
The Windows File Adapter is always available for installation, but the ProjectWise Adapter is only available
for installation if the installer detects that a supported version of ProjectWise Explorer is installed.
The following versions of ProjectWise Explorer are supported:
• ProjectWise Explorer CONNECT Edition Update 3
• ProjectWise Explorer CONNECT Edition Update 2.3
• ProjectWise Explorer CONNECT Edition Update 2.2
• ProjectWise Explorer CONNECT Edition Update 2.1
• ProjectWise Explorer CONNECT Edition Update 2
• ProjectWise Explorer CONNECT Edition Update 1 (10.00.01.25 or later)
• ProjectWise Explorer CONNECT Edition (10.00.00.15 or 10.00.00.20)
• ProjectWise Explorer V8i (SELECTseries 4) (08.11.11.559 or 08.11.11.590)
Tip: If you install ProjectWise Explorer after installing ProjectWise Sync Service, you will need to uninstall and
then reinstall ProjectWise Sync Service, in order for ProjectWise Sync Service to detect ProjectWise Explorer and
install the ProjectWise Adapter.

ProjectWise Network Configuration
If you plan to use the ProjectWise Adapter, which is required to associate a ProjectWise work area with a
ProjectWise cloud project through the ProjectWise Sync Service admin client, then after you install ProjectWise
Explorer you must also configure the ProjectWise network (on page 170), assuming your ProjectWise server and
datasources are on another computer. This is needed so that the ProjectWise Sync Service can get the
ProjectWise datasource list.

Install ProjectWise Sync Service

1. Double-click the SETUP.EXE file to open the ProjectWise Server Setups master installer.
2. Click Install next to ProjectWise Sync Service.
3. When the Installation Wizard opens, read and accept the license agreement and click Next.
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4. On the Select features to install page, all available features are selected by default. Either leave them all
selected and click Next, or turn off the features you do not want to install and click Next.
The installer delivers two main components - the Sync Service and the Service administrator UI. You can
install each component on its own computer, but for the sake of simplicity this procedure assumes you are
installing them both on the same computer. The Sync Service does the actual work, while the Service
administrator UI is the admin client that you use to select which on-premise content you want to associate
to your ProjectWise cloud project.
The Sync Service component includes two adapters. The Windows File Adapter is always available for
installation, but the ProjectWise Adapter is only available for installation if the installer detects that a
supported version of ProjectWise Explorer is installed.
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5. When installation is complete, turn on Launch activation wizard to configure licensing (on page 260) and
click Finish.
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The General Workflow for Sharing and Receiving Content

The content that one organization decides to share will be received by another organization. The receiving
organization can either receive the shared content into their own ProjectWise cloud project (and eventually into
a ProjectWise work area or a Windows folder), or if they are using a Bentley mobile app such as ProjectWise
WorkSite or Navigator Mobile they can receive the shared content directly into their mobile app.
The steps for getting the content from one organization to another are slightly different, depending on whether
the receiving organization wants to receive the shared content into their own ProjectWise cloud project (this is
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the site-to-site share workflow), or if they want to receive the shared content into a Bentley mobile app (this is
the site-to-app share workflow).

Site-to-Site Share Workflow
1. Before any sharing can take place, both the sharing organization and the receiving organization must register

a new ProjectWise cloud project.
For example, Organization A creates Project A and Organization B creates Project B.
See Register a ProjectWise Cloud Project (on page 203).

2. Both the sharing organization and the receiving organization must download and install the ProjectWise Sync
Service.
See Install ProjectWise Sync Service (on page 228).

3. The sharing organization must use their ProjectWise Sync Service client to associate the physical location of
the source content (which can be a ProjectWise work area or a Windows folder) with their ProjectWise cloud
project.

4. The receiving organization must use their ProjectWise Sync Service client to associate the physical location
where the content will be received (which can be a ProjectWise work area or Windows folder) with their
ProjectWise cloud project. The physical folder into which the content will be received must be an empty
folder.
Note: The steps for associating a ProjectWise work area or a Windows folder to a ProjectWise cloud project
are the same for both the sharing organization and the receiving organization.

5. The sharing organization will then go to their ProjectWise cloud project, open the ProjectWise Project
Synchronization portal, and create a site-to-site share to invite one or more members of the receiving
organization to receive the content.
See Creating a Site-to-Site Share (on page 240).

6. An email is sent to the specified members of the receiving organization, informing them of the share.
7. The receiving organization will then go to the ProjectWise Project Synchronization portal, accept the share,

and select to receive the content into their own ProjectWise cloud project, which is then downloaded to the
physical location associated with the receiving organization's ProjectWise cloud project.
See Accepting Content from a Site-to-Site Share (on page 244).

Site-to-App Share Workflow
1. Before any sharing can take place, the sharing organization must register a new ProjectWise cloud project.

For example, Organization A creates Project A.
See Register a ProjectWise Cloud Project (on page 203).

2. The sharing organization must download and install the ProjectWise Sync Service.
See Install ProjectWise Sync Service (on page 228).

3. The sharing organization must use their ProjectWise Sync Service client to associate the location of the
source content (which can be a ProjectWise work area or a Windows folder) with their ProjectWise cloud
project.

4. The sharing organization will then go to their ProjectWise cloud project, open the ProjectWise Project
Synchronization portal, and create a site-to-app share to invite members of the receiving organization to
receive the content.
See Creating a Site-to-App Share for Mobile App Users (on page 242).
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5. An email is sent to the specified members of the receiving organization, informing them of the share.
6. The receiving organization will then use their Bentley mobile app to go to the sharing organization's

ProjectWise cloud project and receive the content.

Preconfiguring the List of Windows Folders That Can Be Associated to ProjectWise
Cloud Projects

This task is required if you need to associate Windows folders with ProjectWise cloud project. You can skip this
task if you are only working with ProjectWise work areas.
1. Open a text editor with elevated privileges, then open the PSS.exe.config file in the ProjectWise Sync

Service installation folder (C:\Program Files\Bentley\ProjectWise Sync Service).
2. Find this section within the <appSettings> element:

<!--
====================================================================================
====
Uncomment 'WindowsAdapterPaths' to specify approved directories for the windows 
adapter.
All folders under these paths will be available for mapping. Behavior is undefined 
if paths
are nested under each other.
====================================================================================
========
   <add key="WindowsAdapterPaths" value="
        C:\Data\To\Sync\
        C:\DesignFiles\
        D:\Projects\
        \\Network\Share
        "/>
-->

This commented out <add> element shows the syntax and some examples of how to add a folder to the list of
approved folders.

3. Copy the following <add> element and paste it just above or below the commented out section:
<add key="WindowsAdapterPaths" value="
        
        "/>

4. Within this element, add the path to the parent folders, whose child folders you want to be made available for
associating to ProjectWise cloud projects.
<add key="WindowsAdapterPaths" value="
        C:\localprojects
        "/>

In this example, and as stated in the comment in the config file, all subfolders under C:\localprojects will
now be available for selection when associating ProjectWise cloud projects in the ProjectWise Sync Service
client.

5. Save and close the file, then restart the ProjectWise Sync Service in the Services window.

Open the ProjectWise Sync Service Client

1. Do one of the following:
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On Windows 8 or later / Windows Server 2012:
On the Start page, go to your Apps, and under Bentley, select ProjectWise Sync Service.
On Windows 7 / Windows Server 2008:
Select Start > All Programs > Bentley > ProjectWise Sync Service > Service Client

2. Sign in using your Bentley Cloud Services credentials.
3. Select which ProjectWise Sync Service want to manage.

If the ProjectWise Sync Service you are managing is the one installed on this computer, then leave localhost
selected under Recent Servers and click Go.
If you want to connect to a ProjectWise Sync Service installed on another computer, enter the name of that
computer in the Specific Server field and click Go.
The default port used to communicate with the ProjectWise Sync Service is 8050.
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The ProjectWise Sync Service client opens.
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Now use the client to associate ProjectWise work areas and/or Windows folders with ProjectWise cloud
projects.

Associating a ProjectWise Work Area with a ProjectWise Cloud Project

1. Configure the ProjectWise network using the ProjectWise Network Configuration Settings dialog
delivered with ProjectWise Explorer if your ProjectWise server and datasources are on another computer.
This step is needed so that the ProjectWise Sync Service can provide a list of datasources to choose from in
the steps below.

2. If not already open, open the ProjectWise Sync Service client (on page 233).
3.

Click Add Association. 
The Add Association dialog opens.
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4. Select which ProjectWise work area you want to associate:
a. Click the Browse button next to the Local Repository field

The Select Local Repository dialog opens.
b. At the top of the dialog, select ProjectWise.

This shows a list of available ProjectWise datasources.
(If no datasources appear, go back and check your ProjectWise network settings.)

c. Double-click a datasource in the list.
The Adapter Credentials dialog opens.

d. Enter a user name and password for the datasource and click Save.
Tip: The account you specify should have read/write access to the folders in the work area you want to
share.
The datasource opens and shows a list of top level work areas and folders in the datasource.
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e. Select a work area and click OK.
The work area is now listed in the Local Repository field of the Add Association dialog.

5. From the Cloud Repository list, select the ProjectWise cloud project you want to associate to the work area.
It is assumed that you have already registered (created) a ProjectWise cloud project. If not, register one now
(see Register a ProjectWise Cloud Project (on page 203)), then come back here, click Refresh, and then select
the ProjectWise cloud project from the list.
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6. Click OK.
The folder names and document names of the selected work area will now be synced up to the ProjectWise cloud
project.
The next step is go to the ProjectWise Project Synchronization portal and create a share, in order to share this
content with others.
You can create site-to-site shares (on page 240) and site-to-app shares (on page 242).

Associating a Windows Folder with a CONNECTED Project

1. This task requires that you first preconfigure the list of folders that can be associated (on page 236), using
the PSS.exe.config file in the ProjectWise Sync Service installation folder
(C:\Program Files\Bentley\ProjectWise Sync Service).
This is needed so that the ProjectWise Sync Service can provide a list of Windows folders to choose from in
the steps below.

2. If not already open, open the ProjectWise Sync Service client (on page 233).
3.

Click Add Association. 
The Add Association dialog opens.

4. Select which Windows folder you want to associate.
a. Click the Browse button next to the Local Repository field.

The Select Local Repository dialog opens.
b. At the top of the dialog, select Windows.

This shows a list of available Windows folders.
(If no folders appear, go back and check your settings in the PSS.exe.config file (on page 236).)

c. Select a folder and click OK.
The folder is now listed in the Local Repository field of the Add Association dialog.

5. From the Cloud Repository list, select the ProjectWise cloud project you want to associate to the Windows
folder.
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It is assumed that you have already registered (created) a ProjectWise cloud project. If not, register one now
(see Register a ProjectWise Cloud Project (on page 203)), then come back here, click Refresh, and then select
the ProjectWise cloud project from the list.

6. Click OK.
The selected folder's metadata (folder names and file names) will now be synced up to the ProjectWise cloud
project.
The next step is go to the ProjectWise Project Synchronization portal and create a share, in order to share this
content with others.
You can create site-to-site shares (on page 240) and site-to-app shares (on page 242).

Creating a Site-to-Site Share

Note: This task is done from the ProjectWise Project Synchronization portal.
A site-to-site share lets you share content from your organization with people in other organizations. People you
invite to receive this shared content will come to the ProjectWise Project Synchronization portal to accept and
receive the content into their own ProjectWise cloud project.
1. Go to the ProjectWise Project Synchronization portal.

a. Go to the CONNECTION Center (https://connect.bentley.com) and sign in with your Bentley Cloud
Services credentials.

b. Go to Recent projects and select your ProjectWise cloud project.
c. Click the Project Synchronization tile.

2. Click Site to site shares from the menu on the left.
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3. Click the Create new share button.
The local project(s) you associated to this ProjectWise cloud project are listed.
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4. Select the folder you want to share by clicking the button to the left of it.
You can share any top level folder you see, or click the > button (if the folder has subfolders) to drill down
into the folder and select one of its subfolders to share. Selecting to share a folder with subfolders will
include the subfolders in the share.

5. Add a description of the content that is being shared.
6. Enter the email address (or addresses) of the people you want to invite to receive the share, along with a

short message about the content you are sharing.
7. When finished, click Share now.
An email message is sent to each recipient, inviting them to come to the ProjectWise Project Synchronization
portal to accept and receive this shared content (on page 244).

Creating a Site-to-App Share for Mobile App Users

Note: This task is done from the ProjectWise Project Synchronization portal.
A site-to-app share lets users access shared content from their Bentley mobile apps such as ProjectWise
WorkSite and Navigator Mobile.
1. Go to the ProjectWise Project Synchronization portal.

a. Go to the CONNECTION Center (https://connect.bentley.com) and sign in with your Bentley Cloud
Services credentials.

b. Go to Recent projects and select your ProjectWise cloud project.
c. Click the Project Synchronization tile.

2. Click Site to app shares from the menu on the left.
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3. Click the Create new share button.
The local project(s) you associated to this ProjectWise cloud project are listed.

4. Select the folder you want to share by clicking the button to the left of it.
You can share any top level folder you see, or click the > button (if the folder has subfolders) to drill down
into the folder and select one of its subfolders to share. Selecting to share a folder with subfolders will
include the subfolders in the share.

5. Add a description of the content that is being shared.
6. Click Save and edit recipient list.
7. Enter the email address of the person you want to invite to receive the shares and click Add recipient.

Repeat this step to invite more people to the share as needed.
The people you add to the recipient list are those members of your project who you want to have access to
the files in these shared folders from their Bentley mobile apps such as ProjectWise WorkSite and Navigator
Mobile.

8. When finished adding recipients, click Continue.
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An email message is sent to each recipient, informing them that the shared content is now available to access
through their mobile apps.
Note: The mobile app users who are invited to the share will have access to all of the site-to-app shares that exist
in that ProjectWise cloud project, if you have created more than one site-to-app share.

Accepting Content from a Site-to-Site Share

Note: This task is done from the ProjectWise Project Synchronization portal.
Once a site-to-site share is created, users in the receiving organization come to the ProjectWise Project
Synchronization portal to accept the invitation to the share and then receive the content into their own
ProjectWise cloud project.
1. Go to the ProjectWise Project Synchronization portal.

a. Go to the CONNECTION Center (https://connect.bentley.com) and sign in with your Bentley Cloud
Services credentials.

b. Open one of your organization's ProjectWise cloud projects.
c. Click the Project Synchronization tile.

2. Click Invitations from the menu on the left to view your invitations from this project.
The number to the right of Invitations shows you how many share invitations you have not yet accepted or
rejected.

3. Click the Accept button under the share you want to accept.

4. Select one of your organization's ProjectWise cloud projects that you want to receive the shared content to.
Your organization's ProjectWise or Windows folder structure that is associated with the selected ProjectWise
cloud project appears.
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5. From the list of local folders, select an empty folder where you want the shared content to be synced to.
6. Enter a short description of the shared content.
7. Click Save the share.

The content from the share will be imported into ProjectWise, or downloaded to the Windows folder, on the
next sync.
Note: If the final destination of the content is ProjectWise, reference scanning is automatically performed on
the files after they are imported into ProjectWise.

Adding Work Area Connections to ProjectWise Cloud Projects
ProjectWise cloud project administrators have the ability of exposing on-premise work areas in the ProjectWise
Share portal within the ProjectWise cloud project, by creating something called a work area connection from the
cloud project. A work area connection uses Bentley Web Services Gateway (WSG) in order to access the on-
premise ProjectWise Design Integration Server, datasource, and work area, making the content in that work area
available to users in the ProjectWise Share portal.
This release of ProjectWise now lets you create the same work area connections right from ProjectWise
Explorer. To facilitate this, a new datasource setting has been added in ProjectWise Administrator, called WSG
Work Areas URL for Connect services. In this setting, the administrator specifies the URL of the Bentley Web
Services Gateway (which includes the path to the on-premise ProjectWise Design Integration Server and
datasource). Once this URL is configured, then associating a work area to a ProjectWise cloud project
automatically creates the work area connection in the ProjectWise Share portal (or any ProjectWise Connection
Service that utilize this feature) within the associated cloud project.
These are the basic steps:
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1. Install and deploy Bentley Web Services Gateway and the ProjectWise Plug-in as described in the ProjectWise
Implementation Guide.

2. In ProjectWise Administrator, configure the new datasource setting, WSG Work Areas URL for Connect
services (details below).

3. In ProjectWise Explorer, associate a work area to a ProjectWise cloud project.
Now go to the ProjectWise Share portal within the same associated ProjectWise cloud project and you will
see the new work area connection.

Configuring the WSG URL:
The important part of this configuration is getting the syntax of the URL right. The server does not verify
whether or not you have entered it correctly, so make sure you enter it correctly!
To find the first part of the URL, open the WSG Explorer on the server where Bentley Web Services Gateway is
installed.
To open the WSG Explorer, in a web browser enter: https://WSGservername/ws/Pages/WsgExplorer.aspx
(for example, https://maestrovm.bentley.com/ws/Pages/WsgExplorer.aspx)
In the WSG Explorer window that opens, on the Navigation tree tab, expand Repositories, then select the
datasource you are configuring. In the WSG Explorer address bar, select the full URL that includes the datasource
as shown here, then right-click and select Copy.
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Then in ProjectWise Administrator, paste this URL into the new datasource setting, WSG Work Areas URL for
Connect services. At the end of the pasted URL, append this text: /PW_WSG/Project, so that the full URL is now
something like this:
https://WSGservername/ws/v2.7/Repositories/Bentley.PW--PWservername~3Apwtest/PW_WSG/
Project

Make sure you use the fully qualified domain name when entering the Bentley Web Services Gateway and
ProjectWise server names.
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This example shows the full URL, when the Bentley Web Services Gateway and ProjectWise servers are installed
on the same computer:
https://maestrovm.bentley.com/ws/v2.7/Repositories/Bentley.PW--
maestrovm.bentley.com~3Apwtest/PW_WSG/Project
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 13
Language Packs

The text that displays in the various windows, menus, dialogs, and error messages can be switched to another
language by installing a ProjectWise language pack.
ProjectWise language packs provide localized interfaces for users of:
• ProjectWise Explorer
• ProjectWise Administrator
• Orchestration Framework Administrator
Search the Bentley Software Fulfillment Center to see if there is a ProjectWise language pack for your language.

Before You Install the Language Pack
1. Make sure the application for which you are installing the language pack is already installed.

If you install the language pack first and then the application, the language pack will not apply and you will
have to uninstall and reinstall it to make it apply.

2. For ProjectWise Explorer and/or ProjectWise Administrator, make sure you first install ProjectWise Explorer
with the User Tools option turned on, as this will be used to set the new locale for these applications.

3. When installing the language pack for Bentley i-model Composition Server for PDF, you must use the same
locale across the iCS for PDF machines.

To Install the Language Pack
1. Download your language pack and extract the package.
2. Open the folder where the language packs are extracted to.

The extracted folder will look something like this:
C:\BentleyDownloads

    \pw081111574xx

Where XX at the end of the folder name is the two letter abbreviation that indicates the language. For
example, de for German.

3. Double-click the appropriate MSI file to install the language pack.
Note: On ProjectWise Explorer computers, you must install both 64-bit and 32-bit language packs, making
sure to install the 64-bit language pack first, then the 32-bit language pack.

4. When the Setup Wizard opens, click Next and follow the prompts to completion.
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After You Install the Language Pack
1. ProjectWise Explorer and ProjectWise Administrator computers:

After language pack installation, open the ProjectWise Tools dialog, select Set Locale and click Execute. In
the dialog that opens, select the newly installed language, click OK, then click Close.
To open the ProjectWise Tools dialog:
• On Windows 8 or later / Windows Server 2012 or later:

Go to the Start page and type User Tools, or go to Start > Apps > Bentley and click User Tools.
• On Windows 7 / Windows Server 2008:

Select Start > All Programs > Bentley > ProjectWise <version> > Tools > User Tools.
2. Orchestration Framework Administrator computers:

After language pack installation, change the display language of the operating system.

Language Packs
After You Install the Language Pack
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Upgrade Planning

This section discusses the suggested process for upgrading a ProjectWise V8 2004 Edition or later system to
ProjectWise CONNECT Edition Update 3. The process outlined below is intended to serve as general guidance
only and may not apply to all installations. You should become familiar with the new capabilities of this version
before upgrading your production environment to ensure a successful upgrade.
Caution: Contacting Bentley Professional Services is highly recommended for site assessment, installation, and
configuration services in support of the upgrade process.

Caution: It is highly recommended that a test conversion be performed and validated prior to upgrading a
production environment.

Caution: Upgrading from V8 (8.1x) or earlier requires assistance from Bentley Professional Services due to the
complexity of the upgrade.

Caution: Some upgrades, depending on the version you are upgrading from, require that you check in all checked
out documents before upgrading, to ensure the integrity of master/reference document relationships. Exported
documents can remain exported during the upgrade. See the Precautions (on page 253) section for details.

Application Integration Support
This version of ProjectWise was tested against a specific list of primary applications and versions. That list of
supported applications can be found in the ProjectWise readme.
For a more comprehensive and ongoing list of applications that are supported with both current and previous
versions of ProjectWise, see the ProjectWise Version Support Matrix available on docs.bentley.com. This
document is updated periodically, as new information becomes available, so check back often.
Note: The old Application Integration Compatibility document on Bentley Communities is no longer being
updated. Please use the new ProjectWise Version Support Matrix on docs.bentley.com instead.

Setting Up a Test Environment
Before you upgrade your production environment to ProjectWise CONNECT Edition Update 3, it is
recommended that you first set up and run ProjectWise CONNECT Edition Update 3 in a test environment. To do
so, you can use the same instructions to upgrade your database and datasource as described in the section, 
Upgrading to the Current Version (on page 252), with the following exceptions:
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1. Make a copy of your current ProjectWise database, to be used in the upgrade test. Use your database's
standard backup and restoration tools to do this.

2. When setting up your test environment, install the new ProjectWise CONNECT Edition Update 3 software on
a dedicated server or servers, and NOT on any of your production servers. Consider using virtual servers for
your test environment.

3. Make a copy of your current ProjectWise storage area(s), to be used for your test datasource. Next, open your
database, and open the dms_store table for write. There will be one row in this table for each storage area
used by the datasource. For each storage area row, change the value in the o_node column to be the
computer name (or IP Address if that is how you are configured) of the computer you copied the storage area
to, then change the value in the o_path column to be the path to the specific storage area folder on that
computer.

Caution: If the conversion of your database should fail for some reason, do not run DMSCONV on it a second time,
as this can cause further corruption of the database. Instead, after you have determined the cause of the failure
and found a solution, you will need to start the DMSCONV process over, using a fresh backup copy of your
database.

Upgrading to the Current Version
After you have completed a test upgrade, as well as a test of the new features, use the following guidelines to
upgrade your production environment to the current version of ProjectWise. Again, it is recommended that you
contact Bentley Professional Services to assist you in your upgrade.

General

1. Upgrading generally requires upgrading both server and client applications.
2. Depending on the version you are upgrading from, you may still be able to use your older client with the new

server, or your new client with an older server.
ProjectWise Design Integration Server CONNECT Edition Update 3 supports connections from:
• ProjectWise Administrator CONNECT Edition Update 3
• ProjectWise Explorer CONNECT Edition Update 3
• ProjectWise Explorer CONNECT Edition Update 2.3
• ProjectWise Explorer CONNECT Edition Update 2.2
• ProjectWise Explorer CONNECT Edition Update 2.1
• ProjectWise Explorer CONNECT Edition Update 2
• ProjectWise Explorer CONNECT Edition Update 1
• ProjectWise Explorer CONNECT Edition
• ProjectWise Explorer V8i (SELECTseries 4)
• ProjectWise Explorer V8i (SELECTseries 3)
• ProjectWise Explorer V8i (SELECTseries 2)
• ProjectWise Explorer V8i (SELECTseries 1)
• ProjectWise Explorer V8i

• ProjectWise Caching Server CONNECT Edition Update 3
• ProjectWise Caching Server CONNECT Edition Update 2.2
• ProjectWise Caching Server CONNECT Edition Update 2

Upgrade Planning
Upgrading to the Current Version

ProjectWise Design Integration 252 Implementation Guide



• ProjectWise Caching Server CONNECT Edition Update 1
• ProjectWise Caching Server V8i (SELECTseries 4)
• ProjectWise Web Server V8i (SELECTseries 4)
ProjectWise Explorer CONNECT Edition Update 3 can connect to:
• ProjectWise Design Integration Server CONNECT Edition Update 3
• ProjectWise Design Integration Server CONNECT Edition Update 2.2
• ProjectWise Design Integration Server CONNECT Edition Update 2
• ProjectWise Design Integration Server CONNECT Edition Update 1
• ProjectWise Integration Server V8i (SELECTseries 4)
Important: The version of ProjectWise Administrator you use must always be the same version as the
ProjectWise Design Integration Server.

3. Typically, all ProjectWise servers in a ProjectWise system must be of the same release version, and should be
upgraded at the same time, with the following exceptions:
• You may temporarily use your existing ProjectWise Caching Server(s) from one of the versions listed

above against the new ProjectWise Design Integration Server, until such time that a ProjectWise Caching
Server upgrade can be performed.

• There is no ProjectWise Web Server in this release. If you need this feature, use ProjectWise Web Server
V8i (SELECTseries 4). Also, if you need to use the ProjectWise Publishing Gateway Service with your
ProjectWise Web Server, then use ProjectWise Publishing Gateway Service V8i (SELECTseries 4) and not
the ProjectWise Publishing Gateway Service from this release.

4. All ProjectWise applications on a single computer must be of the same release version. For example, you
cannot have applications from both ProjectWise CONNECT Edition Update 3 and Update 2.2 installed on the
same computer.

Precautions

1. Some upgrades, depending on the version you are upgrading from, require that you check in all checked out
documents before upgrading, to ensure the integrity of master/reference document relationships. Exported
documents are not affected and can remain exported during the upgrade.
ProjectWise V8i (08.11.05.xx) introduced a file called file_name.fileinfo.xml, which gets created locally
upon check out of a master document. Because of this change, upgrading a pre-V8i version ProjectWise
database to ProjectWise CONNECT Edition Update 3 requires that you check in all checked out documents
having references, raster references, or link sets before upgrading.
ProjectWise V8i (SELECTseries 1) (08.11.07.1xx) introduced the creation of shapefile sets and raster sets.
Because of this change, upgrading a pre-V8i (SELECTseries 1) version ProjectWise database to the current
version requires that you check in all checked out DGN documents having links to shapefiles and/or raster
files (which have their own related files) before upgrading.

2. Back up your existing database. A complete cold backup should be made and verified using the database
vendor's recommended backup procedures.

3. Back up all server-side ProjectWise configuration files, including DMSKRNL.CFG.
4. Ensure that your database software is still supported in the current version of ProjectWise (see the readme -

readme_ProjectWise.chm). Note that the suggestions in this upgrade planning document do not address
the conversion between database types (for example, SQL Server to Oracle conversions, or vice versa).
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5. If there has been API-driven customization of your ProjectWise system, that customization will at a minimum
need to be recompiled to be binary compatible with the current version of ProjectWise. Installers will need to
be updated to properly register the customizations on the new ProjectWise clients.

6. The administrative user performing the upgrade will need to have access to the top folder of the datasource.
If you are concerned about whether this user has access, you may want to turn off that user's user setting,
General > Use access control, before you begin your upgrade, then turn it back on after upgrade is
complete.

7. The following installers from the current version of ProjectWise can be used to automatically upgrade an
earlier version of the product to the current version, when the earlier version is ProjectWise V8i or later:
• ProjectWise Explorer
• ProjectWise Administrator
• ProjectWise Caching Server
• ProjectWise Gateway Service
An automatic upgrade will uninstall the earlier version and then install the new version. Note that you are
not required to use the automatic upgrade feature; you can still use Add / Remove Programs to manually
uninstall the earlier version before installing the new version, if you prefer.
The ideal situation in which to use the automatic upgrade feature is when one of the above modules is the
only module from ProjectWise V8i or later that is installed on the computer. If you have more than one of the
above modules from the same ProjectWise V8i or later version installed, you must perform back-to-back
upgrades of each module, as you cannot have modules from different ProjectWise versions installed and
running on the same computer.
Note: To upgrade a module not listed above, you must use Add / Remove Programs to uninstall the existing
version before installing the new version. If you have a mix of modules installed from the same V8i or later
version (that is, some from the list above and some not), then it is recommended that you do not use the
automatic upgrade feature for the modules listed above, and instead use Add / Remove Programs to uninstall
all modules from that release version before you install the new ones.

Note: If you have a ProjectWise V8i or later module from the list above installed next to a pre-V8i version of
the same module on the same computer, then it is recommended that you use Add / Remove Programs to
remove the pre-V8i version, before you can use the automatic upgrade feature to automatically upgrade the
ProjectWise V8i or later version.

Suggested Migration Process

1. Conduct the necessary preparation and testing as recommended above.
2. On the servers to be upgraded, uninstall any existing ProjectWise modules in the following order:

• ProjectWise Distribution Service Plug-in for ProjectWise InterPlot Server
• ProjectWise Distribution Service Administrator
• ProjectWise Distribution Service
• ProjectWise Automation Service Administrator
• ProjectWise Automation Service
• ProjectWise Design Compare Utility
• ProjectWise Publishing Gateway Service
• ProjectWise Publishing Server
• ProjectWise InterPlot Server
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• ProjectWise Web Server
• ProjectWise Administrator
• ProjectWise Explorer
• ProjectWise User Synchronization Service
• ProjectWise Design Integration Server or ProjectWise Caching Server or ProjectWise Gateway Service or

ProjectWise Indexing Service
• ProjectWise Prerequisite Runtimes
• ProjectWise Orchestration Framework Service
• MicroStation (if installed for ProjectWise Orchestration Framework Service)
Note: ProjectWise Distribution Service is no longer delivered.

Note: ProjectWise Automation Service has been renamed Bentley Automation Service and is now a separate
download.

Note: ProjectWise Web Server is not delivered in this release. If you need this feature, use the latest
ProjectWise Web Server and ProjectWise Publishing Gateway Service from ProjectWise V8i (SELECTseries
4).

3. Install servers from this release as needed, per this Implementation Guide.
4. Stop the service for ProjectWise Design Integration Server CONNECT Edition Update 3 in the local Services

window.
5. Migrate configurations from your existing DMSKRNL.CFG file to the current version’s delivered DMSKRNL.CFG

file.
Note the following default installation location, for 64-bit servers:
C:\Program Files\Bentley\ProjectWise\Bin

6. In the Windows Registry, move all ProjectWise ODBC datasources from HKEY_LOCAL_MACHINE\SOFTWARE
\Wow6432Node\ODBC\ODBC.INI to HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBC.INI

7. Perform any necessary database product upgrades.
The upgrade process will drop and recreate all the ProjectWise product tables in the database. Specifically, a
copy of each table’s data is created and the original database tables are then deleted. Once this is done, new
tables are created and the original data rows are inserted into the new tables. This is to reconcile any minor
inconsistencies that may exist in the database table structure (such as minor differences in a column size, or a
column declared as CHAR instead of VARCHAR, and so on).
Your database should have enough storage space to allow the upgrade process to copy the largest table in the
ProjectWise database. For instance, if you have one million documents in your database, you should have at
least enough storage in your database to allow one million document records to be copied to a temporary
table.
If you have created any custom database triggers or indexes on those tables, you will need to re-create them
after conversion.
Updating The Database To Support Unicode — INSTRUCTIONS FOR ORACLE USERS ONLY

By supporting Unicode, ProjectWise is better able to store and sort characters from many different languages
and character sets. To do this, the underlying database must also be set to support Unicode. For SQL Server
users, this is automatic and nothing needs to be done. For Oracle users, the database used by ProjectWise
must be converted to support Unicode. This means exporting all of the data out of the old database, creating a
new database with Unicode support, and importing all of the data into this new database. These steps are
accomplishing using Oracle tools.
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General Procedure — Updating databases to Unicode

a. Export data from existing database using database tools.
b. Create a new database using UTF8 or AL32UTF8 character sets
c. Import data into new database using database tools.
d. Upgrade the database table structure using the DMSCONV.EXE utility.
e. Connect to new database with ProjectWise Administrator and log in to complete the upgrade.
For Oracle users who are also upgrading the version of Oracle, at this point back up your existing database,
upgrade the Oracle installation, and migrate the database to one of the supported versions of Oracle. Make
sure you have specified a valid Unicode character set for your new database. In the current supported
versions of Oracle, both the database character set and the national character set must be set to a Unicode
character set (see Setting Up the Main ProjectWise Database (on page 24)).
When creating your export from your old Oracle database, you must export the data using the active database
server NLS_LANG* settings. This is to prevent your default client NLS_LANG setting from affecting the
character set conversion during the export process.
Next, import the database backup into your new Oracle database using the target database's NLS_LANG
settings. Again, this is to prevent your default client NLS_LANG setting from affecting the character set
conversion during the import process.
Note: Refer to your Oracle documentation for details.
Once this process is complete, the ProjectWise database can be upgraded.

8. Using ProjectWise's DMSCONV.EXE utility, update your datasources to make the necessary database
modifications for the new capabilities of the current version of ProjectWise.

Converting Database Table Structure Using DMSCONV.EXE

Converting existing ProjectWise datasources to work with the current version of ProjectWise is done using the
DMSCONV.EXE command line utility (or DMSCONV, for short, which stands for DMS convert), which is delivered
with the ProjectWise Design Integration Server installation. DMSCONV will migrate the database schema of your
existing ProjectWise database to meet the requirements of the current version.
1. Before you start, update the database statistics to maximize database performance (consult your database's

documentation).
2. Stop the service for ProjectWise Design Integration Server in the local Services window.
3. Open a command prompt and navigate to the ...\ProjectWise\bin directory.
4. (Optional) Before converting the database, type DMSCONV and press <Enter>. This displays a list of options

you can use with DMSCONV.
5. To update the database schema, enter:

DMSCONV -d ODBC_datasourcename -u ODBC_username -p ODBC_password

This is the basic DMSCONV command, which is used to update the database schema. You can add switches to
the command as necessary, depending on what else you want DMSCONV to do, as described in the following
steps.

6. To also control how document MIME type information in the database will be updated, you can add one of
the following switches to the DMSCONV command:
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Switch Description

-mime This will automatically perform the MIME type update.
For example:
DMSCONV -d ODBC_datasourcename -u ODBC_username -
p ODBC_password
-mime

-nomime This will automatically skip the MIME type update for all MIME
types.
For example:
DMSCONV -d ODBC_datasourcename -u ODBC_username -
p ODBC_password
-nomime

-skipmime Used in conjunction with the -mime switch, this will
automatically skip the MIME type update for the specified
extensions.
For example:
DMSCONV -d ODBC_datasourcename -u ODBC_username -
p ODBC_password
-mime -skipmime "*.doc;*.xls;*.ppt"

Note: You can also run DMSCONV without entering any of the above MIME switches; if you do, you will be
prompted to update document MIME type information after the database structure is upgraded. While a
document MIME type update is required for proper functioning of ProjectWise CONNECT Edition Update 3,
this step may be deferred until later. If you use the -nomime switch during the database upgrade, or if you do
not enter any MIME switch and you select to skip the MIME type update when prompted, make sure you
perform a MIME type update soon after upgrading the datasource, and before putting the datasource into
production. (Consult ISOC RFC 2046 for more information about MIME types.)

7. (Optional) The -notransaction switch is for SQL Server upgrades, and should only be used when
absolutely necessary. Using this option will disable the use of upgrade transactions. This may speed up the
upgrade and reduce transaction log usage, but is riskier because any failure will require restoring your
database from backup. Consult with Bentley Professional Services before using this option.

8. (Optional) The -force-cursor-sharing switch is for Oracle upgrades, and should only be used when
absolutely necessary. This option was added to increase database performance in certain configurations.
Consult with Bentley Professional Services before using this option.

9. (Optional) The -nosatellites switch is for skipping the creation of sets in the database for existing raster
files and their sister files, and also various ESRI files (including shapefiles (SHP)) and their related files.

10. (Optional) DMSCONV also provides the capability to import application association settings into the updated
datasource. Default application association settings are delivered in the APPINFO.XML file located in
the ...\ProjectWise\bin directory, but you can define and import your own custom application
association settings if necessary. There are several command line switches that control the import of these
application association settings:
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Switch Description

-app This imports the application association settings in the delivered
appinfo.xml file.
For example:
DMSCONV -d ODBC_datasourcename -u ODBC_username -
p ODBC_password
-app

You can import the appinfo.xml file as is, or edit the
application association settings in the file first, as needed, and
then run DMSCONV.

-appfile
<path_to_and_name_of_xml_file>

This imports the XML file of your choice. Use this option if you
have created your own XML file with custom application
association settings.
For example:
DMSCONV -d ODBC_datasourcename -u ODBC_username -
p ODBC_password
-appfile C:\import\myappsettings.xml

-appext=<0,1> This is used in conjunction with either -app or -appfile to
control whether or not any previously defined application
extensions will be remapped to new applications set in the XML
file being imported. Enter a value of 1 after the = character, if
you want extensions remapped; enter 0 if you do not want
extensions remapped.
For example:
DMSCONV -d ODBC_datasourcename -u ODBC_username -
p ODBC_password
-app -appext=1

The above example imports the application association settings
from the delivered appinfo.xml file and remaps any existing
extension associations in the datasource to the extension
associations defined in appinfo.xml.

Note: You are not required to import application association settings at the same time you are upgrading the
database table structure. If you prefer, you can first run DMSCONV without any of the -app switches to only
upgrade the database table structure, and then run DMSCONV again with the appropriate -app switches to
import the necessary application association settings.

11. Start the service for ProjectWise Design Integration Server in the Services window.
12. Open ProjectWise Administrator, recreate the datasource entry for the converted database, then log into this

new datasource — you will be prompted to complete the datasource conversion. This step is required before
you can log into the datasource using the current version of ProjectWise Explorer.

13. Test the operation of the new ProjectWise production environment to ensure that all functionality is
operating normally.

14. If you delayed updating the MIME type information, use DMSCONV to update them now (see step 6 for
details).

Upgrade Planning
Upgrading to the Current Version

ProjectWise Design Integration 258 Implementation Guide



15. Conduct a complete backup of converted database and also a complete server backup of the new ProjectWise
system to serve as a baseline recovery.

Caution: If the conversion of your database should fail for some reason, do not run DMSCONV on it a second time,
as this can cause further corruption of the database. Instead, after you have determined the cause of the failure
and found a solution, you will need to start the DMSCONV process over, using a fresh backup copy of your
database.

Areas for Review After Migration

1. As suggested above, a thorough review of client integration and overall operation is recommended before
you bring an upgraded ProjectWise system into production.

2. Review both datasource settings and user settings, as new options may have been added or renamed in both
of these areas. It is also suggested to review any new DMSKRNL.CFG options as well as the current logging
system configuration. These settings are described in the ProjectWise Administrator help.

3. In ProjectWise V8i (SELECTseries 1), the “Redline” action was renamed to “Markup”. For applications such as
MicroStation, the Markup action is set by default to use Bentley Navigator, which points to the application
class name ProjectWise.Navigator.Application in the Windows Registry. After upgrading to the
current version from a pre-V8i (SELECTseries 1) version, you may notice that some of your applications now
have two “Markup” actions. One is the new Markup action, and the other is the old Redline action which got
renamed to Markup during the upgrade. If you see two Markup actions after an upgrade, simply delete the
second Markup action (the old Redline action which got renamed to Markup) in ProjectWise Administrator.

4. You must run a scan for references and link sets (in ProjectWise Explorer) after converting a pre-v8.1
datasource to the current version.. This is to allow for the population of additional data into the ProjectWise
database about reference file relationships for both MicroStation and AutoCAD, and ensures the correct
operation of reference data.

5. Some upgrades, depending on the version you are upgrading from, require that you check in all checked out
documents before upgrading, to ensure the integrity of master/reference document relationships. If you did
this, then your master/reference document relationships should be in tact after upgrading. However, if you
did not do this, and you find that some of your master/reference document relationships are broken, then
running a scan for references and link sets (in ProjectWise Explorer) after upgrading will fix the broken
relationships. Note that before you run the scan, you must check in all checked out documents.
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Licensing

ProjectWise licensing is managed by SELECTserver, which tracks the usage of Right to Run licenses reported by:
• ProjectWise Design Integration Server
• ProjectWise Caching Server
• Bentley i-model Composition Server for PDF
SELECTserver also tracks the usage of Bentley CONNECTIONS Passport licenses used by:
• ProjectWise Explorer
• ProjectWise Administrator
Note: On each computer that you have Bentley software installed, that computer can only report to one
SELECTserver. Therefore if you have multiple products on the same computer that require licensing through
SELECTserver, you only need to run the Product Activation Wizard once on that computer for all the products
that require licensing.

Activating Your Product
Product activation is achieved by connecting to a SELECTserver, receiving verification that your SELECTserver
Name and Activation Key are correct, and successfully posting usage logs. Product activation is not the same as
checking out a license. This section describes how to configure ProjectWise Design Integration Server for
activation. After initial configuration, ProjectWise Design Integration Server automatically and transparently
tries to activate each time it runs, and runs unconstrained for a period of 7 days after its last successful
activation. However, if activation is unsuccessful for a period of 30 days, ProjectWise Design Integration Server
reports license expired exceptions until the license is successfully activated again.If activation is unsuccessful for
a period of 7 days, users will be blocked from logging in, until the license is successfully activated again.

Using the Product Activation Wizard

The Product Activation Wizard is designed to step users through the product activation process. After a product
is installed, you must obtain a license and then activate that license. Obtaining the license alone is not enough to
complete the process. This wizard eliminates the confusion and makes it clear that obtaining a license and
activating a product are two essential steps.
The first screen of the Product Activation Wizard offers these product activation options:
• SELECT subscriber activating against a hosted (Bentley) SELECTserver
• SELECT subscriber with a deployed (local) SELECTserver
• NON-SELECT or Node Locked user
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• Evaluation Only - No license information

The wizard steps you through the activation process based on the options selected.

SELECT Subscriber Activating Against a Hosted (Bentley) SELECTserver
If you are activating against a hosted (Bentley) SELECTserver, the Server Name is pre-populated but you must
provide the proper Activation Key - see http://www.bentley.com/activate for more information regarding this.
1. Select SELECT subscriber activating against a hosted (Bentley) SELECTserver and click Next.

The Activating against a SELECTserver page opens.
2. Enter the site activation key in the Site Activation Key field.
3. If you are using HTTPS, turn on HTTPS (SSL).
4. If you are using a proxy server to connect to the SELECTserver, click the Proxy button and fill in the Proxy

Server information, then click OK.
5. Click Test Connection to verify the connection to the SELECTserver.
6. Click Next.
7. On the Single Sign-In page, just click Next.

Note: When the CONNECTION Client is not installed, a link is provided to download the CONNECTION Client
from the Bentley Software Fulfillment Center. For ProjectWise server-only installations (where no
ProjectWise clients are installed on the server), the CONNECTION Client is not required and therefore this
page can be skipped.

8. On the Country of Use page, select the country where you will be using this product and click Next.
The Wizard Selections page displays the information provided on the previous pages.

9. Review the information and click Finish to activate the product.

SELECT Subscriber with a Deployed (local) SELECTserver
If you are activating against a local SELECTserver, you must provide the proper Server Name and Activation Key.
The Server Name and Activation Key, along with any proxy configuration information, can be obtained from your
Site Administrator.
1. Select SELECT subscribers with a deployed (local) SELECTserver and click Next.

The Activating against a SELECTserver page opens.
2. Enter the name of the server in the Server Name field.
3. Enter the site activation key in the Site Activation Key field.
4. If you are using HTTPS, turn on HTTPS (SSL).
5. If you are using a proxy server to connect to the SELECTserver, click the Proxy button and fill in the Proxy

Server information, then click OK.
6. Click Test Connection to verify the connection to the SELECTserver.
7. Click Next.
8. On the Single Sign-In page, just click Next.

Note: When the CONNECTION Client is not installed, a link is provided to download the CONNECTION Client
from the Bentley Software Fulfillment Center. For ProjectWise server-only installations (where no
ProjectWise clients are installed on the server), the CONNECTION Client is not required and therefore this
page can be skipped.
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9. On the Country of Use page, select the country where you will be using this product and click Next.
The Wizard Selections page displays the information provided on the previous pages.

10. Review the information and click Finish to activate the product.

NON-SELECT or Node Locked User
If you are not a Bentley SELECT subscriber and you are activating your product, you are presented with three
options:

I have a license file ready to import
1. Enter the path to your license file (or Browse to the location of your license file) in the License File field.
2. Click Next.

The Wizard Selections page displays the information provided on the previous pages.
3. Review the information and click Finish to activate the product.

I have an activation key
1. Enter the site activation key in the Site Activation Key field.
2. If you are using HTTPS, turn on HTTPS (SSL).
3. If you are using a proxy server to connect to the SELECTserver, click the Proxy button and fill in the Proxy

Server information, then click OK.
4. Click Test Connection to verify the connection to the SELECTserver.
5. Click Next.

The Check out license now? page displays.
6. Enter your email address in the Email Address field.
7. Select the product to be activated (if not pre-populated) in the Product Name field.
8. Enter the product version number (XXX.XXX.XXX.XXX, if not pre-populated) in the Product Version field.
9. Click Next.

10. On the Country of Use page, select the country where you will be using this product and click Next.
The Wizard Selections page displays the information provided on the previous pages.

11. Review the information and click Finish to activate the product.

I do not have any license information
1. The product will run in evaluation mode.
2. Click Go To Bentley.com to request activation information.

Evaluation Only - No License Information
1. The product will run in evaluation mode.
2. Click Go To Bentley.com to request activation information.

Remote Activation
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You can use either the Active Directory Group Policy Objects or the LicenseTool command line utility
(LicenseToolCmd.exe) to remotely configure the license of your product.
For information on using the Active Directory Group Policy Objects, refer to the Group Policy Administration
(ADM) files page on Bentley Communities.
The LicenseTool command line utility (LicenseToolCmd.exe) is delivered in ProductName's program directory.
Following section describes the arguments that can be supplied to the utility.
Note: All of the following commands can also be supplied to the License Tool GUI application (LicenseTool.exe),
when starting it from a command shell. However, since the license tool does not have stderr or stdout, the
results of the following commands will not appear on the screen. In addition, when calling these commands from
LicenseTool.exe (the GUI), all arguments must be preceeded by the "-nowin" argument.

Checkout
Arguments to checkout a product are:
• product:id - (Mandatory) Numeric id of the product to checkout.
• productversion:versionnumber - (Mandatory) Product version number
• productfeatures:"featurestring" - (Mandatory, if there are features associated with the product) Features

of the product.
Note: As feature strings contain the pipe "|" symbol, they must be wrapped in quotes in order to work with
the product.

• checkoutperiod:days - (Optional) Number of days for which this product will be checked out.
• email:noname@bentley.com - (Optional) The email address of the user performing the checkout.
For example,
licensetoolcmd checkout /productid:1000 /productversion:10.00.00.25/
email:username@company.com

Checkin
Arguments to checking a product are:
• productid:id -Numeric id of the product to check in. (mandatory)
• productversion:versionnumber - (Mandatory) Product version number
• productfeatures:"featurestring" - (Mandatory, if there are features associated with the product) Features

of the product.
Note: As feature strings contain the pipe "|" symbol, they must be wrapped in quotes in order to work with
the product.

For example,
licensetoolcmd checkin /productid:1000 /productversion:10.00.00.25

Import
Argument to import a checked out license is:
• file:file name - (Mandatory) License file to import.
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For example,
licensetoolcmd import /file:c:\mymachine-MicroStation-License.xml

List
Lists either the products available for checkout or what products are currently checked out on the machine. The
default is to produce both lists.
• avail - (Optional) Display only the list of products available for checkout.
• out - (Optional) Display only the list of products currently checked out.
For example,
licensetoolcmd list -avail

Status
Lists the current configuration of the license client on the machine running the command. There are no
arguments for this command. For example,
licensetoolcmd status 

Configure
Configure a license client option. Takes a license client setting and a value for that setting.
• setting:setting_name - (Mandatory) The name of the setting to be saved.
• value:setting_value - (Mandatory) The setting value.
• productid:id - (Optional) The product id associated with this setting .
Following settings are available:
• SELECTserver - The name of the SELECTserver.
• ActivationKey - The Activation Key to be used.
• UseProxy - Determines whether or not the configured proxy should be used. The possible values are: “Yes”,

“No”.
• ProxyServer - Name of Proxy Server.
• ProxyNeedsAuth - Determines if the configured proxy server requires authentication. The possible values

are: “Yes”, “No”
• ProxyDomain - Domain name to use for proxy authentication.
• ProxyUser - User name to use for proxy authentication.
• ProxyPassword - Password to use for proxy authentication.
For example,
licensetoolcmd configure /setting:selectserver /value:selectserver.bentley.com

Client-side Licensing for ProjectWise Explorer and ProjectWise
Administrator Users
By default, Bentley CONNECTIONS Passport license usage by ProjectWise Explorer and ProjectWise
Administrator users is automatically reported to the SELECTserver that your ProjectWise Design Integration
Server is connected to, and there is nothing else you need to configure to track the license usage of those users.

Licensing
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However, if you need some ProjectWise Explorer or ProjectWise Administrator users to use a different
SELECTserver, then you must do the following:
1. On the ProjectWise Explorer or ProjectWise Administrator computer, launch the Product Activation Wizard

(on page 265) and enter the name of another SELECTserver and that server's Site Activation Key.
2. Next, open ProjectWise Administrator, log in to your datasource, and go to the Users datasource node. For

each ProjectWise Explorer or ProjectWise Administrator user who needs to use a different SELECTserver,
right-click the user account and select Properties. On the Settings tab, expand the Administrative category
and set Client Licensing to Activate and record usage through client's configured SELECT Server.

ProjectWise Gateway Service Licensing
ProjectWise Gateway Service delivers a Product Activation Wizard, but you are not prompted to launch it at the
end of your ProjectWise Gateway Service installation because ProjectWise Gateway Service does not require a
license. However, if you enable the file caching feature in the ProjectWise Gateway Service's DMSKRNL.CFG file,
then you will need to run the Product Activation Wizard on this computer in order to specify a SELECTserver
and Site Activation Key for this server to use. This is because you have essentially turned the ProjectWise
Gateway Service into a ProjectWise Caching Server, which requires a Right to Run license.
Note: Whenever launching the Product Activation Wizard, you need to launch the wizard with elevated
privileges (Run as administrator) (on page 265).

Launching the Product Activation Wizard from the Desktop
If you skipped the Product Activation Wizard step at the end of your installation, or if you need to change your
existing SELECTserver information, you can run the Product Activation Wizard later by launching the
ActivationWizard.exe file, or by first launching the License Management Tool (LicenseTool.exe) and then
selecting Tools > Product Activation Wizard.
For most ProjectWise applications, the ActivationWizard.exe and LicenseTool.exe files are located in
the ...\Bentley\ProjectWise\bin folder of your installation.

Launching the Product Activation Wizard with Elevated Privileges

Because of certain access control restrictions to the Windows Registry on Windows servers, the Product
Activation Wizard must be launched with elevated privileges. This can be done by logging in to the computer
with an administrator account and then launching ActivationWizard.exe or LicenseTool.exe, or by right-
clicking ActivationWizard.exe or LicenseTool.exe and selecting Run as administrator.
If the Product Activation Wizard is not launched with elevated privileges, the Product Activation Wizard will add
the licensing information to the HKEY_CURRENT_USER section of the Registry instead of HKEY_LOCAL_MACHINE.
When the server looks for and cannot find the licensing information under HKEY_LOCAL_MACHINE, the server
enters 30-day countdown mode. You cannot fix the problem simply by rerunning the Product Activation Wizard,
because the Product Activation Wizard will find a valid licensing configuration under HKEY_CURRENT_USER and
therefore will not move the licensing information to the location it needs to be in.
To correct the issue if it occurs:

Licensing
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1. Launch the Windows Registry Editor (regedit.exe) application with elevated privileges. This can be done
by logging in to the computer with the Administrator account and launching regedit.exe, or by right-
clicking regedit.exe and selecting Run as administrator.

2. In the Registry Editor, navigate to the HKEY_CURRENT_USER\Software\Bentley registry node, then delete
the Licensing registry key and all its subkeys.

3. Close the Registry Editor.
4. Launch the Product Activation Wizard with elevated privileges as described above, then reenter your

SELECTserver activation information.

Licensing
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Installing Required Windows Server Features

This section provides some quick pointers about how to install or where to find certain common required
Windows features. See the Microsoft online documentation for details.

Install Microsoft .NET Framework 4.6 or Later
ProjectWise Orchestration Framework Service requires .NET Framework 4.6 or later. As of this writing, the
latest version of .NET Framework is 4.7.1, which satisfies any .NET Framework 4 or later requirement.
If needed, you can download .NET Framework 4.7.1 from here: https://www.microsoft.com/en-us/download/
details.aspx?id=56115
Operating System Delivered .NET Framework Version Action

Windows Server 2016 .NET Framework 4.6.1 Install .NET Framework 4.6.1
through Server Manager:
1. In Server Manager, click

Manage > Add Roles and
Features.

2. In the Add Roles and Features
Wizard click Next until you get
to the Select features page.

3. Turn on .NET Framework 4.6
Features, click Next, then
Install.

Windows Server 2012 R2 .NET Framework 4.5.1 Download and install .NET
Framework 4.6 or later.

Windows Server 2008 R2 SP1 .NET Framework 3.5.1 Download and install .NET
Framework 4.6 or later.

Note: Per Microsoft instructions, you do NOT need to first install the delivered version of .NET Framework
through Server Manager before you install the newer downloaded version of .NET Framework 4.6 or later.
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Install Microsoft Message Queuing (MSMQ)
Operating System Action

Window Server 2016, Windows Server 2012 R2 1. In Server Manager, click Manage > Add Roles and
Features.

2. In the Add Roles and Features Wizard click Next
until you get to the Select features page.

3. Turn on Message Queuing, click Next, then
Install.

Windows Server 2008 R2 SP1 1. In Server Manager, click Features in the left pane,
then click Add Features in the right pane.

2. In the Add Features Wizard, turn on Message
Queuing, click Next, then Install.

Note: After installation, make sure the Message Queuing service is running in the Services window.

Install Windows Search
Operating System Action

Window Server 2016, Windows Server 2012 R2 1. In Server Manager, click Manage > Add Roles and
Features.

2. In the Add Roles and Features Wizard click Next
until you get to the Select features page.

3. Turn on Windows Search Service, click Next, then
Install.

Windows Server 2008 R2 SP1 1. In Server Manager, click Roles in the left pane, then
click Add Roles in the right pane.

2. In the Add Roles Wizard, turn on File Services
and click Next.

3. On the Select Role Services page, turn on
Windows Search Service, click Next, then Install.

Note: After installation, make sure the Windows Search service is running in the Services window.

Installing Required Windows Server Features
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